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Kullanım Talimatlarına aşağıdaki yollarla erişilebilir: 

1. Uygulamayı açtıktan sonra, ana ekranda “Yardım” (“Help”) veya “Hakkında” (“About”) ögesine tıklayın. “Kullanım Talimatları” 
(“Instructions for Use”) ögesini seçin. Bir pdf görüntüleyici içinde Kullanım Talimatları açılacaktır. 

2. NeoSoft’tan alınan orijinal kurulum paketi mevcutsa, zip dosyasını açın ve önce “Belgeler” (“Documentation”) klasörünü ardından 
“Kullanım Talimatları” (“Instructions for Use”) klasörünü bulun ve kendi dilinizdeki Instructions for Use.pdf dosyasına çift tıklayın. 
Diller ve işaretleri, EN - İngilizce, FR - Fransızca, DE - Almanca, EL - Yunanca, IT - İtalyanca, LT - Litvanca, ES - İspanyolca, SV - İsveççe, 
TR - Türkçe, RO - Romence, NL - Felemenkçe, PT-PT - Avrupa Portekizcesi, HU - Macarca, JA - Japonca, VI - Vietnamca, 
ZH-CN - Basitleştirilmiş Çince, PT-BR - Brezilya Portekizcesi olarak gösterilmiştir.

3. Uygulamanın kurulu olduğu klasöre gidin. “Belgeler” (“Documentation”) klasörünü ardından “Kullanım Talimatları” (“Instructions for 
Use”) klasörünü bulun ve kendi dilinizdeki Instructions for Use.pdf dosyasına çift tıklayın. Diller ve işaretleri EN - İngilizce, FR - Fransızca, 
DE - Almanca, EL - Yunanca, IT - İtalyanca, LT - Litvanca, ES - İspanyolca, SV - İsveççe, TR - Türkçe, RO - Romence, NL - Felemenkçe, 
PT-PT - Avrupa Portekizcesi, HU- Macarca, JA - Japonca, VI - Vietnamca - ZH-CN - Basitleştirilmiş Çince, 
PT-BR - Brezilya Portekizcesi olarak gösterilmiştir.

4. Kullanım Talimatlarının elektronik kopyalarına son üretim tarihinden itibaren en az 15 yıl boyunca www.neosoftllc.com/neosoft/
product_manuals/ adresinden erişilebilir. 

5. suiteHEART / suiteDXT Software Group Basic UDI DI – 850001088039.

Rev Tarihi Değişiklik Açıklaması
Güvenlik Güncellemesi 

(Evet/Hayır)
1 22 AĞUSTOS 2022 5.1.0 ürün sürümü için güncellendi. 

Bu KT, önceki dil/revizyon/parça numaralarının yerini alır:
suiteHEART® Software KT - NS-03-039-0003, EN-Rev. 6
suiteHEART® Software KT - NS-03-039-0004, FR-Rev. 5
suiteHEART® Software KT - NS-03-039-0005, DE-Rev. 5
suiteHEART® Software KT - NS-03-039-0006, IT-Rev. 5
suiteHEART® Software KT - NS-03-039-0007, EL-Rev. 5
suiteHEART® Software KT - NS-03-040-0003, LT-Rev. 4
suiteHEART® Software KT - NS-03-040-0004, ES-Rev. 4
suiteHEART® Software KT - NS-03-040-0005, SV-Rev. 4
suiteHEART® Software KT - NS-03-040-0006, TR-Rev. 4
suiteHEART® Software KT - NS-03-040-0007, RO-Rev. 4
suiteHEART® Software KT - NS-03-040-0008, NL-Rev. 4
suiteHEART® Software KT - NS-03-041-0005, ZH-CN-Rev. 2
suiteHEART® Software KT - NS-03-040-0030, PT-PT-Rev. 4
suiteHEART® Software KT - NS-03-041-0007, HU-Rev. 3
suiteHEART® Software KT - NS-03-042-0006, JA-Rev. 1
suiteHEART® Software KT - NS-03-042-0007, VI-Rev. 1

Hayır



suiteHEART® Yazılımı Kullanım Talimatları NS-03-043-0003-TR Rev. 1 i

Tıbbi cihaz direktifi
Bu ürün, aşağıdaki CE Uygunluk işaretini taşıdığında, tıbbi cihazlarla ilgili 93/42/EEC sayılı konsey direktifinin koşullarına uygundur:

Kanada: Health Canada cihaz lisans numarası: 99490

suiteHEART 5.1.0 UDI: 00850001088015510

DİKKAT: Birleşik Devletler federal yasası, bu cihazın bir doktor tarafından veya bir doktorun siparişiyle 
satılmasını kısıtlar. 

Bu cihazla ilgili olarak meydana gelen herhangi bir önemli durum, NeoSoft'a ve Üye Devletinizin yetkili makamına bildirilmelidir.

Bu ürün bir Tıbbi Cihazdır: İthalatçı:

MedEnvoy
Prinses Margrietplantsoen 33 - Suite 123, 
2595 AM The Hague, 
The Netherlands

EMERGO EUROPE 
Prinsessegracht 20 
2514 AP The Hague The 
Netherlands

MedEnvoy Switzerland 
Gotthardstrasse 28 
6302 Zug Switzerland

Malezya Yetkili Temsilcisi:
Emergo Malaysia Sdn. Bhd.
Level 16, 1 Sentral Jalan Stesen Sentral 5 KL 
Sentral, 50470
Kuala Lumpur MALAYSIA

Malezya Tıbbi Cihaz Kayıt Numarası: 
GB10979720-50888



Tıbbi cihaz direktifi

Tıbbi cihaz direktifi i

Güvenlik 1
Giriş 1
Kullanım Endikasyonları 1
Kullanım Amacı 2
Desteklenen DICOM Görüntü Biçimleri 2
Güvenlik Bildirimleri 3
Ekipman Tehlikeleri 3

Siber güvenlik 4

Başlangıç 6
Uygulamayı Başlatma ve Uygulamadan Çıkma 6

suiteHEART® Yazılımını Başlatma 6
suiteHEART® Yazılımından Çıkma 7

Kullanıcı Arayüzüne Genel Bakış 8
Genel Bakış 8
Analiz/Görüntüleyici Modları 9

Seride Dolaşma 9
Düzenleme Penceresi ve Mod Görünümü 10

Dosya Menüsü Seçenekleri 10
Araçlar Menüsü Seçenekleri 10
Yardım Menüsü Seçenekleri 11
Düzenleme  Görüntüleme Kontrolleri 11
Görüntü Görüntüleyici Kontrolleri 11
Çapraz Başvuru Görüntüleme Alanları 12
Görüntü Kullanım Araçları 12

Hızlı Tuşlar 14
Sonuç Paneli 15
Rapor Görünümü 18
VT Tarama 18

VT Tarama Özellikleri 19
VT Tarama Prosedürü 20

Görüntü Yönetim Araçları 21
Görüntüleyici 21

Görüntü/Seri Seçme 22
Görüntüleyici İşlevleri 23

Karşılaştırma Modu 24
Örnek İş Akışı 26
suiteHEART® Yazılımı Kullanım Talimatları NS-03-043-0003-TR Rev. 1 Tıbbi cihaz direktifi-i



Tercihleri Tanımlama 28
Tercihleri Ayarlama 28

Global Sekmesi 29
Şablon Sekmesi 37
Makro Sekmesi 40
Yazdırma Sekmesi 42
Virtual Fellow® Sekmesi 43
T1/T2 Eşleştirme Sekmesi 44
Menü Odaklı Raporlama Sekmesi 45
İçe Aktarma Tercihleri 47
Dışa Aktarma Tercihleri 47

Virtual Fellow® 48
Virtual Fellow® ile Ön İşleme 49
Virtual Fellow® Arayüzü 50

Virtual Fellow® Seçimleri 50
Görüntüleme Protokolleri 52
Klavye Kısayolları 53
Görüntüleme Protokolleri için Kullanıcı Seri Seçimi 54
Uzun Eksen Çapraz Başvuru Görüntüleme Alanları için Kullanıcı Serisi Seçimi 55

Otomatik Güncelleme 56
İş Akışı 56

Konturları Düzenleme 58
ROI (İlgi bölgeleri) Nokta Eğrisi 58
Sürükleme Aracı 59
Kontur Çekme Aracı 60
Bir Konturu Silme 62
Ek Düzenleme Analizi (Yalnızca İşlev Analizi) 62

İşlev Analizi 63
 Ventriküller 64

Endeks Ölçümlerini Hesaplama 64
Otomatik LV ve RV Bölümleme 64
Manuel LV ve RV İşlev Analizi Prosedürü 68
Bazal Aradeğerleme 69
Seriler Arası Hareket Düzeltme 71
Matris Görünümü 73
Ventriküler İşlev Analizi Sonuçları 76
Sol Ventriküler Bölgesel Analiz 78
Uyumsuzluk Analizi 79
Otomatik Uzun Eksen Bölümleme 80

 Atria 81
Manuel LA ve RA Analizi 81
Otomatik LA veya RA Analizi 82
Atriyal Boyutlar ve Alan 83

Varsayılan Ölçümler 84
Bir Ölçüm Gerçekleştirme 84

Aort Kapağı Düzlemi Analizi 86
Aort Kapağı Düzlemi Analizi Prosedürü 86
suiteHEART® Yazılımı Kullanım Talimatları NS-03-043-0003-TR Rev. 1 Tıbbi cihaz direktifi-ii



Akış Analizi 89
Otomatik Bölümleme Kullanan Akış Analizi 91

Kontur Düzenleme 94
Ana Hat Düzeltme Seçenekleri 97
Akış Araçları 99
Renk Katmanı 100
Kullanıcı Tanımlı Tepe Nokta Hızı 101
Eğri Modu Seçimleri 101
Akış Sonuçlarını Görüntüleme 104

Akış1 ve Akış2 için Kategori Etiketini Değiştirme 104
Entegre Analiz 106

Miyokardiyal Değerlendirme 114
Sonuç Ölçüm Etiketlerini Tanımlama 115
Late Enhancement Analiz Prosedürü 115
T2 Analizi 119
Birleşik Analiz 121

LE ve T2 121
Sinyal Diferansiyeli Sonuçları 125

Early Enhancement Analizi 126
Yerel ROI Aracı 127

T1 Eşleştirme Analizi 129
Analizi Gerçekleştirme 130

16 Bölümlü Kutupsal Eşlem 132
Konturları Silme 133
T1 Eğrilerini Gözden Geçirme 133

İnversiyon Düzeltme Faktörü (ICF) Siemens MyoMaps 134

T2 Eşleştirme Analizi 135
Analizi Gerçekleştirme 136

16 Bölümlü Kutupsal Eşlem 138
Konturları Silme 139
T2 Eğrilerini Gözden Geçirme 139

Miyokardiyal Perfüzyon 140
Miyokardiyal Perfüzyon Analizi Gerçekleştirme 142

Kontur Düzenleme 143
Sonuçları İnceleme 143
Grafik/Tablo Sonuçlarını Gözden Geçirme 143
Bağıl Yukarı Eğimi (RU) ve Rezerv Endeksini (RI) Hesaplama 144
Miyokardiyal Perfüzyon Eğriden Hesaplanan Parametre Tanımları 145

Patent Foramen Ovale (PFO) Analizi 146

T2* 150
Kalp Analiz Prosedürü 151

Miyokardiyal Renk Haritası Oluşturma 152
Uyum Parametreleri 152
suiteHEART® Yazılımı Kullanım Talimatları NS-03-043-0003-TR Rev. 1 Tıbbi cihaz direktifi-iii



T2* Sonuçlarını Gözden Geçirme 153

3B/4B Akış Görüntüleyici 154

Menü Odaklı Raporlama 167
Hasta Demografikleri 168
Raporlama Prosedürü 169

Rapora Görüntü, Grafikler, Tablolar Ekleme 170
Kutupsal Çizimler 171
Rapor Önizleme 172
İncelemeyi Onaylama 172
Dışa Aktarma Seçenekleri 173
Onaylı Raporu Gözden Geçirme 174

Rapor Veritabanı 176
Rapor Veritabanı Aracı Prosedürü 176

Sorgu Gerçekleştirme 177
Sonuçları Getirme 178
Sonuçları Görüntüleme 179
Sorguyu Kaydetme 180

Favoriyi Silme 181
Arama Sonuçlarını bir HTML Dosyasına Aktarma 182
Veritabanını Dışa Aktarma 183
Veritabanını İçe Aktarma 183

Ek 184
Referans Makaleler 184
Ek B - İşlevsel Analiz Tarama Düzlemi Örneği 185

İndeks 187
suiteHEART® Yazılımı Kullanım Talimatları NS-03-043-0003-TR Rev. 1 Tıbbi cihaz direktifi-iv



Güvenlik
Giriş
Verimli ve güvenli bir kullanım sağlamak için yazılımı kullanmadan önce, bu güvenlik bölümü ve tüm ilgili konuların 
okunması gereklidir. Ürünü kullanmaya başlamadan önce, bu el kitabının içeriğini okuyup anlamanız önemlidir. 
Prosedürleri ve güvenlik önlemlerini periyodik olarak gözden geçirmeniz gerekir. 

Bu yazılım, yalnızca eğitimli ve uzman personel tarafından kullanılmalıdır.

suiteDXT / suiteHEART® yazılımının orijinal yayım tarihinden itibaren 7 yıllık bir kullanım ömrüne sahiptir.

DİKKAT: Federal Yasa, bu cihazın bir doktor tarafından veya bir doktorun siparişiyle satılmasını, dağıtımını ve 
kullanımını kısıtlar.

Bu el kitabında, tehlike, uyarı ve dikkat terimleri tehlikelere işaret etmek ve ciddiyet derecesini veya seviyesini göstermek 
için kullanılmaktadır. Tehlike, bir şahsın olası yaralanma nedeni olarak tanımlanır. Aşağıdaki tabloda listelenen terminoloji 
açıklamalarına aşina olun:

Kullanım Endikasyonları
suiteHEART® Yazılımı, tıbbi görüntülerin gözden geçirilmesi ve raporlanması için tekrarlanabilir araçlar sunan analitik bir 
yazılım aracıdır. suiteHEART® Yazılımı, bir MR sisteminden tıbbi görüntüleri içe aktarabilir ve bunları bilgisayar ekranındaki 
bir görüntüleme alanında gösterebilir. Görüntüleme alanı birden fazla çalışmaya ve çok kesitli, çok aşamalı görüntü 
serilerine erişim sağlar. Çok aşamalı görüntü sekansları görüntülemeyi kolaylaştırmak için film modunda görüntülenebilir.

Tablo 1: Güvenlik Terminolojisi

Grafik Tanım

TEHLİKE:

Tehlike, yönergeler gözardı edilirse ciddi kişisel yaralanmalara, ölüme ya da önemli maddi hasara 
neden olacak belirli bir tehlikesi olduğu bilinen koşulları ya da eylemleri belirtmek için kullanılır.

UYARI : 

Uyarı, belirli bir tehlikesi olduğu bilinen koşulları ya da eylemleri belirtmek için kullanılır.

DİKKAT: 

Dikkat, potansiyel bir tehlikesi olduğu bilinen koşulları ya da eylemleri belirtmek için kullanılır.
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Bir rapor giriş arabirimi de bulunmaktadır. Rapor arabirimindeki ölçüm araçları, görüntüleme incelemesine ait tam bir 
klinik raporunun hızlı ve güvenilir bir şekilde doldurulmasını sağlar. Kullanılabilir araçlar şunları içerir: nokta, mesafe, 
alan ve hacim ölçüm araçları (ejeksiyon fraksiyonu, kardiyak çıktısı, diyastol sonu hacmi, sistol sonu hacmi ve hacim 
akış ölçümleri).

Sol ventriküler kontur tespiti, kapak düzlemi tespiti, akış analizi için damar konturu tespiti, miyokardiyum ve enfarktüs 
boyutu ölçümü için sinyal yoğunluğu analizi ve T2* analizi için yarı otomatik araçlar da mevcuttur.

Ölçüm araçlarının sonuçları hekim tarafından yorumlanır ve ilgili diğer hekimlere aktarılabilir.

Bu araçlar, eğitimli bir hekim tarafından yorumlandığında teşhisi desteklemek için yardımcı olabilir.

Kullanım Amacı
suiteHEART® Yazılımının amacı, kardiyak işlevinin kalifikasyonu ve kantifikasyonu konusunda eğitimli klinik personele 
yardımcı olmaktır. Yazılım, DICOM görüntü parametrelerini ayarlamak için araçlar ve kullanıcının faydalanabileceği, 
zaman içinde MRI ile alınmış kalp ve damar düzeni görüntülerini gösteren, gösterim durumları sunar. Yazılım buna ek 
olarak, kardiyak işlevini nicel hale getirmek için kullanılabilecek doğrusal mesafe, alan ve hacim ölçme araçları sağlar. 
Son olarak, yazılım ,hacimsel akış ölçümlerini yapmak için araçlar sunar ve akış değerlerini hesaplama yeteneği sağlar.

Desteklenen DICOM Görüntü Biçimleri
suiteHEART® Yazılımı, şu DICOM biçimlerini destekler; MR ve Gelişmiş MR. Desteklenen biçimler hakkında daha fazla 
ayrıntı için suiteHEART® Yazılımı DICOM Uyumluluk Beyanı el kitabına bakın.

DİKKAT: Harici bir PACS’tan içe aktarılan ve DICOM görüntüsü olarak saklanan veri, suiteHEART® Yazılımı ile 
görüntülenmek için uyumlu olmayabilir. 
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Güvenlik Bildirimleri

UYARI : Uygulama, yalnızca görüntülerin analizine yardım eder ve otomatik olarak sonuçların klinik açıdan bir 
yorumunu üretmez. Kantitatif ölçümlerin kullanımı ve yerleştirilmesi kullanıcının inisiyatifindedir. 
Ölçümler yanlış yapılırsa, hatalı teşhisler meydana gelebilir. Ölçümler, yalnızca uygun bir şekilde 
eğitilmiş ve uzman bir kullanıcı tarafından oluşturulmalıdır.

UYARI : Görüntü üzerindeki artefaktlar yanlış yorumlanırsa hatalı teşhislere neden olabilir. Teşhis için artefakt 
içeren görüntüler kullanmayın. Analiz, yalnızca uygun bir şekilde eğitilmiş ve uzman bir kullanıcı 
tarafından gerçekleştirilmelidir.

UYARI : Görüntülerde hasta adı ya da kimlik numarası yoksa yanlış hasta için teşhis konulabilir. Teşhis için hasta 
adı ya da kimlik numarası içermeyen görüntüleri kullanmayın. Analizden önce hasta bilgilerini görsel 
olarak onaylayın.

DİKKAT: Görüntü filtresinin uygulandığı görüntülerin kullanılması sonuçların değişmesine neden olabilir. 
Kullanıcı piksel yoğunluğu düzeltilmiş görüntüleri analiz etmeden önce kendi inisiyatifini kullanmalıdır. 

Ekipman Tehlikeleri

DİKKAT: Hasarlı veya zarar görmüş ekipman kullanılması halinde, teşhisin gecikmesi nedeniyle hasta için risk 
oluşabilir. Ekipmanın düzgün çalıştığından emin olun.

DİKKAT: Uygulamalar, üzerinde hastalarla ilgili tıbbi bilgileri olan, bir veya daha fazla sabit disk sürücü içeren 
ekipmanlar üzerinde çalışır. Bazı ülkelerde bu tarz ekipmanlar, kişisel verilerin işlenmesi ve serbest 
dolaşımına ilişkin kurallara tabi olabilir. Kişisel verilerin yayımlanması, geçerli düzenleyici kuruma bağlı 
olarak yasal işlem başlatılmasına neden olabilir. Hasta dosyalarına erişimin kesinlikle korunması önerilir. 
Kullanıcı, hasta bilgilerini düzenleyen yasaları anlamaktan sorumludur.
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Siber güvenlik
NeoSoft, yazılımlarının tasarlama ve uygulama süreçlerinde aşağıdaki siber güvenlik önlemlerini almaktadır: 

• Belirli fonksiyonlara (kullanıcı izinleri, veri tabanının yeniden oluşturulması vb.) ilişkin NeoSoft yazılım yönetimi, 
sadece eğitimli idari kullanıcılar tarafından gerçekleştirilebilir. 

• NeoSoft yazılımları, NIST veri tabanında listelenen bilinen güvenlik açıklarına karşı düzenli olarak incelenmekte ve 
gerektiğinde yama yapılmaktadır. 

• NeoSoft yazılımlarında, hasta verilerinin saklanması ve kullanıcı tarafından yapılandırılan bir bağlantı noktası ile hasta 
verilerinin ağ üzerinden aktarılması amacıyla DICOM standardı kullanılmaktadır. 

• Yazılımın tamamen eksiksiz bir şekilde teslim edilmesi amacıyla, kurulum işlemi öncesinde NeoSoft yazılımına md5 sum 
doğrulaması uygulanır. 

• Şifrelemenin etkin olduğu donanımlarda NeoSoft yazılımlarının kullanıma uygunluğu doğrulanmıştır. 
• NeoSoft, tasarımı itibarıyla, ISO 14971 standardı uyarınca siber güvenlik risklerini azaltmaktadır. 
• NeoSoft çalışanları, Siber Güvenlik ve Sağlık Bilgilerinin Korunması konularında eğitim almaktadırlar.
• NeoSoft, sorun giderme amacıyla müşteri tarafından özellikle erişim izni verilmediği müddetçe, korunmakta olan sağlık 

bilgilerini almaz ve bunların yönetimini gerçekleştirmez.
• NeoSoft yazılımları, sızma testinden geçirilmiştir.
• Otomatik oturum kapatma (ALOF) - suiteHEART, belirli bir süre kullanılmadığında kapatılmak üzere ayarlanabilir. suiteDXT, 

bir kullanıcı tarafından kapatılana ya da sistem yeniden başlatılana kadar açık kalır. 
• Denetim kontrolleri (AUDT) - suiteHEART ve suiteDXT, yazılım olaylarını ve kullanıcı bilgilerini kapsayan zaman damgalı 

günlükler üretmektedir. 
• Yetkilendirme (AUTH) - suiteDXT’de, bir yönetici erişim kontrolünü görüntüleyebilir ve başka kullanıcılar için yapılandırabilir. 

Erişim yapılandırmasının ne şekilde gerçekleştirildiğine bağlı olarak, kullanıcılar suiteDXT’de ve suiteHEART’ta yalnızca belirli 
çalışmaları görüntüleyebilir. Örneğin; Kullanıcı A, çalışma bilgilerine yalnızca A konumundan erişim sağlayabilirken Kullanıcı B 
ise çalışma bilgilerine A ve B konumlarından erişim sağlayabilir. 

• Düğüm doğrulaması (NAUT) - AE başlığı, IP adresi ve DICOM bağlantı noktası yapılnadırılarak suiteDXT, başka DICOM 
cihazlarıyla iletişim kurmak üzere yapılandırılabilir. suiteHEART’ın varsayılan ayarlarında ağ oluşturma kullanımı mevcut 
değildir; fakat AE Başlığı, IP Adresi ve bağlantı noktası aracılığıyla başka bir sistem (sistemler) tespit edilerek yapılacak bir 
yapılandırma değişikliği suretiyle başka sistemlere veri gönderilecek şekilde ayarlanabilmesi mümkündür. Her iki ürün de 
bir ağ aracılığıyla çalışma verisi gönderip almak yerine, yerel çalışma verilerinin dosya sisteminden içe aktarılarak, herhangi 
bir ağ oluşturmaksızın kullanılabilir. 

• Kişi doğrulama (PAUT) - suiteHEART ve suiteDXT; kullanıcı doğrulaması, kullanıcı şifre kontrolleri ve oturum açmış olan 
kullanıcıya özel mevcut hasta bilgilerinin yapılandırılmasına olanak tanıyacak şekilde ayarlanabilir. Kullanıcı bilgileri günlüğe 
kaydedilir. 

• Bağlantı kapasitesi (CONN) - suiteDXT, yapılandırılmış başka DICOM eşlerine bağlanarak veri aktarımı yapabilir. suiteHEART; 
AE Başlığı, IP Adresi ve bağlantı noktası ile başka sistemler tespit edilerek yapılacak bir yapılandırma değişikliği suretiyle 
başka sistemlere veri gönderecek şekilde yapılandırılabilir. 

• Fiziksel kilitler (PLOK) - Mevcut değil. NeoSoft, koruma için Ağ güvenliği ürünlerinin kullanımını önerir. 
• Sistem ve uygulama güçlendirme (SAHD) - Mevcut değil. NeoSoft, koruma için Ağ güvenliği ürünlerinin kullanımını önerir.
• Sağlık verisi gizleme (DIDT) - suiteDXT’de hasta çalışmalarının gizlenmesine yarayan bir “Anonimleştirme” özelliği 

mevcuttur. 
• Sağlık verisinin bütünlüğü ve doğruluğu (IGAU) - suiteDXT’de, içe aktarma veya transfer işleminin başarılı bir şekilde 

gerçekleştirildiğini veya bir hatanın meydana geldiğini bildiren, çalışma bilgilerinin içe aktarılmasına/transferine ilişkin 
durum mesajları mevcuttur. suiteHEART, beklenen giriş verilerinin kaybolması veya bozulması halinde bir açılır pencere 
ile kullanıcıyı uyarır. 
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• Veri yedekleme ve kurtarma (DTBK) - suiteHEART tarafından oluşturulan verilerin, uzun süreli saklama/yedekleme için 
PACS’e gönderilmesi önerilir. suiteDXT’de, yerel yazılımın bozulması halinde kullanılacak bir veri tabanı yenileme aracı 
bulunur. 

• Sağlık verisi saklama gizliliği (STCF) - suiteHEART ve suiteDXT’nin nitelikli personel tarafından kullanılması amaçlanmıştır 
ve kullanıcının takdirine göre kullanıcı adı ve şifre aracılığıyla korunmaları mümkündür. 

• İletim gizliliği (TXCF) - Her türlü veri aktarımı DICOM formatında yapılır. 
• İletim bütünlüğü (TXIG) - Her türlü veri aktarımı DICOM formatında yapılır.
• Siber güvenlik ürün yükseltmeleri (CSUP) - her türlü kurulum ve yükseltme işlemi, izin verilen yeni yazılım sürümüne 

uygun olacak ve müşterinin takdirine göre uygulanacaktır. 
• Yazılım malzeme listesi (SBoM) - suiteHEART’ın “Hakkında” ekranında üçüncü taraf yazılımlarının bir listesi bulunur. 

suiteDXT 3. taraf yazılım bilgileri, “3pInfo” isimli suiteDXT kurulum dizini dosyasında bulunabilir. 
• Cihaz kullanım ömründeki üçüncü taraf bileşenlerine ilişkin yol haritası (RDMP) - NeoSoft, üçüncü taraf yazılımlarını 

düzenli olarak değerlendirir ve gerekmesi halinde suiteHEART’ı ve/veya suiteDXT’yi güncelleyebilir. 
• Güvenlik kılavuzu (SGUD) - NeoSoft, antivirüs yazılımı kullanılmasını önerir. 
• Ağ Güvenliği Özelliğinin Yapılandırılması (CNFS) - Kullanıcı ihtiyaçlarına bağlı olarak ürünün ağ güvenliği özelliklerini 

yapılandırma becerisi - Hem suiteHEART hem de suiteDXT, ağ oluşturma işlemi yapılmaksızın kullanılabilir. Fakat ağ transferi 
için yapılandırılması halinde yalnızca AE Başlığı, IP adresi ve Bağlantı noktası bilgilerine gerek duyulur. İlave bir güvenlik 
işlemi gerekmez/önerilmez. 

• Acil durum erişimi (EMRG) - Mevcut değil. suiteHEART ve suiteDXT, acil durumlarda kullanılmaz. 
• Uzaktan servis (RMOT) - Müşterinin belirlediği uzaktan erişim yöntemiyle (örn. uzak masaüstü) servis hizmeti uzaktan 

gerçekleştirilebilir. suiteHEART ve suiteDXT’de uzaktan erişim özelliği mevcut değildir. 
• Kötü amaçlı yazılım tespiti/koruması (MLDP) - Mevcut değil. suiteHEART ve suiteDXT’de kötü amaçlı yazılım tespiti veya 

koruması özellikleri mevcut değildir. NeoSoft, koruma için Ağ güvenliği ürünlerinin kullanımını önerir.
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Başlangıç

Uygulamayı Başlatma ve Uygulamadan Çıkma
suiteHEART® Yazılımı, Kardiyak MRI (Manyetik Rezonans Görüntüleme) verilerinin analiz edilmesi, gözden geçirilmesi ve 
raporlanması için kullanılabilen bir uygulamadır. Bu el kitabı, suiteHEART® Yazılımı kullanıcı arabiriminin ve kardiyak MR 
görüntülerin üzerinde kantitatif analiz gerçekleştirmeye yönelik iş akışının ayrıntılı bir açıklamasını sunar.

suiteHEART® Yazılımını Başlatma
1. Masaüstü kısayolunu kullanarak suiteDXT uygulamasını başlatın.

NOT: Uygulamalar arasında gerekli dosya aktarımını/aktarımlarını gerçekleştirmek için hem suiteDXT hem de 
suiteHEART® Yazılımı uygulamaları çalışıyor olmalıdır (eş zamanlı olarak).

2. Ana Ekranda Uygulama Başlatma (Launch Application) aşağı açılır menüsüne gidin ve suiteHEART® Yazılımını seçin.

ŞEKİL 1. Uygulamayı Başlatma
 

3. Çalışma listesinde bir çalışma seçin ve şunlardan birini yapın:
• Başlat (Launch) ögesini seçin.
• Çalışmanın üzerine çift tıklayın.

4. Bir çalışma grubu seçin ve Başlat (Launch) ögesini seçin.

Diğer çalışmaları görüntülemek için Dosya > Çalışmayı Değiştir'i (File > Switch Study) kullanın.

NOT: Ekran çözünürlüğü 1920x1080 veya daha yüksek bir çözünürlüğe ayarlanmış olmalıdır(Yatay); 2160x3840 veya 
üstü (Dikey), aksi halde yazılım başlamaz.

UYARI : Analizde piksel yoğunluk filtresi uygulanmış görüntüler kullanmak hatalı sonuçlara neden olabilir.
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suiteHEART® Yazılımından Çıkma
Uygulamadan çıkmak için Dosya (File) > Çıkış (Exit) ögelerini seçin veya arayüzün sağ üst köşesindeki X simgesine tıklayın.

ŞEKİL 2. suiteHEART® Yazılımını kapatın
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Kullanıcı Arayüzüne Genel Bakış
Genel Bakış

suiteHEART® Yazılımı analiz modları arayüzleri aşağıdaki gibi düzenlenmiştir:

• Sonuç Paneli - Her analiz modu ve sonuç tablosu için analiz araçlarına erişin
• Küçük Resim Görünümü - Tüm kesit konumlarını görüntüleyin
• Düzenleme Görünümü - Segmentasyonu düzenleyin ve inceleyin
• Matris - İşlev ve Miyokardiyal Perfüzyon analizi için kullanılabilir 
• Film Görünümü - Görüntüyü bir film olarak görüntüleyin 
• Çapraz Başvuru - 3 görüntüleme alanı 
• Rapor Görünümü (Alt + R): Menü odaklı raporlamaya erişin

ŞEKİL 1. Analiz Modu Arayüzü (İşlev Analizi Modu görünür.) 
Küçük Resim Görünümü Matris 

Film Görünümü Düzenleme GörünümüSonuç Paneli Rapor Görünümü 

Çapraz 
Başvuru 
Görüntüleme 
Alanları
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Analiz/Görüntüleyici Modları

NOT: Patent Foramen Ovale (PFO) Analizi, dosya aşağı açılır menüsünden veya klavyede Ctrl+5 tuş kombinasyonu ile seçilebilir.

Seride Dolaşma

Seçili çalışma içindeki görüntüleri görüntülemek veya serileri değiştirmek için Görüntü Görüntüleyicinin üst kısmında bulunan sağ ve 
sol ok tuşlarını kullanın. Filtre (Filter) düğmesinin solunda bulunan seri aşağı açılır menüsü de seri seçimi yapmak için kullanılabilir. 
Analiz veya ilgi bölgesi içeren seriler Şekil 2‘de gösterildiği gibi kalın harflerle gösterilir.

ŞEKİL 2. Seride Dolaşma

Tablo 1: Analiz Modları

İşlev Analizi Akış 
Analizi

Miyokardiyal 
Değerlendirme

T1 
Eşleştirme

T2 
Eşleştirme

Miyokardiyal 
Perfüzyon Analizi

T2* Analizi

Tablo 2: Görüntüleme Modları

Görüntüleyici Virtual Fellow® 3B/4B Akış 
Görüntüleyici
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Düzenleme Penceresi ve Mod Görünümü

Görüntü Görüntüleyicide görüntü üzerine sağ fare tuşuyla tıklarsanız görüntü kullanma araçları etkinleşir. 

Dosya Menüsü Seçenekleri
Analiz Seç (Select Analysis) – Analiz modunu seçer (İşlev, Akış, Miyokardiyal Değerlendirme, Miyokardiyal Perfüzyon, PFO, T2*, 

T1 Eşleştirme, T2 Eşleştirme, 3B/4B ve DENSE•) 
VT Tara (BrowseDB) – Yerel veri tabanını açar
Çalışmayı Değiştir (Switch Study) – Analiz modu için kullanılabilir çalışmaları listeler
Rapor Önizleme (Preview Report) – Biçimlendirilmiş raporu önizleme
Rapor Yazdır (Print Report) – Raporu yazdırır
İncelemeyi Onayla (Approve Exam) – Son raporu imzayla onaylar ve kilitler
Onaylı İnceleme Yükle (Load Approved Exam) – Daha önceden açılmış bir raporu yükler
Çıkış (Exit) – Geçerli analiz sonuçlarını ikinci alım (SCPT) serisine kaydederek uygulamayı kapatır.

•Araştırma Anlaşması gerektirir

Araçlar Menüsü Seçenekleri
Tercihler (Preferences) >

Düzenle (Edit) – Sistem ve şablon tercihlerini düzenlemek için tercih düzenleyicisini açar
İçe Aktar (Import) – Kullanıcı tercihlerini ve makroları geri yükler
Dışa Aktar (Export) – Tüm kullanıcı tercihlerini dışa aktarır

Dışa Aktar (Export) >
Raporu DICOM olarak gönder (Report to DICOM) – Geçerli analiz sonuçlarına göre bir rapor üretir ve ikinci alım (SCPT) 

serisine kaydeder.
Raporu Excel olarak gönder (Report to Excel) – Analiz sonuçlarını içeren bir Excel çalışma sayfası üretir.
Raporu XML olarak gönder (Report to XML) – Raporu XML dosyası olarak dışa aktarır.
Görüntüleri DICOM olarak gönder (Images to DICOM) – Mevcut seçilmiş seriden DICOM filmi oluşturur ve SCPT dosyası 

olarak kaydeder.
... konumuna raporla – Sonuçları, üçüncü bir taraf raporlama sistemine aktarır.
Görüntüleri JPEG, AVI, vb. olarak gönder (Images to JPEG, AVI, etc.) – Mevcut seçilmiş seri görüntülerini seçilen dosya 

biçimlerinden birinde dışa aktarır. Kullanılabilir 
biçimler şunlardır: sıkıştırılmış QuickTime video, JPEG, 
TIFF, GIF, PNG veya sıkıştırılmamış AVI video.

Verileri Matlab olarak gönder (Data to Matlab) – Mat-file'ı ikili biçimde dışa aktarır. (Araştırma anlaşması gerektirir)
Gerilim Verilerini Matlab olarak gönder (Strain Data to Matlab) – Mat-file'ı ikili biçimde dışa aktarır. (Gerilim Analizi, 

bir araştırma anlaşması gerektirir)

Tablo 3: Görüntü Kullanım Araçları

Pencere/Düzey

Kaydır

Yaklaş

Döndür

Çevir

Rapora Gönder

Tarama Parametreleri

Sıfırla
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Rapor Veri tabanı – Veri tabanı arama arayüzünü açar
Notu Aç/Kapat (Toggle Annotation) – ROI notunun açılıp kapatılmasını sağlar
Hat Kalınlığını Aç/Kapat (Toggle Line Thickness) – Notların çizgi kalınlığının gösterilip kaldırılmasını sağlar.
Çapraz Başvuru Hatlarını Aç/Kapat (Toggle Cross Reference Lines) – Görüntüler üzerindeki çapraz başvuru hatlarının gösterilip 
kaldırılmasını sağlar.
Görüş Alanı Aç/Kapat (Toggle FOV) – Görüş alanının açılıp kapatılmasını sağlar
Pencereyi/Seviyeyi Ters Çevir (Invert Window/Level) – Pencere/seviye görünümünü ters çevirir

Yardım Menüsü Seçenekleri
Kullanım Talimatları (Instructions for Use) – suiteHEART® Yazılımı Kullanım Talimatları
DICOM Uyumluluk Beyanı (DICOM Conformance Statement) – suiteHEART® Yazılımı DICOM Uyumluluk Beyanı
suiteHEART® Hakkında (About suiteHEART®) – Uygulama sürüm bilgisi 
Hızlı Tuşlar (Quick Keys) – Klavye işlevleri

Düzenleme  Görüntüleme Kontrolleri

Aşama Kaydırma Çubuğu (Phase Slider Bar)  film aşama seçimini 
kontrol eder.

Ctrl tuşuna ve orta fare düğmesine eş zamanlı basarak aşamalar arasında ilerleyin.

Görüntü Atlama Simgeleri (Image Step Icons)  kesit veya 
aşamalarda küçük resim görünümü varken kesitten kesite gezinmeyi sağlar.

Tercih ayarlarınıza göre klavyedeki Sol ve Sağ Ok Tuşlarını kesitler arasında, Yukarı ve Aşağı Tuşlarını da aşamalar arasında gezinmeyi 
kontrol eder. 

NOT: x (kesit) ve y (aşama) eksenleri değiştirilebilir. Bkz. İşlev (Function), sayfa 34. Değiştirme yapılırsa uygulama kapatılıp 
yeniden başlatılmalıdır.

Görüntü Görüntüleyici Kontrolleri

 - Film Kontrol Çubuğu: Filmin başlangıç ve bitiş karelerini tanımlar.

 - Saniyedeki Kare Sayısı (FPS): Film hızını değiştirmek için oka tıklayın veya metin kutusuna bir değer girin.

 - Oynatma Simgesi: Film kontrol çubuğunun yanında yer alır

 - Duraklatma Simgesi: Film kontrol çubuğunun yanında yer alır
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Çapraz Başvuru Görüntüleme Alanları

Üç çapraz başvuru görüntüleme alanı, görüntü düzenleme penceresinde kısa eksen görünümü varken, görüntünün uzun eksen 
görünümünü gösterir. Uzun eksen görünümü, düzenleme görüntüleme alanında gösterilen görüntünün açısı içinde yer alan dikgen 
bir kesittir. Çapraz başvuru kesit göstergelerinin görünümünü değiştiren bir düğme ve tüm dikgen dilimler için kullanılabilen aşağı 
açılır bir menü mevcuttur. Kesit konumları arasında dolaşmak için eksi ve artı tuşlarını kullanın.

ŞEKİL 3. Seri Aşağı Açılır Seçici

 

Görüntü Kullanım Araçları

Tablo 4: Araç Açıklamaları

Kesit/Aşama Gözden Geçirme Açma/Kapatma

Pencere/Seviye (Window/Level) – Ayar yapmak için seçin ve orta fare düğmesini kullanın.

Renk Ölçeği (Color Scale) - Ayar yapmak için seçin ve orta fare düğmesini kullanın

Kaydır (Pan) – Ayar yapmak için seçin ve orta fare düğmesini kullanın.

Yaklaş (Zoom) – Ayar yapmak için seçin ve orta fare düğmesini kullanın.

Döndür (Rotate) – Ayar yapmak için seçin ve orta fare düğmesini kullanın.

Yatay Çevir (Flip Horizontal) – Görüntüyü yatay olarak çevirir.

Aralık-Hepsi (Scope All) – Görüntü için yapılan işlemi tüm kesitlere uygular.

Aralık-Mevcuttan Bitişe Kadar (Scope Current to End) – Görüntü için yapılan işlemleri mevcut kesitten bitişe 
kadar uygular.

Aralık-Sadece Mevcut (Scope Current to End) – Görüntü için yapılan işlemleri sadece mevcut kesite uygular.

Görüntüleme Alanı Yerleşimi (Viewport Layout) – Görüntüleyici yerleşimini değiştirir.
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Karşılaştırma Modu (Compare Mod) – Karşılaştırma moduna geçiş yapar.

Gözden Geçirme Modu (Review Mod) – Gözden geçirme moduna geçiş yapar.

Çapraz Başvuru Hatlarını Göster (Show Cross Reference Lines) – Çapraz başvuru hatlarını açar/kapatır.

Renkli Harita Katmanı (Colormap Overlay) – Kesit sınıflandırma renkli haritasını açar/kapatır.

Sıfırla (Reset) – Kapsam ayarlarına uygun olarak W/L (Pencere/Düzey), Kaydırma, Yaklaşma ve Döndürme 
işlemlerini varsayılana geri getirir.

İlgi Bölgesi (Region of Interest) – Alan ve çevre ölçümleri sağlar.

Artı İmleci (Crosshair) – Tek piksel verisi için örnekleme sağlar.

Doğrusal (Linear) – Düz hat mesafelerini ölçme imkânı sağlar.

Etiket (Label) – Düzenleme penceresinde kullanıcı notlarının eklenmesini sağlar.

Açı (Angle) – Açı ölçümü sağlar.

Bulma Özelliği (Find Feature) – Aynı konumu içeren görüntüleri otomatik olarak belirlemeyi ve görüntülemeyi 
sağlayan çapraz başvuru aracı.

Geri Al (Undo) – ROI düzenleme için kullanılan geri alma işlevidir.

Yenile (Refresh) – Görüntü Görüntüleyiciyi ağdan yeni alınan görüntülerle güncellemek veya analiz modlarını 
güncellemek için bu düğmeye tıklayın.
Filtrele (Filter) – Analiz moduna uygun olarak serileri vuruş sekans tiplerine göre sıralar. HEPSİ (ALL) seçimi 
yapılarak seçim kaldırılabilir. Filtreler Tercihler (Preferences) menüsünden ayarlanabilir. Filtre kullanımda 
olduğunda, filtre düğmesi yeşil renkte görünür.

Tablo 4: Araç Açıklamaları
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Hızlı Tuşlar 

*Aktif ayarlar Tercihler içinde yapılan seçimlere göre değişir.

Eylem Hızlı Tuş Eylem Hızlı Tuş

Görüntüyü Yakınlaştırma Ctrl + Orta Fare Düğmesi T2* Ctrl+6

Görüntüyü Döndürme Ctrl + Shift + Orta Fare 
Düğmesi

T1 Eşleştirme Ctrl+7

Görüntüyü Kaydırma Shift + Orta Fare Düğmesi T2 Eşleştirme Ctrl+8

Pencere/Düzey Alt + Orta Fare Düğmesi 3B/4B Akış Görüntüleyici Ctrl+9

Film Oynat/Duraklat Boşluk Tuşu Kesitler arasında dolaş* Sol ve Sağ Ok Tuşları

Aşama Kaydırma Ctrl + Fare Tekerleği Aşamalar arasında dolaş* Yukarı ve Aşağı Ok Tuşları

Rapor Görünümü Alt + R Virtual Fellow® Kesitine Git Sonraki ve önceki kesit için Z ve 
A tuşu

Görüntüleme için tüm 
görüntüleri yeniden seç

Ctrl+A Genel Açıklamalar

Rapor Veritabanı Ctrl+D Doğrusal Shift+1

Tercihleri Düzenleme Ctrl+E Artı İmleç Shift+2

Görüş Alanını (FOV) Açma/
Kapatma

Ctrl+F İlgi Alanı Shift+3

İncelemeyi Onayla Ctrl+G Etiket Shift+4

Pencereyi/Düzeyi Ters Çevirme Ctrl+I Açı Shift+5

Kalın Hat Notu Ctrl+L ROI (İlgi Alanı) Düzenleme Araçları

VT’yi Açma ve Tarama Ctrl+O ROI’yi kopyala Ctrl+C

Raporu Yazdır Ctrl+P ROI’yi yapıştır Ctrl+V

Uygulamayı Kapatma veya Çıkış 
Yapma

Ctrl+Q ROI’yi düzgünleştir Ctrl+S

Rapor Önizlemeyi Aç Ctrl+R ROI’yi dikey olarak kaydır W ve S Tuşları

Çalışma Değiştir Ctrl+S ROI’yi yatay olarak kaydır A ve D Tuşları

Notu Aç/Kapat Ctrl+T Bir eğri köşe noktası oluşturun Alt + Sol Fare Düğmesi

Çapraz Başvuru Hatlarını Aç Ctrl+X Bir noktayı silin (eğri noktası) DELETE + İmleç bir nokta 
üzerinde

Geri Alma Ctrl+Z 3B/4B Akış Görüntüleyici Düzenleme Araçları

DENSE Ctrl+0 3B Döndür Ctrl + Alt + Orta Fare Düğmesi

İşlev Ctrl+1 Görüntüyü Yakınlaştırma Ctrl + Orta Fare Düğmesi

Akış Ctrl+2 Pencere/Düzey Alt + Orta Fare Düğmesi

Miyokardiyal Değerlendirme Ctrl+3

Miyokardiyal Perfüzyon Ctrl+4

PFO Ctrl+5
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Sonuç Paneli

Her analiz modu için Sonuç Paneli vardır.

ŞEKİL 4. Sonuç Paneli

 1. Sonuç tablosu, 2. Grafik görünümü 3. Sil, 4. Grafikler, 5. Tablolar

1

2

5

3

4

suiteHEART® Yazılımı Kullanım Talimatları NS-03-043-0003-TR Rev. 1 15



Sonuç Tablosu

Ölçüm sonuçları yeniden sıralanabilir ve tercihlerde yapılandırılabilir (bkz. Yazdırma Sekmesi, sayfa 42). Ölçüm tablosu, bir satır 
seçilerek ve yeni bir konuma sürüklenerek yeniden düzenlenebilir. Tablonun sırası, tüm yeni çalışmalar için tercihteki sıra her zaman 
varsayılan olacaktır. Ölçüm yanında bulunan kutuya tıklayarak bir ölçümün rapora eklenip eklenmeyeceğini belirleyin.

ŞEKİL 5. Sonuç Tablosu

NOT: Kalp atışını düzenlemek veya girmek için doğrudan tabloya tıklayın.

 Grafik ve Tablo Sonuçları

Sonuçlar, Analiz Görünümünde sağ alt köşede bulunan simgelerden seçim yapılarak grafik veya tablo biçiminde görüntülenebilir.

ŞEKİL 6. Grafik (sol) ve Tablo (sağ):
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Tablo 5: Analiz Araçları

 Sol Ventriküler Endokardiyal ROI  Uzun Eksen LV Endokardiyal ROI 

 Sol Ventriküler Epikardiyal ROI
 Uzun Eksen LV Epikardiyal ROI 

 Sağ Ventriküler Endokardiyal ROI
  Sol Ventriküler Septal ROI

 Sağ Ventriküler Epikardiyal ROI
 Sol Ventriküler Yerel ROI

 Mitral Kapak Anülusu
 Sol Ventriküler Kan Havuzu ROI’si

 Triküspit Kapak Anülusu

 Sağ Ventriküler Ekleme Noktası

 Sol Ventriküler Papiller Kas ROI’si

 Sağ Ventriküler Papiller Kas ROI’si

 Sol Atriyal ROI 

 Sağ Atriyal ROI

 Uzun Eksen RV Endokardiyal ROI

 Uzun Eksen RV Epikardiyal ROI
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Rapor Görünümü

Menü odaklı raporlama arayüzünü açmak için Alt + R tuşlarına aynı anda basın. 
Daha fazla bilgi için bkz. Menü Odaklı Raporlama, sayfa 167.

ŞEKİL 7. Rapor Görünümü

 - Rapor Görünümü: Menü Odaklı Raporlama arayüzünü veya Analiz Modunu açmak için kullanılır

 - Rapor Önizleme: Bir raporu önizleme için kullanılır

 - İncelemeyi Onayla: Raporu imzalamak için kullanılır

VT Tarama

VT Tarama penceresi, yerel veri tabanında bulunan geçerli çalışmaların görüntülenmesini sağlar. Hangi çalışmaları görüntüleyeceğinizi 
veya çalışma değiştirme listesine ekleneceğinizi seçmenize izin veren kontroller bulunmaktadır.
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ŞEKİL 8. VT Tarama

1. Yerel veritabanı listesi, 2. suiteHEART® Yazılımı veritabanı görüntüleyici, 3. Görüntüleyiciye Ekle düğmesi, 4. Görüntüleyiciden Kaldır, 
5. Görüntüyü Güncelle, 6. İptal

VT Tarama Özellikleri

VT tara seçeneği varsayılan değeri her zaman yerel veri tabanıdır.

1. Yerel veritabanı listesi (Local database listing) – yerel veri tabanında saklanan incelemeleri görüntüler.
2. suiteHEART® Yazılımı veritabanı görüntüleyicisi (suiteHEART® Software database viewer) – geçerli suiteHEART® Yazılımı veri 

tabanında yer alan incelemeleri görüntüler.
3. Görüntüleyiciye Ekle (Add to Viewer) – Yerel veri tabanından seçilen incelemeyi (pencerenin üst kısmında gösterilir) suiteHEART® 

Yazılımı veritabanı görüntüleme alanına ekler.
4. Görüntüleyiciden Kaldır (Remove from Viewer) – İncelemeyi suiteHEART® Yazılımı veri tabanı görüntüleme alanından kaldırır.
5. Görünümü Güncelle (Update View) – Veri Tabanı Tarama penceresini kapatır ve görüntülenebilir liste alanındaki incelemeleri 

uygulama görüntüleyiciye getirir. Çalışmaları değiştirme penceresini doldurmak için kullanılır.
6. İptal (Cancel) – Veri Tabanı Tarama penceresini listede değişiklik yapmadan kapatır.

1

2

3 4

6

5
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VT Tarama Prosedürü

Çalışmalar, yerel veri tabanından seçilip suiteHEART® Yazılımı veritabanı Görüntüleyiciye eklenebilir ve Görünümü Güncelle 
(Update View) ögesine tıklanarak görüntülenebilir.

suiteHEART® Yazılımı Çalışma Değiştirme Listesine Çalışma Ekleme
1. Dosya (File) > Veri Tabanına Gözat (Browse DB) ögelerini tıklayın.
2. Veri tabanı görüntüleyici içinde çalışmayı bulun ve çalışmayı işaretlemek için üzerine tıklayın.
3. Görüntüleyiciye Ekle (Add To Viewer) ögesine tıklayın.
4. Görünümü Güncelle (Update View) ögesine tıklayın.
5. Çalışma artık suiteHEART® Yazılımı Çalışma Değiştirme Listesine eklenmiştir.

suiteHEART® Yazılımı Çalışma Değiştirme Listesinden İnceleme Çıkarma
1. Dosya (File) > Veri Tabanına Gözat (Browse DB) ögelerini tıklayın.
2. Çalışmayı bulun ve Görüntüleyiciden Çıkar (Remove from Viewer) ögesine tıklayın.
3. Görüntüleyiciyi Güncelle (Update Viewer) ögesine tıklayın.

DİKKAT: Halen suiteHEART® Yazılımı içinde açık olan bir çalışmayı silmeyin.

Çalışmaların görüntüleyicide gösterilebilmesi için önce suiteHEART® Yazılımına yüklenmesi gerekir. Çalışma Değiştirme Listesinin 
doldurulmasını için bkz. VT Tarama Prosedürü, sayfa 20.

suiteHEART® Yazılımında Çalışma Değiştirme
1. File (Dosya) > Switch Study (Çalışmayı Değiştir) ögelerini tıklayın.

Kullanılabilir Çalışmalar (Available Studies) penceresi, daha önce VT'na Gözat işlemi tarafından yüklenen tüm incelemelerin 
bir listesiyle birlikte görüntülenir.

2. Çalışmayı seçin.
Çalışma Değiştirme (Switch Studies) penceresini açtıktan sonra çalışma değiştirmekten vazgeçerseniz, uygulamaya dönmek 
için pencerenin dışında herhangi bir yere tıklayın.
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Görüntü Yönetim Araçları

Görüntüleyici
Görüntüleyici, çapraz başvurular kullanarak çalışmanın hızla gözden geçirilmesine olanak verir. Görüntüleyici arayüzü, 
seçili çalışma için alınan serilerin listesini her bir seri bir görüntüleme alanında olacak şekilde gösterir. Görüntüleyici 
arayüzü içinde analiz ve gözden geçirme için yeni seri tipleri oluşturulabilir. Çalışma gözden geçirme sürecini hızlandırmak 
maksadıyla, rutin olarak alınan seriler için kullanıcı tanımlı görüntüleme protokolleri tanımlanabilir.

NOT: Görüntüyü dışa aktarma sadece analiz modlarında gerçekleştirilebilir. 

ŞEKİL 1. Görüntüleyici 

1. Çalışma serisi listesi, 2. Seri/Kesit görüntüleme alanı, 3. Çapraz Başvuru, 4., Seriyi kaydet, 5. Çapraz Başvuru, 6. Bulma Özelliği, 7. Ölçüm Araçları

1
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Görüntü/Seri Seçme
Bir seriye tıklayın ve serideki kesit konumlarında gezinmek için klavyedeki Sayfa Yukarı (Page Up) veya Sayfa Aşağı 
(Page Down) tuşlarını kullanın.

Bir sonraki seriye gitmek için klavyedeki sağ ok tuşuna ve bir önceki seriye gitmek için sol ok tuşuna basın.

Çok fazlı bir seriyi bulurken, bunlar otomatik bir düzende görüntülenirken tek fazlı bir seri 1x1 düzeninde görüntülenir.

Bulma Özelliği*

1. Çapraz başvuru aracını kullanmak için  ögesini seçin. 

Mor imleç, görüntü üzerine konumlandırılabilecek esas imleçtir. 

2. Ctrl tuşuna basın ve birincil imleci etkinleştirmek için çapraz başvuru aracını seçin. Tüm yakın kesit konumları otomatik 
olarak görüntülenir.

Bu işlemin ardından, ana görüntüleme alanına ikincil yeşil imlecin birincil mor imlece yakın olarak hesaplandığı 
kesitler getirilir. 

NOT: Görüntüleme alanlarında yeşil ikincil artı notları gelir ve bunların içinde paralel olmayan görüntüler bulunur. 
Bu görüntüler, esas imlecin 3B uzayda 10 mm’ye kadar yakınında olduğu hesaplanan noktalardadır.

NOT: Görüntüleme alanlarında yeşil ikincil artı notları gelir ve bunların içinde paralel görüntüler bulunur. 
Bu görüntüler, esas imlecin 3B uzayda 5mm’ye kadar yakınında olduğu hesaplanan noktalardadır.

Hızlı Tuş  

*ABD Geçici Patent Başvurusu No. 62/923061
Unvan: Method and System for Identifying and Displaying Medical Images
Inventor(s): Wolff et al.

İşlev Eylem
Görüntüleme için tüm 
görüntüleri yeniden seç

Ctrl+A
suiteHEART® Yazılımı Kullanım Talimatları NS-03-043-0003-TR Rev. 1 22



Görüntüleyici İşlevleri
Yeni bir Seri Oluşturma

Görüntüleyici, yalnızca gözden geçirme amaçlı (özel) olarak, İşlev, Miyokardiyal Değerlendirme, Miyokardiyal Perfüzyon, T2*, 
T1 Eşleştirme, T2 Eşleştirme için kullanılabilecek seri türlerinin oluşturulmasına izin verir. Oluşturulan seriler, mevcut çalışmanın 
seri listesine eklenir ve suiteHEART® Yazılımı uygulaması içinde görüntülenebilir ve analiz edilebilir.

NOT: Bir serinin analiz için geçerli olması için, her kesit konumunun aynı sayıda aşamaya, aynı edinim parametrelerine 
ve tarama düzlemi preskripsiyonuna sahip olması gerekir.

UYARI : Kullanıcı, analiz için doğru görüntüleri içeren yeni seriyi analiz için oluşturmaktan sorumludur. 
Hatalı oluşturulan seri analiz edilebilir, ancak doğru olmayan sonuçlar verebilir. Kullanıcı, kardiyak 
analizi konusunda uygun bir eğitim almış olmalı ve yeni seriye kopyalanan kesit konumlarının farkında 
olmalıdır. DICOM içe aktarma için kullanılmış olan orijinal görüntüleri silmeyin.

1. Seri listesinden istenen serileri veya kesit konumlarını seçin.

2. Üst Karakter tuşuna (Shift) basarak bir grup seriyi veya kesit konumlarını seçin ya da Ctrl tuşuna tıklayarak tek seriyi 
veya kesit konumunu ekleyin.

3. Tıklayıp çekerek görüntüleme alanı içinde görüntülerin sıralamasını değiştirebilirsiniz.

4. Bir görüntüyü görüntüleme alanından silmek için, görüntüleme alanını seçin ve klavye üzerindeki Sil (Delete) 
tuşuna basın.

5. Seriyi Kaydetme alanından Şekil 2,  ögesini seçin.

ŞEKİL 2. Seriyi Kaydetme Alanı

6. Uygulama Seri açıklaması için bir seri adı yazın. 

7. Dosya aşağı açılır menüsünden, uygun seri uygulama türünü seçin (Şekil 3). Özel (Custom) seçilirse, farklı tarama 
düzlemlerine ve sekans tiplerine sahip görüntüler bir seri olarak kaydedilebilir.

ŞEKİL 3. Yeni Seriyi Kaydetme

Görüntüleme Protokolleri
Yalnızca NeoSoft’tan talep edilirse kullanılabilir.
Rapor Görünümü

Menü Odaklı Raporlama'ya erişmek veya izleyici işlevine geri dönmek için  ögesine tıklayın.
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Karşılaştırma Modu
Karşılaştırma modu size, aynı mevcut ya da daha önceki bir incelemeden görüntüleri/serileri arayüz içinde eş zamanlı 
olarak gözden geçirme olanağı sağlar.

NOT: Karşılaştırma modunda önceki muayeneden rapora gönderilen görüntüler bitmap biçiminde olur. Bu görüntüler 
üzerinde görüntü işleme yapılamaz.

UYARI : Bir inceleme içinde incelemeleri ya da serileri gözden geçirmeden veya karşılaştırmadan önce, her iki 
görüntüleyici için tüm inceleme hasta göstergelerini görsel olarak onaylayın. 

ŞEKİL 4. Karşılaştırma Modu Görüntüleyici

1 2

Görüntüleyici 1

Görüntüleyici 2

3
4 5

6

7 8

10
9

12

11
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Görüntüleyici Belirtme Açıklama
Görüntüleyici 1 1 Seri aşağı açılır menüsü

2 Seri seçici
3 Görüntülenmekte olan hasta inceleme gösterge hattı
4 Görüntü kontrolleri
5 Görüntüleme alanı yerleşim seçimleri

Görüntüleyici 2 6 Görüntülenmekte olan hasta inceleme gösterge hattı
7 İnceleme seçici 
8 Seri seçici 
9 Görüntüleme alanı yerleşim seçimleri

Her İki 
Görüntüleyici

10 Kapsam ayarlarını değiştir
11 Gözden Geçirme Modunu Aç
12 Eş zamanlı filmi aç
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Örnek İş Akışı
1. Düzenleyici penceresinde herhangi bir analiz modu üzerine çift tıklayın.

2. Arayüzü Şekil 5‘da gösterildiği gibi iki görüntüleyiciye ayırmak için  ögesini seçin.

ŞEKİL 5. Karşılaştırma Modunda Görüntüleme

3. Görüntüleyici 1 içindeki seriyi değiştirmek için seri aşağı açılır menüsünü ya da sağ/sol ok tuşlarını kullanın.
• Bu üst görüntüleyici her zaman daha önce başlatılmış olan mevcut çalışmayı gösterir. 

4. Görüntüleyici 2 içinde göstermek ve Görüntüleyici 1 içinde gösterilen seri ile karşılaştırmak maksadıyla, aynı 
incelemedeki başka bir seriyi seçmek için seri aşağı açılır menüsünü kullanın. 

• Herhangi bir görüntüleyici içinde bir görüntüleme alanı seçilmişse ve bir kısa eksen serisi gibi paralel bir kesit varsa, 
kesit konumuna bağlı olarak, karşılık gelen kesit işaretlenir.

Görüntüleyici 1

Görüntüleyici 2
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ŞEKİL 6. Seri Aşağı Açılır Menüsü, Görüntüleyici 2

5. Görüntüleyici 2 içinde farklı bir inceleme yükleyip Görüntüleyici 1 içinde gösterilmekte olan incelemeyle karşılaştırmak 
için inceleme seçiciyi kullanın.

ŞEKİL 7. İnceleme Seçici, Görüntüleyici 2

6. Her iki görüntüleyicide inceleme gösterge bilgisini kontrol ederek uygun inceleme seçimini onaylayın.

ŞEKİL 8. İnceleme Gösterge Bilgisi

7. Her iki görüntüleyicide de sağ fare tuşuyla tıklayınca görüntü işleme araçları açılır.
• Kapsam seçimi her iki görüntüleyiciye de uygulanır.

NOT: Görüntü farklı bir çalışmada ise, Görüntüler (Images) sekmesinde görüntüye gitme komutunu işletmek geçerli 
bir işlem olmaz. 

NOT: Her iki görüntüleyicide de film serisi seçildiyse ve her iki serinin de aynı sayıda aşaması varsa, film görüntülemeyi 

eş zamanlı hale getirmek için  ögesine tıklayın.
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Tercihleri Tanımlama

suiteHEART® Yazılım Arayüzündeki menü çubuğundan Araçlar (Tools) > Tercihler (Preferences) seçildiğinde üç 
seçenek görüntülenir: 

• Düzenleme
• İçe Aktarma
• Dışa Aktarma

ÖNEMLİ: Rapor edilecek ilk vakayı analiz etmeden önce, kullanıcı tercihlerinin ayarlanması önerilir. Tercihlerdeki 
değişikliklerin geçerli olması için geçerli incelemeyi kapatın ve sonra suiteDXT’yi kapatıp yeniden başlatın. 

Tercihleri Ayarlama
Global Sekmesi - Tercihler, aşağıdaki özellikler için özelleştirilebilir: 

• Rapor (Report)
• Görüntüleyici
• Virtual Fellow®
• Rapor Onay Yetkili Kişiler (Authorized Report Approvers)
• Genel
• Akış (Akış)
• Boşta Kalma Süresi (Idle Timer)
• İşlev (Function)
• Miyokardiyal Değerlendirme
• Seri Filtresi (Series Filter)
• Dışa Aktar (Resim/Video) 

Şablon Sekmesi - Raporlama için kullanılan sonuç parametreleri aralıkları için şablonlar oluşturun.

Makro Sekmesi - İzlenim, Teknikler, Geçmiş ve Bulguların raporlama bölümleri için önceden tanımlanmış metin oluşturun.

Yazdırma Sekmesi - Rapor için sonuç parametrelerinin sırası ve seçimi.

Virtual Fellow® Sekmesi - Görüntüleme tercihlerini seçin.

T1/T2 Eşleştirme Sekmesi - Görüntüleme ve analiz tercihlerini seçin.

Menü Odaklı Raporlama Sekmesi - Menü odaklı metin seçimlerini düzenleyin ve otomatik önceden doldurma işlevi için 
kategorik aralıkları yapılandırın.
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Global Sekmesi
Sekmenin sağ üst köşesindeki Sıfırla (Reset) ögesinin seçimi tüm kullanıcı seçimlerini sıfırlayacaktır.

Rapor (Report) 

Tüm raporlarda görünen başlık bilgilerini yapılandırır.

ŞEKİL 1. Rapor Tercihleri (Report Preferences)

Rapor Tercihlerine İlişkin Seçimler
1. Menü çubuğunda Araçlar (Tools) > Tercihler (Preferences) > Düzenle (Edit) ögelerini seçin. 
2. Global sekmesini seçin.
3. İmleci, Rapor (Report) panelinin istediğiniz alanına getirin ve bilgileri girin. 

Başlıklar, üst bilgiler ve logo belirtilen kağıt boyutundaki raporda gösterilecektir. Bu bilgileri raporun dışında tutmak için 
"Raporda aşağıdaki alan değerlerini kullan” ("Use the field values below in Report”) onay kutusunun seçimini iptal edin. 
Bu, yazdırılan tüm hasta raporları için geçerli olacaktır. 
“Tek ve çift satırları destekle” (“support even and odd row”) onay kutusunu işaretlerseniz arayüzdeki ve rapordaki 
sonuç satırları işaretlenerek gösterilir.

4. Rapora site logosu eklemek için dosyayı jpeg, png veya gif biçiminde hazırlayın ve sabit sürücüye veya CD-ROM'a 
kaydedin. Logo bölümünün altında Gözat (Browse) ögesine tıklayın ve sistem tarayıcı penceresinden dosyanın 
konumunu belirleyin. Uygun logo dosyasını seçin ve Aç (Open)ögesine tıklayın. 

Logo rapor tercihleri panelinde görünecektir.
5. Dışa aktarılacak raporun dosya ismini yapılandırmak için İnceleme Dosya Adı (Exam File Name) üzerine tıklayın.
6. Kaydet ve Çık (Save and Exit) ögesine tıklayın. 

Değişiklikleri kaydetmeden veya kabul etmeden kapatmak için İptal (Cancel) ögesine tıklayın. 
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Görüntüleyici

1. Menü çubuğunda Araçlar (Tools) > Tercihler (Preferences) > Düzenle (Edit) ögelerini seçin.

2. Faz kontrastlı görüntülerde hız renk katmanını ayarlamak için kaydırma çubuğunu kullanın.
Renk kaplamasını kaldırmak için opaklığı %0 değerine ayarlayın.

Virtual Fellow®

ŞEKİL 2. Virtual Fellow® Tercihleri

1. Menü çubuğunda Araçlar (Tools) > Tercihler (Preferences) > Düzenle (Edit) ögelerini seçin.

2. Global sekmesini seçin.

3. Çalışmayı doğrudan Virtual Fellow® uygulaması ile açmak için, Çalışmayı Virtual Fellow® ile Aç (Open study in Virtual 
Fellow®) ögesini işaretleyin. 

4. Kaydet ve Çık (Save and Exit) ögesine tıklayın.
Değişiklikleri kaydetmeden veya kabul etmeden kapatmak için İptal (Cancel) ögesine tıklayın.

Rapor Onay Yetkili Kişiler (Authorized Report Approvers)

Uygulamada son raporu kilitleyen rapor onay özelliği vardır. Rapor onaylandıktan sonra değiştirilemez. Onay yetkili kişiler 
eklenebilir, düzeltilebilir ve silinebilir.

ŞEKİL 3. Rapor Onay Yetkili Kişiler (Authorized Report Approvers)
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Rapor Onay  Yetkili Kişileri Yönetme
1. Menü çubuğunda Araçlar (Tools) > Tercihler (Preferences) > Düzenle (Edit) ögelerini seçin. 

2. Global sekmesini seçin ve imleci Rapor Onay Yetkili Kişiler (Authorized Report Approvers) paneline getirin. 

3. Onay yetkili kişiler listesine kullanıcı adı eklemek için Ekle (Add) sekmesine tıklayın.
• Kullanıcı adı girin.
• Parolayı iki kez girin.
• Ekle (Add) ögesini seçin. 

4. Onay yetkili kişiler listesindeki bir kullanıcının parolasını değiştirmek için Değiştir (Modify) sekmesini seçin.
• Parolası değiştirilecek kullanıcıyı seçin.
• Eski parolayı girin.
• Yeni parolayı iki kez girin.
• Uygula (Apply) ögesini seçin.

5. Onay yetkili kişiler listesinden bir kullanıcı silmek için Sil (Delete) sekmesini seçin.
• Silinecek kullanıcıları seçin.
• Sil (Delete) ögesini seçin.

6. Acuity, Powerscribe veya Precession için uygun Otomatik Dışa Aktarma Konumları'nı seçin.
“Onaylı inceleme” gerçekleştirildiğinde, dışa aktarma otomatik olarak gerçekleştirilecektir. 

7. Kaydet ve Çık (Save and Exit) ögesine tıklayın.
• Değişiklikleri kaydetmeden veya kabul etmeden kapatmak için İptal (Cancel) ögesine tıklayın.

Genel

ŞEKİL 4. Genel Tercihler

Genel Tercihlere ilişkin Seçimler
1. Menü çubuğunda Araçlar (Tools) > Tercihler (Preferences) > Düzenle (Edit) ögelerini seçin.

2. Global sekmesini seçin.

3. Notları kalın çizgiler halinde göstermek için Kalın Çizgili Notlar (Thick Line Annotation) onay kutusunu işaretleyin.
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4. Örtüşme Olmaması için Aktif ROI’yi Sınırla (Limit Active ROI for No Overlap) ögesini kontrol edin. İşaretli olduğunda, 
mevcut olarak seçili olmayan ROI’ler baskındır, işaretli olmadığında ise düzenlenmekte olan ROI baskındır.

5. Bir serbest seçim ROI'sini otomatik olarak nokta eğrisine dönüştürmek için, Eğri Dönüşümünü Göstermek için 
Otomatik Serbest Seçim (Automatic Free Hand to Point Spline Conversion) ögesini işaretleyin.

6. Display Arayüz araç ipuçlarını göstermek için Araç İpuçlarını Görüntüle (Display Tooltips) ögesini işaretleyin.

7. Hasta adını ve kimliğini raporda gizlemek için Hastayı Anonim Hale Getir (Anonymize Patient) onay 
kutusunu işaretleyin.

Tüm hastaların adları “anonim” olarak görünür ve kimlik boş olarak ayarlanır. Bu değişiklikler rapor ve Görüntü 
Görünümüne uygulanacaktır.

8. Raporun onaylanmasından sonra, raporu bir DICOM dosyası olarak dışarı aktarmak için Onaylı İncelemeyi Otomatik 
Olarak Dışa Aktar (Automatically Export Approved Exam) ögesini işaretleyin.

9. Çok çerçeveli kısa eksenli görüntülerden oluşan bir grup eklemek amacıyla sağ fare tıklama seçeneği eklemek için 
Rapor Edilecek Çok Kesitli Görüntü (Multi-Slice Image to Report) ögesini işaretleyin.

10. Açıklamalar kapatıldığında kesit konumunu görüntülemek için Her zaman kesit konumunu göster (Always show slice 
location) ögesini işaretleyin.

11. Dosya aşağı açılır menüden görüntü kullanımı için Kapsam (Scope) seçimini ayarlayın.

12. Measurement Dosya açılır menüsünden Ölçüm Sistemi’ni (Measurement System) İngiliz ölçüsü veya Metrik 
olarak ayarlayın.

13. Doğrusal Ölçüm Birimini cm veya mm olarak ayarlayın.

14. Çift monitör kullanılıyorsa, dosya açılır menüsünden Monitor Seçimi (Monitor Selection) ögesini ayarlayın.

15. Dosya açılır menüsünden İlk Not Düzenleme Modu (Initial Annotation Editing Mode) ögesini ayarlayın. 
Seçimler arasında Hiçbiri (None), Sürükleme Aracı (Nudge Tool) veya Çekme Aracı (Pull Tool) bulunur.

16. Dosya açılır menüsünden Tarih ve Saat Biçimi (Date & Time Format) ögesini ayarlayın.

Akış (Akış)

ŞEKİL 5. Akış Tercihleri

Akış Tercihlere ilişkin Seçimler
1. Menü çubuğunda Araçlar (Tools) > Tercihler (Preferences) > Düzenle (Edit) ögelerini seçin.

2. Global sekmesini seçin.

3. 2B ve 4B aşama kontrastı için otomatik aşama hatası düzeltme yapmak istiyorsanız Otomatik Ana Hat Düzeltme 
(Auto Baseline Correction) onay kutusunu işaretleyin.
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4. Regurjitan Modu (Regurgitant Mode) ögesini işaretleyin: Net negatif akışı otomatik olarak hesaplamak için 
Otomatik (Auto) (x ekseninin altında). 

5. Kullanıcı Tarafından Düzenlenen ROI'yi Değiştir (Replace User Edited ROI) ögesinin işaretlenmesi, 
yayılma gerçekleştirilirse kullanıcı tarafından düzenlenen ROI'lerin yerini değiştirecektir.

6. Düzenleme araçlarını doğrudan görüntüleme alanında göstermek için, Düzenleme Görüntüleme Araçları 
(Display Tools for Editing) ögesini işaretleyin.

7. Yeni bir etikete yazarak, Akış 1 (Flow 1) veya Akış 2 (Flow 2) ögesine ilişkin kategori etiketlerini tanımlayın. 
Bu etiketler, akış arayüzünde araç ipuçları olarak görünecektir.

8. Dosya açılır menüsünden uygun Akış Birimi (Flow Unit) için ml/atış veya l/dk veya hiçbiri (none) seçeneğini seçin.

9. Default Method Entegre Akış paneli hesaplama yönteminin kalıcı olması için, Varsayılan Yöntem (Default Method ) 
ögesini seçin.

10. Akış Rengi Opaklığını (Flow Color Opacity) ayarlamak için kaydırma çubuğunu kullanın.
Renk kaplamasını kaldırmak için opaklığı %0 değerine ayarlayın.

11. Kaydet ve Çık (Save and Exit) ögesine tıklayın.
 Değişiklikleri kaydetmeden veya kabul etmeden kapatmak için İptal (Cancel) ögesine tıklayın.

Boşta Kalma Süresi  (Idle Timer)

Boşta Kalma Süresi (Idle Timer) paneli, uygulamada belirli bir süre herhangi bir eylem yapılmadığında, uygulamanın 
kapatılması için dakika cinsinden bir süre ayarlamak için kullanılır. 

ŞEKİL 6. Boşta Kalma Süresi Ayarları

Boşta Kalma Süresi Seçimleri
1. Menü çubuğunda Araçlar (Tools) > Tercihler (Preferences) > Düzenle (Edit) ögelerini seçin. 

2. Global sekmesini seçin ve imleci Boşta Kalma Süresi (Idle Timer) paneline getirin. 

3. Boşta kalma süresi özelliğini etkinleştirmek için Boşta Kalma Süresi (Idle Timer) onay kutusunu seçin.

4. İstenen süreyi dakika olarak belirlemek için boşta kalma süresi işaretçisini çekin. 

5. Seçimlerinizi saklamak için Kaydet ve Çık (Save and Exit) ögesine tıklayın. 
Değişiklikleri kaydetmeden veya kabul etmeden kapatmak için İptal (Cancel) ögesine tıklayın. 
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İşlev (Function)

ŞEKİL 7. İşlev Tercihleri

1. Görüntü Görüntüleme (Image View) menü çubuğunda Araçlar (Tools) > Tercihler (Preferences) > Düzenle (Edit) 
ögelerine tıklayın.

2. Global sekmesini seçin.

3. Bazal aradeğerleme için otomatik anülus yerleştirme için Otomatik MV Anülusu Yerleştirme’yi (Automatic MV 
Annulus Insertion) tıklayın ve 4 odalı MV Anülusu’nu (Include 4-Chamber MV Annulus) dahil edin . Otomatik TV 
Anülus Ekleme (Automatic TV Annulus Insertion) ögesine tıklayın.

4. Ekseni çevirmek için Matris modu için x(kesit) ve y(aşama) eksenini çevir [Flip x(slice) and y(phase) axis for matrix 
mode] ögesini işaretleyin.

5. Her iki eğriyi de görüntülemek için LV Etkinleştir (Enable LV) ögesini veya RV Gölge Eğri (RV Shadow Curve) 
ögesini işaretleyin.

6. İşlev bölümlemeyi gerçekleştirmek için Otomatik İşlev için kalıcılık analizi araçları (Persist analysis tools for Function 
Auto) ögesini işaretleyin.

7. Düzenlemeyi gerçekleştirmek için Kalıcı Endo/Epi ROI (Persist Endo/Epi ROI) düzenleme modu’nu işaretleyin. 

8. İşlev Analizindeki bu özelliğe erişmek için, Kesitler Arasında Hareket Düzeltme (Motion Correction Between Slices) 
Seriler Arası Hareket Düzeltme, sayfa 71ögesini işaretleyin. 

9. Atriyal Hacim etiketi’ni (Atrial Volume label) seçin: Hacimsel etiketleri değiştirmek için MaxV, MinV.

10. Bölgesel Analiz Kutup Grafikleri için üst ve alt limitler belirleyin.

11. Seçimlerinizi saklamak için Kaydet ve Çık (Save and Exit) ögesine tıklayın. 
Değişiklikleri kaydetmeden veya kabul etmeden kapatmak için İptal (Cancel) ögesine tıklayın. 
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Miyokardiyal Değerlendirme

ŞEKİL 8. Miyokardiyal Değerlendirme Tercihleri

1. Menü çubuğunda Araçlar (Tools) > Tercihler (Preferences) > Düzenle (Edit) ögelerini seçin.

2. Global sekmesini seçin.

3. Ölçüm etiketlerini tanımlamak için bkz. Sonuç Ölçüm Etiketlerini Tanımlama, sayfa 115.

4. Kaydet ve Çık (Save and Exit) ögesine tıklayın.
Değişiklikleri kaydetmeden veya kabul etmeden kapatmak için İptal (Cancel) ögesine tıklayın.

Seri Filtresi (Series Filter)

Analiz modu tipine göre, analiz için uygun serinin seçimini hızlandırmak maksadıyla bir seri filtresi uygulanabilir. 
Filtre tercihleri analiz sırasında ana panelde küçük resim görünümünün üzerinde bulunan filtre düğmesine tıklayarak 
da seçilebilir. 

ŞEKİL 9. Filtre Tercihleri

Ayar Filtre Tercihleri
1. Menü çubuğunda Araçlar (Tools) > Tercihler (Preferences) > Düzenle (Edit) ögelerini seçin.

2. Global sekmesini seçin.

3. Her analiz tipi için uygun açık/kapalı seçimlerinin üzerine tıklayın.

4. Kaydet ve Çık (Save and Exit) ögesine tıklayın. 
• Değişiklikleri kaydetmeden veya kabul etmeden kapatmak için İptal (Cancel) ögesine tıklayın. 
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NOT: Bir seri filtresi uygulandıysa ve gerekli seri mevcut değilse, bir mesaj görünür: “Seçili analiz tipiyle eşleştirilmiş seri 
yok” (“There are no series associated with the selected analysis type”). Tamam (OK) düğmesine tıklanırsa, filtre 
etkisiz hale gelir ve çalışma içindeki tüm seriler gösterilir.

Dışa Aktar (Resim/Video)

Dışa Aktarma (Export) paneli görüntü ve video verilerini dışa aktarmak için görüntü biçimlerini seçmenizi sağlar. 
Dışa aktarma özelliği, görüntü verilerinden sıkıştırılmamış AVI filmleri, sıkıştırılmış QuickTime filmleri ve JPEG, TIFF ve PNG 
dosyaları oluşturmanızı sağlar.

ŞEKİL 10. Resim/Video Dışa Aktarma Tercihleri

Dışa Aktarma Seçimleri 
1. Menü çubuğunda Araçlar (Tools) > Tercihler (Preferences) > Düzenle (Edit) ögelerini seçin. 

2. Global sekmesini seçin ve imleci Dışa Aktarma (Export) paneline getirin. 

3. Uygun görüntü veri türlerini seçin. 

4. Seçimleri kaydetmek için Kaydet ve Çık (Kaydet Exit) ögesine tıklayın. 
Değişiklikleri kaydetmeden veya kabul etmeden çıkmak için İptal (Cancel) ögesine tıklayın. 
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Şablon Sekmesi
Uygulama, yaşa ve cinsiyete göre belirtilen kullanıcı tanımlı normal aralıklara dayalı şablonlar oluşturmaya yönelik bir 
araç sağlar. Kullanıcı tanımlı bir modele göre z puanlarının hesaplanması ve raporlanması desteklenir. Tavsiye edilen 
referanslara bakın.

ŞEKİL 11. Şablon Sekmesi

Önemli Noktalar

Analize başlamadan önce, ana arayüzden kullanıcı tanımlı şablon seçilmelidir. Sağ üstte bulunan Varsayılan (Default) 
ögesine tıklayın ve kullanılacak şablonu seçin. Analiz yaptıktan sonra şablonun değiştirilmesi, şablonda tanımlanan 
normal aralık ve/veya Z-puanı ögesine uygulanacaktır.

ŞEKİL 12. Şablon Değiştirme

NOT: Daha önceki suiteHEART analizlerini içeren içe aktarılmış çalışmalarda, çalışmada kullanılan şablonun adı 
görünebilir. Bu şablon diğer çalışmalar için bulunmayabilir.

Analiz için iki sistem kullanılıyorsa, şablon tercih dosyasının birinci sistemde oluşturulup ikinci sisteme içe aktarılması 
tavsiye edilir. Farklı bir sistemden içe aktarılan şablon tercih dosyaları, aktarıldıkları sistemde oluşturulmuş olan şablon 
tercih dosyalarının üzerine yazılır.

Bir Şablon Oluşturma

UYARI : Normal aralıklar ve Z-puan parametreleri için girilen değerlerin geçerliliği, kullanıcının 
sorumluluğundadır. Analizden önce tüm girişleri onaylayın. Hatalı değerler, yanlış teşhise sebep olabilir.

Tüm yeni şablonlar, varsayılan bir şablon çoğaltılarak oluşturulur. Varsayılan şablon düzenlenemez. 

1. Araçlar (Tools) > Tercihler (Preferences) > Düzenle (Edit) ögelerini seçin. 
2. Şablon (Template) sekmesini seçin.

3. Yeni Oluştur (Create New) ögesini veya bir şablonu çoğaltmak için Çoğalt (Duplicate) ögesini tıklatın.
Yaş varsayılandır.
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ŞEKİL 13. Şablon Seçimlerini Oluşturma

4. Şablon için yeni bir ad girin. 
Yeni bir ad girildiğinde, Geçerli Şablon (Current Template) aşağı açılır menüsü güncellenir.

ŞEKİL 14. Örnek Şablon Sekmesi - Kısa Eksen İşlevi Gösteriliyor

1. Geçerli şablon,  2. Yaş aralığı çubuğu,  3. Her analiz türüne ilişkin sonuç parametreleri,  4. Erkek Z-puanı BSA sınırları,  5. Erkek alt ve üst sınırlar,
6. Erkek Z-puanı parametreleri,  7. Kadın Z-puanı BSA sınırları,  8. Kadın alt ve üst sınırlar,  9. Kadın Z-puanı parametreleri

5. Bir şablon oluşturmak amacıyla istenen uygulama analiz türünü seçin.

6. Yaş aralıkları kullanılacaksa, bir yaş aralığı bölücüsü oluşturmak için, Yaş Aralığı Çubuğuna sağ tıklayın.
Yaş aralığı bölme çubukları sürüklenebilir ve istenen yaş aralığı için ayarlanabilir.
Birden fazla yaş aralığı bölücü çubuk oluşturulabilir.
Delete Yaş Aralığı bölücüsü çubuklar, imleç çubuğun yakınına yerleştirilerek ve sağ fare menüsünden Aralığı Sil 
(Delete Range) seçilerek silinebilir.

7. Hem alt hem de üst sınırların yanı sıra, uygun analiz modu için normal aralık değerlerini girin.

8. Gerekirse erkek ve kadın değerlerini farklı olarak girin. Cinsiyetler arasındaki değerleri kopyalamak için Tümünü 
Kopyala (Copy All) oklarını kullanın. Bu analiz türü için tam ölçümlere gitmek maksadıyla kaydırma çubuğunu kullanın.

9. Z-puanları hesaplanacaksa, hem a, b ve SD hem de BSA Sınırlarının değerleri kullanıcı tarafından girilmelidir.

Raporlama önceliği aşağıdaki tabloda ana hatlarıyla gösterilmiştir. Duruma bağlı olarak, normal aralık veya ölçüm sonuç 
tablolarındaki hesaplanan z-puanı gösterilecektir.

1

2

3

4
5 6

7
8 9
suiteHEART® Yazılımı Kullanım Talimatları NS-03-043-0003-TR Rev. 1 38



UYARI : Normal aralıklar ve Z-puan parametreleri için girilen değerlerin geçerliliği, kullanıcının 
sorumluluğundadır. Analizden önce tüm girişleri onaylayın. Hatalı değerler, yanlış teşhise sebep olabilir.

10. Tüm girişleri kaydetmek için Kaydet ve Çık (Save and Exit) ögesine tıklayın.
- Değişiklikleri kaydetmeden veya kabul etmeden kapatmak için İptal (Cancel) ögesine tıklayın.

NOT: Bir şablonun geçerli olması için, parametre değerlerinin hem alt hem de üst sınırlarının girilmiş olması ve girilen 
değerlerin de rakam olması gerekir. Değerlerde tutarsızlıklar varsa, şu mesaj görünür:
“Geçersiz normal aralık seçildi. (Invalid normal range selected.) Lütfen düzeltin ve yeniden kaydedin. 
(Please correct and save again.)” Düzeltilmesi gereken parametre kırmızı olarak gösterilecektir. 
Boş bir şablonun kaydedilmesine izin verilmez ve bu yapılmak istenirse “Şablon(lar) kaydedilemiyor” [“Unable to 
Save Template(s)”] mesajı görünür.

NOT: Akış için girilen normal aralıklar hem 2B hem de 4B akış analiz sonuçlarına uygulanır.
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Şablon Silme
1. Araçlar (Tools) > Tercihler (Preferences) > Düzenle (Edit) ögelerini seçin.

2. Şablon (Template) sekmesini seçin.

3. Geçerli Şablon (Current Template) aşağı açılır menüsünden şablonu seçin.

4. Sil (Delete) ögesine tıklayın.

Raporlanan/Hesaplanan Durum

z-puanı Hesaplandı Eğer z-puan parametreleri girilmişse ve BSA sınırlar içindeyse.

Normal Aralık Raporlandı Z-puanı ve normal aralık girilmişse ve BSA sınırları dışındaysa.

Normal Aralık Raporlandı Yalnızca normal bir aralık girilmişse.

Normal Aralık yahut z-puanı Hesaplanmamıştır Z-puanı parametreleri girilirse. Hiçbir normal aralık girilmemiş ve 
BSA sınırların dışında.

Normal Aralık yahut z-puanı Hesaplanmamıştır Z-puan parametreleri veya normal bir aralık girilmemiştir.
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Makro Sekmesi
Hesaplanan değerlerle otomatik olarak doldurulabilen özelleştirilmiş raporlama makroları oluşturulabilir. 
Oluşturulan makrolar tüm kullanıcılar tarafından kullanılabildiği için, makrolar şablonlardan bağımsızdır.

Aşağıdaki raporlama bölümlerine ilişkin makrolar oluşturulabilir:
• Geçmiş
• İmpresyon
• Teknik
• Bulgular

İzlenimler Makrosu Ekleme
NOT: Geçmiş veya Teknik makrosu oluşturmak için İzlenim makrosu oluşturma adımları takip edilir.

1. Araçlar (Tools) > Tercihler (Preferences) > Düzenle (Edit) ögelerini seçin.

2. Makro (Macro) sekmesini seçin.

3. İzlenimler Makrosu Ekle (Add Impressions Macro) ögesine tıklayın. 
İzlenim Makroları (Impression Macros) panelinde yeni bir metin alanı görünür.

ŞEKİL 15. İzlenim Makroları Penceresi

4. İmleci yeni metin alanının içine yerleştirin ve istediğiniz adı girin.

NOT: Oluşturulan makrolar yeniden sıralanabilir. İstediğiniz makroya tıklayıp liste içinde çekin.

Makro Metnini Girme
1. İmleci Makro Bilgileri (Macro Information) metin kutusuna getirin ve ilgili metni girin.

2. Bir parametre sonucu girmek için aşağıdaki analiz sekmelerinden birini seçin ve istediğiniz parametre düğmesine 
tıklayın; parametre otomatik olarak makro bilgilerine girilecektir. Bu örnekte, LV Ejeksiyon Fraksiyonu parametresi 
seçilmiş ve metnin sonuna girilmiştir.

ŞEKİL 16. Makro Bilgisi
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ŞEKİL 17. Makro Parametre Sonuç Seçimleri 

3. Kaydet ve Çık (Save and Exit) ögesine tıklayın.
Değişiklikleri kaydetmeden veya kabul etmeden kapatmak için İptal (Cancel) ögesine tıklayın.

Makro Çalıştırma

Makro çalıştırmanın ön koşulu olarak, sonuç parametreleri içeren makrolar çalıştırılmadan önce analiz sonuçları 
oluşturulmalıdır. Otomatik rapor üretme için Teknik ve İzlenim makroları oluşturulabilir.

NOT: Bir makro, analiz modunda değiştirilmiş bir parametre sonucu içeriyorsa, güncellenen sonucu yansıtmak için 
makronun yeniden seçilmesi gerekir.

Makro Silme
1. Araçlar (Tools) > Tercihler (Preferences) > Düzenle (Edit) ögelerini seçin.

2. Makro (Macro) sekmesini seçin.

3. Listeden makroyu seçin. 

Gösterilen örnekte, İşlev (Function) adlı makro, silinmek üzere seçilmiştir.

ŞEKİL 18. Makro Seçim Listesi

4. Seçilen Makroyu/Makroları Kaldır [Remove Selected Macro(s)] ögesini seçin.
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Yazdırma Sekmesi
Her analiz modunda hesaplanan sonuçlar, Yazdır (Print) sekmesindeki rapor girmek üzere yapılandırılabilir ve bu 
raporda sıralanabilir.

ŞEKİL 19. Yazdırma Tercihleri 

1. Menü çubuğunda Araçlar (Tools) > Tercihler (Preferences) > Yazdır (Print) ögelerine tıklayın.

2. Uygun analiz sekmesini seçin ve rapora girmesini istediğiniz sonucu işaretleyin.

3. Raporda listelenen sonuçların sırası, doğrudan bir sonuca tıklanarak ve listede yeni bir konuma 
sürüklenerek değiştirilebilir. 

4. Tüm analiz modu sekmeleri için tekrarlayın.

5. Kaydet ve Çık (Save and Exit) ögesine tıklayın.
Değişiklikleri kaydetmeden veya kabul etmeden kapatmak için İptal (Cancel) ögesine tıklayın.

NOT: Yazdırma seçimleri doğrudan uygulama arayüzü üzerinden yapıldıysa, şablona kaydedilmezler.

NOT: Ölçümlerin sırası doğrudan arayüzde değiştirilirse, değişiklik şablona kaydedilmeyecektir.

NOT: İşlev Analizinde Diğer altında oluşturulan kullanıcı tanımlı ölçümler, Yazdırma Tercihi Diğer (Print Preference Other) 
sekmesinde görünecektir. Bu ölçümler yeniden sıralanabilir.
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Virtual Fellow® Sekmesi

ŞEKİL 20. Virtual Fellow® Tercihleri

1. Araçlar (Tools) > Tercihler (Preferences) > Düzenle (Edit) ögelerini seçin.

2. Virtual Fellow® sekmesini seçin.

3. Uzun eksen görüntüleme için Tepe Yönünü (Apical Direction) seçin.

4. Miyokardiyal Değerlendirme için Aşama (Phase) veya Büyüklüğün (Magnitude) görüntülenmesi amacıyla seriyi seçin.

5. Miyokardiyal perfüzyon için görüntülemek üzere MOCO veya NO MOCO serisini seçin. 

6. Kaydet ve Çık (Save and Exit) ögesine tıklayın.
Değişiklikleri kaydetmeden veya kabul etmeden kapatmak için İptal (Cancel) ögesine tıklayın.
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T1/T2 Eşleştirme Sekmesi

ŞEKİL 21. T1/T2 Eşleştirme Tercihleri

1. Menü çubuğunda Araçlar (Tools) > Tercihler (Preferences) > Düzenle (Edit) ögelerini seçin.

2. T1/T2 Eşleştirme sekmesini seçin.

3. Analiz için geçerli bir seri oluşturmak amacıyla, Analize ilişkin Otomatik Seriler Oluştur (Auto Compose Series for 
Analysis) altında satıcı türü için doğru seçeneği seçin.

4. Endo/Epi Ofseti,1 ve -1 olarak ayarlanır ve 1, 0,25 piksele eşittir.

5. Kaydet ve Çık (Save and Exit) ögesine tıklayın.
Değişiklikleri kaydetmeden veya kabul etmeden kapatmak için İptal (Cancel) ögesine tıklayın.

T1 Eşleştirme
1. Zaman serisinin analizinde, T1 Eşleştirme Sıra türü için MOLLI veya Doygunluk Kurtarma'yı (Saturation Recovery) seçin.

2. Renk haritasını otomatik olarak görüntülemek için Zaman Serisi Yerleşimi (Time Series Overlay) veya Harita 
Yerleşimi'ni (Map Overlay) seçin.

3. ICF’yi girin, T1 Eşleştirme Analizi, sayfa 129‘a başvurun.

4. Alan Gücünü (Field Strength) seçin ve 1,5 T veya 3 T için renk haritası türünü ve ölçek değerlerini ayarlayın.

5. Kaydet ve Çık (Save and Exit) ögesine tıklayın.
Değişiklikleri kaydetmeden veya kabul etmeden kapatmak için İptal (Cancel) ögesine tıklayın.
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T2 Eşleştirme
1. Zaman serisinin analizi için uygun Parametre Uyum hesaplamasını seçin.
2. Renk haritasını otomatik olarak görüntülemek için Zaman Serisi Yerleşimi (Time Series Overlay) veya Harita 

Yerleşimi'ni (Map Overlay) seçin.
3. Alan Gücünü (Field Strength) seçin ve 1,5 T veya 3 T için renk haritası türünü ve ölçek değerlerini ayarlayın.
4. Kaydet ve Çık (Save and Exit) ögesine tıklayın.

Değişiklikleri kaydetmeden veya kabul etmeden kapatmak için İptal (Cancel) ögesine tıklayın.

Menü Odaklı Raporlama Sekmesi
1. Menü çubuğundan Araçlar (Tools) > Tercihler (Preferences) > Düzenle (Edit) ögelerini seçin.

2. Menü Odaklı Raporlama (Menu Driven Reporting) sekmesini seçin.

3. Şekil 22'de gösterildiği gibi menü tanımlayıcıları için varsayılan metni düzenlemek üzere uygun alana tıklayın.

4. Şekil 22'de gösterildiği gibi uygun analiz sekmesini seçip istediğiniz parametreyi tıklayarak metinle birlikte bir 
parametre sonucu ekleyin. 

5. İmleci eklenen sonucun arkasına yerleştirerek ve sil tuşuna basarak bir parametre sonucunu kaldırın.

ŞEKİL 22.  Menü Odaklı Raporlama Arayüzü

6. Varsayılan metni geri yüklemek için  ögesine tıklayın.

7. Menü seçimiyle ilişkili bir parametre sonucu için raporlama kategorik aralıklarını  ögesine tıklayarak 
tanımlayın.

Varsayılan metin 

Analiz sekmesi

Parametre sonuç seçimleri 

düzenleyici alanları
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8. İlişkili analiz sekmesinden uygun parametre sonucunu seçin.

9. Mutlak, Ofset veya Z'yi  seçin.

10. Kategori aralıkları için uygun değerleri yazın. Bir raporlama kategorisini ortadan kaldırmak için renk çubuğuna tıklayın,
çubuk griye döner ve değerler kaldırılır. Şekil 23.

ŞEKİL 23. Raporlama Kategorisini Kaldır

NOT: Kategorik aralıkların tamamlanması, rapor için otomatik önceden doldurma işlevinin etkinleştirilmesini 
sağlayacaktır. Metin, kullanıcı tanımlı değerlere göre önceden doldurulacaktır. Raporlama işlemi sırasında menü 
arayüzünden bir seçim yapılırsa, önceden doldurma işlevi artık etkinleştirilmez.

NOT: Aşağıdaki parametre sonuçları için önceden doldurulmuş metin, kullanıcının uygun analizi tamamlamasını 
gerektirir: Atria Hacimleri, Hipertrofi: Maksimum Duvar Kalınlığı, T2*, Kapak Darlığı, Kapak Yetmezliği.

11. Raporlama kategorik aralıklarını ve seçilen değeri sıfırlamak için  ögesini tıklayın.

Hipertrofi Kategorisini Tanımlama

Hipertrofi için raporlama ayrıca Eşmerkezli veya Eksantrik olarak tanımlanabilir. Kategorik aralıklar için değerler girilmeli ve 
erkek ve kadın için eşmerkezlilik değerleri doldurulmalıdır. Bkz. Şekil 24.

ŞEKİL 24. Hipertrofi Kategorik Aralıkları ve Eşmerkezlilik 

Referanslar
Petersen SE, Khanji MY, Plein S, Lancellotti P, Bucciarelli-Ducci C. European Association of Cardiovascular Imaging expert consensus 
paper: a comprehensive review of cardiovascular magnetic resonance normal values of cardiac chamber size and aortic root in adults 
and recommendations for grading severity. Eur Heart J Cardiovasc Imaging. 2019 Dec 1;20(12):1321-1331. doi: 10.1093/ehjci/jez232. 
Erratum in: Eur Heart J Cardiovasc Imaging. 2019 Dec 1;20(12):1331. PMID: 31544926.

Seçim Açıklama

Mutlak Yaştan bağımsız olarak cinsiyet için mutlak değerlere dayalı aralıklar. 

Ofset Aralıklar, bir şablonda ve yaşta ayarlanan normal aralıktan ne kadar ofset 
olduğuna bağlıdır.

Z Z puanlarına dayalı aralıklar.
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Eş Merkezlilik Referansı 
Khouri MG, Peshock RM, Ayers CR, de Lemos JA, Drazner MH. A 4-tiered classification of left ventricular hypertrophy based on left 
ventricular geometry: the Dallas heart study. Circ Cardiovasc Imaging. 2010 Mar;3(2):164-71. doi: 10.1161/CIRCIMAGING.109.883652. 
Epub 2010 Jan 8. PMID: 20061518.

İçe Aktarma Tercihleri
1. Tools > Araçlar (Tools) > Tercihler (Preferences) > İçe Aktar (Import) ögelerini seçin.

ŞEKİL 25. İçe Aktarma Tercihleri

2. Tara (Browse) düğmesine tıklayın, tercih dosyasının konumunu bulun ve Aç (Open) düğmesine tıklayın.

3. Görüntüleme protokollerini içe aktarmak için Sadece Görüntüleme Protokolleri (Only Viewing Protocols) seçenek 
düğmesini seçin.

4. İçe aktarma prosedürünü açıklandığı gibi gerçekleştirmek için Tamam (OK) ögesine tıklayın.
 İçe aktarmadan çıkmak için İptal (Cancel) ögesini seçin.

NOT: suiteHEART® Yazılımının önceki sürümlerinden (4.0.4 veya altı) içe aktarma desteklenmemektedir. Önceki 
sürümlerden tercihleri içe aktarma konusunda yardım almak için lütfen service@neosoftmedical.com adresinden 
NeoSoft Destek ile iletişim kurun.

Dışa Aktarma Tercihleri
1. Araçlar (Tools) > Tercihler (Preferences) > Dışa Aktar (Export) ögelerini seçin.

ŞEKİL 26. Dışa Aktarma Tercihleri

2. Tara (Browse) düğmesine tıklayın, tercih dosyasını kaydedeceğiniz konumu bulun ve Kaydet (Save) 
düğmesine tıklayın.

3. Tamam (OK) ögesini seçin.
 Dışa aktarmadan çıkmak için İptal (Cancel) ögesini seçin.
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Virtual Fellow®

Virtual Fellow® kardiyak MR çalışmaları için standart hale getirilmiş bir görüntü izleme özelliğidir. Bu özellik, görselleştirme 
iş akışını iyileştirir ve kardiyak MR çalışmalarının klinik uzmanlar tarafından gözden geçirilmesini kolaylaştırır. Bu özellik, 
pencere seviyeleme, yaklaştırma, kaydırma ve döndürme gibi görüntü kullanım araçlarını otomatik olarak uygular. Mevcut 
ve önceki kardiyak MR çalışmaları Virtual Fellow® özelliği ile kolayca gözden geçirilebilir.

NOT: Ön işlemeli Virtual Fellow® özelliğini etkinleştirmek için suiteDXT Kullanım Talimatlarına bakın.

NOT: Hasta kimliği, Virtual Fellow® içinde görüntülenen, hem mevcut hem de önceki muayene için eşleşmelidir. 

NOT: Virtual Fellow® içinde analiz sonuçları düzenlenemez, düzenleme yapmak için uygun analiz modunu seçin. 

UYARI : Virtual Fellow® tarafından oluşturulan görüntüleme protokolleri için doğru görüntü seçimini 
onaylamak kullanıcının sorumluluğundadır. Mevcut/önceki görüntüleme protokolleri için yanlış 
belirlenen görüntüler, manuel olarak seçilebilir. Uygun görüntülerin gözden geçirildiğinden emin olmak 
için, kullanıcı kardiyak görüntüleme teknikleri konusunda uygun bir şekilde eğitilmiş olmalıdır. 
Çalışma için alınan tüm görüntüleri gözden geçirmek amacıyla, Görüntü Yönetim Araçları, sayfa 21 
bölümünde bulunan Görüntüleyici modunu kullanın.

UYARI : Çalışmaları gözden geçirmeden veya karşılaştırmadan önce, arayüzün üst kısmında bulunan hasta gösterge 
bilgilerinin tamamını görsel olarak doğrulayın. #1 mevcut çalışmayı, #2 önceki çalışmayı gösterir.

UYARI : Virtual Fellow® tarafından gerçekleştirilen WW/WL, kaydırma, yaklaştırma, döndürme ve çevirme gibi 
görüntü kullanım işlemleri, farklı patolojilerin görünümünü ve diğer anatomik yapıların anlaşılmasını 
etkileyebilir. Her görüntüleme protokolünü gözden geçirin ve uygun ayarlamaları yapın.
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Virtual Fellow® ile Ön İşleme

Seri Tanımı

Otomatik Bölümleme
(tanımlanan seri için)

Otomatik Kapakçık Anülusu Tespit Etme
(etkinse)

Virtual Fellow® - Görüntü Optimizasyonu
(etkinse)

Tamam
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Virtual Fellow® Arayüzü

Virtual Fellow® Seçimleri

Seçim Açıklama

Virtual Fellow®

İşlev sonuçlarını göster

Akış sonuçlarını göster

Miyokardiyal Değerlendirme sonuçlarını göster

Uzun Eksen Çapraz Başvuru 

Ana Görüntüleyici

Görüntü Görüntüleme 

Görüntüleme 

ve Sonuç Görünümü

Protokolleri

Kontrolleri
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WW/WL, kaydırma, yaklaştırma, döndürme ve çevirme 
işlemlerini hem mevcut hem de önceki seri üzerinde 
aynı anda yapmayı sağlayan Bağlama Anahtarı.

WW/WL, kaydırma, yaklaştırma, döndürme ve çevirme 
işlemlerini tek seri üzerinde aynı anda yapmayı sağlayan 
Çözme Anahtarı.
Not: Yaklaştırma, her zaman hem mevcut seride hem de 
önceki seride gerçekleştirilir.

Aşama, aşama duyarlı late enhancement (LE) 
görüntülemek için kullanılır.

Büyüklük, büyüklük duyarlı late enhancement (LE) 
görüntülemek için kullanılır.

Hareket düzeltmeli Miyokardiyal Perfüzyon seri 
görüntüleme için MOCO kullanılır.

Hareket düzeltmesiz Miyokardiyal Perfüzyon seri 
görüntüleme için NO MOCO kullanılır.

#1 mevcut çalışma için görüntülenen seriyi gösterir. 
Seriyi değiştirmek için doğrudan #1 ifadesine sol fare 
tuşuyla tıklayın. 

#2 önceki çalışma için görüntülenen seriyi gösterir. 
Seriyi değiştirmek için doğrudan #2 ifadesine sol fare 
tuşuyla tıklayın.

Filmi oynatmak, duraklatmak, saniyede gösterilecek 
kare sayısını belirlemek ve başlangıç ile bitiş 
karelerini belirlemek için film kontrolleri kullanılır.

Aynı konumu içeren görüntüleri otomatik olarak 
belirlemeyi ve görüntülemeyi sağlayan çapraz 
başvuru aracı. Bu özelliğin kullanılması hakkında bilgi 
almak için bkz. Bulma Özelliği*, sayfa 22.

Ölçüm araçları, Ana Görüntüleyici’de ve uzun eksen 
görünümlerinde kullanılabilir.

Jenerik düzenlemeleri geri al.

Seçim Açıklama
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Görüntüleme Protokolleri

Görüntüleme alanı yerleşim seçenekleri*: 1x1, 1x2, 4x4 
ve 5x4.
*Seçilen protokole bağlıdır.

Kapsam Görüntü Kullanım Araçları, sayfa 12 
bölümünde anlatılan işleve sahiptir.

Klavye Sol Ok Tuşu Mevcut/önceki görüntüleme protokolü içindeyken 
kesit konumunu ilerletmek için kullanılır.

Klavye Sağ Ok Tuşu Mevcut/önceki görüntüleme protokolünde kesit 
konumunu tersine çevirmek için kullanılır.

Seri Tipi

Kısa eksen film işlev serisi.

Önceki çalışma ile kısa eksen film işlevi serisi.

Miyokardiyal Değerlendirme.

Önceki ile Miyokardiyal Değerlendirme.

Miyokardiyal Değerlendirmeli kısa eksen film işlevi.

Miyokardiyal Perfüzyon serisi Stres.

Önceki ile Mevcut Miyokardiyal Perfüzyon Stresi serisi.

Miyokardiyal Değerlendirme ile mevcut Miyokardiyal Perfüzyon Stres.

Seçim Açıklama
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Klavye Kısayolları

Miyokardiyal Perfüzyon Stres/Dinlenme serisi.

T1 aksiyal seri.

T1 aksiyal seri içeren SSFP.

İşlev Klavye Eylemi

Sarı köşe işareti mevcutsa, uzun eksen görüntüleri boyunca ileri kaydırın. Z

Sarı köşe işareti mevcutsa, uzun eksen görüntüleri boyunca geri gidin. A

Seri Tipi
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Görüntüleme Protokolleri için Kullanıcı Seri Seçimi
Görüntüleme protokolleri, mevcut ya da önceki çalışmadan alınan görüntüleri görüntülemek için yapılandırılmıştır. 
Gösterilen görüntüler, gözden geçirilmesi beklenen görüntüler değilse, Virtual Fellow® arayüzünde Şekil 1‘de gösterildiği 
gibi doğrudan sayı gösterimi (mevcut çalışma için #1 ya da önceki çalışma için #2) üzerine sol fare tuşuyla tıklayarak uygun 
seriyi yeniden seçin. Mevcut seri için (#1) gösterilen seri listesinden uygun seriyi seçin.

ŞEKİL 1. Virtual Fellow® Arayüzü
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Uzun Eksen Çapraz Başvuru Görüntüleme Alanları için Kullanıcı Serisi 
Seçimi
Gösterilen görüntüler, gözden geçirilmesi beklenen görüntüler değilse, aşağıdaki Şekilde gösterildiği gibi, doğrudan uzun 
eksen görüntüleme alanı üzerine tıklayıp dosya aşağı açılır menüsünden görüntü seçilerek uygun seri seçimi yapılabilir.

NOT: Klavyeden Z veya A seçimleri yapılırsa, kullanıcı tarafından seçilen görüntü görüntüleme alanında artık durmaz.

NOT: Görüntü Görünümü menüsünden istenen tepe yönünü ayarlamak için Araçlar (Tools) > Tercihler (Preferences) > 
Düzenle (Edit) ögelerini seçin ve Virtual Fellow® sekmesini seçin.
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Otomatik Güncelleme
Otomatik Güncelleme özelliği, arka plan işleme ile bir çalışmanın başlatılmasına imkan sağlar. Çalışma başlatıldığında 
görüntüler ağa bağlı halde ise, algoritma tarafından geçerli bir seri türü tanımlanması halinde, arka planda analiz 
(ve Virtual Fellow® yapılandırılmışsa) gerçekleştirilir. Desteklenen analiz modları şunları içerir:

• İşlev (yalnızca Kısa Eksen) 
• Akış
• Miyokardiyal Değerlendirme [yalnızca Kısa Eksen (Late Enhancement) Geç Güçlendirme]
• T1 Eşleştirme
• T2 Eşleştirme 

Otomatik Güncelleme özelliğini yapılandırmak için suiteDXT Kullanım Talimatları’na bakın. 

UYARI: Ön işlemenin ardından kullanıcı, tüm analizin doğruluğunu değerlendirmekten ve gerekli düzeltmeleri 
yapmaktan sorumludur.

İş Akışı
1. Bir çalışma ağa bağlanmış veya bu çalışma gerçekleştirilme sürecinde ve ağa bağlı halde ise ve açık mavi çember 

göstergesi, Şekil 1‘de gösterildiği gibi DXT çalışma listesinde mevcut ise, çalışma başlatılabilir.

NOT: Otomatik güncellemeden önce bir analiz manuel olarak gerçekleştirilirse, sonuçlar üzerine yazılmaz.

NOT: Çalışma kapalıysa, yeşil bir çember, tamamlanan işlemeyi gösterir.

ŞEKİL 1. DXT Çalışma Listesi
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2. Çalışma açıldığında, Şekil 2‘de gösterilen mesaj görünür. 

ŞEKİL 2. Çalışmayı Başlatma

3. Bir seri üzerinde analiz tamamlandığında, Şekil 3‘te gösterildiği gibi Yenileme göstergesi sarı renge dönecektir. 
Analiz modlarını güncellemek için tıklayın. 

Analiz için seri türlerinin sayısına bağlı olarak, Yenile (Refresh) ögesine birkaç kez tıklanması gerekebilir.

ŞEKİL 3. Yenile (Refresh) Göstergesi 

4. Çalışma kapandığında, Şekil 4‘te gösterilen mesaj görünür. 

NOT: Çalışma kapandıktan sonra ek seri türleri ağa bağlanırsa, işleme gerçekleştirilebilir.

ŞEKİL 4. Çalışmayı Kapatma 
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Konturları Düzenleme

Bu bölümde açıklanan kontur düzenleme, tüm analiz modlarında yapılabilir. Bu özellik hem Düzenleme Penceresinde 
(Editor Window) hem de Gözden Geçirme Modunda (Review Mode) mevcuttur.

ROI (İlgi bölgeleri) Nokta Eğrisi
1. Düzenleme Penceresinde kontur üzerine sol fare tuşu ile tıklayın. Kontur seçildiğinde mora döner.

2. Şekil 1‘de gösterildiği gibi, konturu hareket ettirmek için konturun merkezi üzerinde sol fare tuşu ile tıklayıp çekin.
• Seçilen kontur, nokta eğrisi yöntemiyle oluşturulmuşsa, noktalar düzenleme için görüntülenir. Kontur boyutunu ve şeklini 

ayarlamak için, Şekil 1‘de gösterildiği gibi noktalardan herhangi birine sol fare tuşuyla tıklayın ve çekin.
• Seçilen kontur serbest çizim aracıyla oluşturulmuşsa, konturu güncellemek için sol fare tuşuna tıklayın ve serbest çizim 

düzenlemeyi kullanın.

Ek işlevsellik:
• Alt+ Sol fare kombinasyonu ile bir köşe noktası oluşturulur.
• İlk noktaya tıklamak konturu kapatır.
• Kontur üzerine tıklamak doğrudan bir nokta oluşturur.
• Nokta üzerinde delete + imleç kombinasyonu, bir noktayı kaldırır.
• Bir noktayı komşu bir noktaya yakın sürüklemek, komşu noktayı kaldırır.
• Eğer nokta sayısı 3'ten az olursa, ROI silinecektir.

ŞEKİL 1. Konvansiyonel Kontur Düzenleme
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Sürükleme Aracı
1. Sürükleme aracını aktifleştirmek maksadıyla konturu seçmek için üzerine sol fare tuşuyla tıklayın. Ardından, Şekil 2‘de 

gösterildiği gibi, açılan menüden sağ fare tuşuyla tıklayarak sürükleme aracını seçin.
• Sürükleme aracı uygulandığında, seçili nokta ROI otomatik olarak bir serbest çizim ROI haline gelir.

ŞEKİL 2. Sürükleme Aracı Aktivasyonu

2. İmleç kare şeklinde görünecektir. İmleci ROI’den uzaklaştırın ve sol fare tuşuna basılı tutun. Şekil 3‘te gösterildiği gibi 
sürükleme aracı görünecektir.

NOT: Sürükleme çemberinin çapı, varsayılan olarak farenin bulunduğu noktayla seçili ROI arasındaki mesafe kadardır. 
Ebatı değiştirmek için imleci başka bir konuma alın.

ŞEKİL 3. Sürükleme Aracı
suiteHEART® Yazılımı Kullanım Talimatları NS-03-043-0003-TR Rev. 1 59



3. Sürükleme aracını kapatmak için kontur üzerine sol fare tuşuyla tıklayın, ardından sağ fare tuşuna tıklayıp açılır 
menüden Şekil 4‘te gösterildiği gibi sürükleme aracını seçin.

ŞEKİL 4. Sürükleme Aracını Kapatma

NOT: Sürükleme aracının varsayılan açık/kapalı olma hali Tercihlerde (Preferences) ayarlanabilir.

Kontur Çekme Aracı
1. Çekme aracını aktifleştirmek maksadıyla konturu seçmek için üzerine sol fare tuşuyla tıklayın. Ardından, Şekil 5‘de 

gösterildiği gibi, açılan menüden sağ fare tuşuyla tıklayarak çekme aracını seçin. Küçük ayarlamalar yapmak için kontur 
bölümlerini sürükleyerek bir kontur segmentinin ayarlanmasına imkan sağlar.

ŞEKİL 5. Çekme Aracı Aktivasyonu
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2. Düzenlenecek kontur segmentine doğrudan sol tıklayın. Siyah kesik çizgili segmentin uzunluğu farenin orta kaydırma 
tekerleği ile kontrol edilebilir. Fare imlecinin siyah kesik çizgili hata göre konumu, konturun bu segmentine ilişkin 
düzenleme değişikliğini kontrol edecektir.

ŞEKİL 6. Çekme Aracı

3. Çekme aracını kapatmak için kontur üzerine sol fare tuşuyla tıklayın, ardından sağ fare tuşuna tıklayıp açılır menüden 
Şekil 7‘de gösterildiği gibi çekme aracını seçin.

ŞEKİL 7. Çekme Aracını Devre Dışı Bırakma
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Bir Konturu Silme
1. Konturu seçmek için üzerine sol fare tuşuyla tıklayın ve klavyedeki sil (delete) düğmesine basın

veya

2. Konturu seçmek için üzerine fareyle sol tıklayın, ardından sağ tıklayın ve Şekil 8'de gösterildiği gibi, tek bir konturu 

silmek için  ögesini veya tüm aşamalardan veya tüm zaman noktalarından konturları silmek için  ögesini 
seçin.

ŞEKİL 8. Kontur Silme

NOT: Nokta eğrisi işlevi, 3B/4B Akış Görüntüleyici dışındaki tüm analizler için geçerlidir. 

Aşağıdaki kopyala/yapıştır ve çevir işlevi, PFO analizi hariç tüm analiz modlarında mevcuttur.
• Ctrl +C = ROI’yi kopyala
• Ctrl+V = ROI’yi yapıştır
• Ctrl +S = ROI’yi düzgünleştir

Ek Düzenleme Analizi (Yalnızca İşlev Analizi)
Düzenleyici görüntüleme alanında, iki düzenleme modu arasında geçiş yapmak için seçimler görüntülenir. 

Araç Açıklama
ROI’yi Sınırla

ROI’yi Sınırlama
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İşlev Analizi
Kullanıcı, otomatik bölümleme algoritmaları tarafından oluşturulan ya da değiştirilenler de dahil olmak üzere, tüm ilgi 
bölgelerinin (ROI’ler) tam ve isabetli olarak yerleştirilmesinden (ve doğru şekilde atanmasından) sorumludur. 
Yazılım tarafından üretilen kantitatif veriler, bu ilgi bölgelerinin tam ve isabetli olarak yerleştirilmesine (ve doğru 
şekilde atanmasına) bağlıdır.

Çalışma ön işleme özelliği, işlev analizinin ön işleme tabi tutulmasına olanak sağlar. suiteDXT Kullanım Talimatlarına bakın.

Bu bölüm kardiyak işlev analizi için kullanılan tipik adımları açıklamaktadır. Örnek iş akışları, kardiyak işlev analizini 
tamamlamak için uygulamada kullanılan adımlara genel bir bakış sunar. Prosedürler nicel analizlerin nasıl 
yapılacağını açıklar.

ÖNEMLİ: Analiz sonuçları bir teşhise ulaşmak için kullanılacaksa, kardiyak analizi yapma konusunda uzman bir kişi 
olmanız tavsiye edilir.

UYARI : Ön işlemenin ardından kullanıcı, tüm analizin doğruluğunu değerlendirmekten ve gerekli düzeltmeleri 
yapmaktan sorumludur. Kapsamlı bir gözden geçirme şunları içermelidir:
- ROI yerleştirme/tanımlama
- ED/ES atamaları
- MV/TV anülus yerleştirme
- RV ekleme konumu

UYARI : Uygulama, yalnızca görüntülerin analizine yardım eder ve otomatik olarak sonuçların klinik açıdan bir 
yorumunu üretmez. Kantitatif ölçümlerin kullanımı ve yerleştirilmesi kullanıcının inisiyatifindedir. 
Ölçümler yanlış yapılırsa, hatalı teşhisler meydana gelebilir. Ölçümler, yalnızca uygun bir şekilde 
eğitilmiş ve uzman bir kullanıcı tarafından oluşturulmalıdır.

UYARI : Yanlış tarama düzlemi hatalı analiz sonuçlarına neden olabilir. Bkz. Ek B.
NOT: 4B Akıştan oluşturulmuş geriye dönük 2B seriler manuel bölümleme gerektirebilir.

 ögesini seçin. Analiz için üç kategori vardır:

 - Sol ventrikül (LV) ve sağ ventrikül (RV) için hacim analizini içerir.

 - Sol (LA) ve sağ atrium (RA) için hacim analizini içerir.

 - Ön tanımlı doğrusal ölçümleri ve eklenebilecek kullanıcı tanımlı ölçümleri içerir.
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 Ventriküller
Analiz tipini seçin:

 Konturları silmek için  ögesine tıklayın.

NOT: Konturları silmek için matris modu kullanılabilir.

Endeks Ölçümlerini Hesaplama

1.  ögesine tıklayın.
2. Hastanın Boy (Height) ve Kilo (Weight) değerlerini girin.

Diyastol sonu hacim endeksi, sistol sonu hacim endeksi, kütle diyastol sonu endeksi, kütle sistol sonu endeksi, 
kütle endeks aşaması, kardiyak çıkış endeksi ve kalp atımı hacim endeksi ölçümleri Ölçüm (Measurement) 
tablosunda hesaplanır.

NOT: Rapor Görünümü (Report View) üzerinde yer alan BSA hesaplama yöntemi seçilebilir.

Otomatik LV ve RV Bölümleme
Otomatik bölümleme özelliği, kardiyak işlevinin standart parametrelerini anatomik girdi olmadan hesaplar. Bölümleme 
sonuçlarının oluşturulmasının ardından görüntülenecek/görüntülenmeyecek ROI tipleri seçilebilir. Kullanıcı girdisi ile 
bölümleme düzenlemesi de yapılabilir. 

NOT: İşlev Kısa Eksen (Function Short Axis) içindeki LV ve RV düğmelerinin ikisi birden seçim dışı bırakıldıysa ya da 
Uzun Eksen (Long Axis) içindeki bölme seçim düğmesi seçim dışı bırakıldıysa, Otomatik Yaymaya Başla (Start 
Auto Propagation) düğmesi etkin olmaz. 

LV ve RV bölümleme yapmak için aşağıdaki adımları uygulayın: 

1. Kısa eksen serisini seçin ve pencereyi/düzeyi ayarlayın.

2.  ögesine tıklayın.

3. Otomatik bölümleme için  ögesine tıklayın.
4. Şekil 1‘de gösterildiği gibi, bölümleme araç çubuğundan uygun seçimleri yapın.

5. Otomatik bölümlemeye başlamak için  ögesini seçin.

Kısa Eksen Uzun Eksen
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ŞEKİL 1. Bölümleme Araç Çubuğu

* Matris modu için x (kesit) ve y (aşama)’yi çevir tercihi yapıldığında yayma işlevi değişir.

Tablo 1: Otomatik Bölümleme Kontur Tipleri

Pürüzsüz Mod 
(Smooth Mode) 
– ventriküler 
hacim içindeki 
papiller kasları 
içerir. 

Pürüzlü Mod 
(Rough Mode) 
– ventriküler 
hacim içindeki 
papiller kasları 
içermez. 

Endokardiyal 
ve epikardiyal 
konturları 
göster. 

Endokardiyal 
konturları 
göster.

Kordları 
göster.

Pürüzlü LV, 
Pürüzsüz RV.

Pürüzsüz LV, 
Pürüzlü RV

Tablo 2: Otomatik Bölümleme Yayma* Tipleri

Tüm kesitleri tüm aşamalara 
yay veya tüm kesitleri tüm 
aşamalarda göster

Tüm kesitleri yay, tek 
aşama

Tüm aşamaları yay, tek 
kesit

Gösteren konturları sadece 
ED/ES aşamalarına yay

Tablo 3: Ventriküler Seçimi

Sol Ventrikül - Bölümleme veya görüntü üret Sağ Ventrikül - Bölümleme veya görüntü üret
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Tüm Kesitler ve Tüm Aşamalar için Otomatik Bölümleme Yapma

Bölgesel analiz, uyumsuzluk analizi ve kapakçık düzlemi analizi sonuçlarının üretilmesi için bu seçenek gereklidir.

1. Kısa eksen serisini seçin ve pencereyi/düzeyi ayarlayın.

2.  ögesine tıklayın.

3. Otomatik bölümleme için  ögesine tıklayın.

4. Bölümleme çubuğundan pürüzsüz modu  veya pürüzlü modu  seçin.

5. Miyokardiyal kütle sonuçlarını üretmek için  ögesini seçin.

6. Tüm aşamalar ve tüm kesitler için  ögesine tıklayın.

7.  ögesine,  ögesine veya ikisini birden tıklayın.

NOT: Optimal RV bölümlemesi için hem epikardiyal hem de endokardiyal izleri seçin.

8. Otomatik bölümlemeye başlamak için  ögesini seçin.

NOT: Hem LV hem de RV seçimleri seçim dışı bırakılmışsa, Otomatik Yaymaya Başla (Start Auto Propagation) 
düğmesi etkin olmaz.

Bölümleme Doğruluğunu Gözden Geçirme ve Düzenleme
1. Kısa eksen serisini film modunda oynatın ve konturların doğruluğunu gözden geçirin.

2. Yanlış konturları düzenleyin.

NOT: Pürüzsüz modda kontur düzenleme desteklenir. Bir kontur düzenleme gerçekleştirin ve otomatik 
bölümlemeye başlayın.

ED ve ES’yi yeniden atamak için ED veya ES düğmelerinden birine tıklayın ve matris hücresinin sol veya sağ tarafını 
seçin. Bkz. Matris Görünümü, sayfa 73.

NOT: ED ve ES için aşama atamaları bölümleme ile belirlenir. Hesaplanan en büyük hacme ED, hesaplanan en küçük 
hacme ES atanır.

3. Her kesit üzerine inferiör RV giriş noktasının yerleşimini gözden geçirin. Gerekirse her kesit için ayarlayın.

4. Matris modunu gözden geçirin ve ED ile ES atamalarını onaylayın.
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Bir Aşamadaki Tüm Kesitler için Otomatik Bölümleme Yapma
1. Kısa eksen serisini seçin ve pencereyi/düzeyi ayarlayın.

2.  ögesine tıklayın.

3.  ögesine tıklayın.

4. Bölümleme çubuğundan pürüzsüz modu  veya pürüzlü modu  seçin.

5. Miyokardiyal kütle sonuçlarını üretmek için  ögesini seçin.

6. Kısa eksen görüntülerini gözden geçirin ve diyastol sonu aşamayı seçin.

7.  ögesini,  ögesini veya ikisini birden seçin.

8. Tek aşamadaki tüm kesitler için  ögesini seçin.

9. Otomatik bölümlemeye başlamak için  ögesini seçin.

10. Kısa eksen görüntülerini gözden geçirin ve sistol sonu aşamayı seçin.

11. Otomatik bölümlemeye başlamak için  ögesini seçin. 

NOT: Hem LV hem de RV seçimleri seçim dışı bırakılmışsa, Otomatik Yaymaya Başla (Start Auto Propagation) 
düğmesi etkin olmaz.

Bölümleme İsabetini Gözden Geçirme/Düzenleme
1. Kısa eksen serisini film modunda oynatın ve konturların doğruluğunu gözden geçirin.

2. Yanlış konturları düzenleyin.

3. Matrisi gözden geçirin ve ED ile ES atamalarını onaylayın.

4. Ölçüm tablosundaki tüm sonuçları gözden geçirin.
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Manuel LV ve RV İşlev Analizi Prosedürü
NOT: Diyastol sonu ve sistol sonu aşamalarının kullanılması tavsiye edilir. İşlem diyastol sonu aşamasında başlamalıdır. 

Analiz iş akışı tipik olarak tabandan tepeye kadar gerçekleştirilir.

1.  ögesini seçin.

2. Görüntü Göstericiden (Image View) uygun kısa eksen serisini seçin. 

3.  ögesine tıklayın.

4. Hacim ölçümleri için  düğmesine tıklayın.

5. Diyastol sonu aşamasını belirleyin.

Endokardiyumu Tanımlama

1. LV için  ögesini veya RV için  ögesini seçin. 

2. Endokardiyal konturu izleyin.

3. Sonraki kesite geçmek için  ögesini veya <-- ve --> ögelerini kullanın ya da küçük resmi seçin.

4. Sol ve/veya sağ ventrikülün tamamı bölümlere ayrılana kadar 2. ve 3. adımları tekrar edin.

Birden fazla kesitin bölümlere ayrılmasını hızlandırmak için Endokardiyal kontur aracı seçili kalacaktır.

5. Sistol sonu aşamasını belirleyin.

6. Sol ve/veya sağ ventrikülün tamamı bölümlere ayrılana kadar sistol sonu aşamasındaki 2. ve 3. adımları tekrar edin.

NOT: Yazılım otomatik olarak diyastol sonu aşamasını en büyük hacimli aşama olarak, sistol sonu aşamasını 
ise en küçük hacimli aşama olarak tanımlar. Diyastol sonu ve sistol sonu aşama atamaları bölümleme 
sırasında güncellenir.

Bölümleme Doğruluğunu Gözden Geçirme ve Düzenleme
1. Kısa eksen serisini film modunda oynatın ve konturların doğruluğunu gözden geçirin.

2. Yanlış konturları düzenleyin.

3. Matrisi gözden geçirin ve ED ile ES atamalarını onaylayın.

4. Ölçüm tablosundaki tüm sonuçları gözden geçirin.
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Manuel LV ve RV Miyokardiyal Kütle Prosedürü
1. Uygun kardiyak aşamasını seçin.

2. LV epikardiyum için  ögesini veya RV epikardiyum için  ögesini seçin. 

3. Epikardiyal konturu izleyin.

4. Sonraki kesite geçmek için  ögesini veya <-- ve --> ögelerini kullanın ya da küçük resmi seçin.

5. Sol ve/veya sağ ventriküler epikardiyumun tamamı bölümlere ayrılana kadar 3. ve 4. adımları tekrar edin.
Epikardiyal konturlar tanımlandıkça kütle sonuçları otomatik olarak güncellenir.

Bölümleme İsabetini Gözden Geçirme/Düzenleme
1. Kısa eksen serisini film modunda oynatın ve konturların doğruluğunu gözden geçirin.

2. Yanlış konturları düzenleyin.

3. Matris modunu gözden geçirin ve ED ile ES atamalarını onaylayın.

4. Ölçüm tablosundaki tüm sonuçları gözden geçirin.

Bazal Aradeğerleme
Bazal kesitler için aradeğerleme yapmak üzere ya mitral veya trikuspit kapakçık anülusu ya da uzun eksen 
görüntülemeyi seçin.

NOT: LV ve RV için kapakçık anülusunun otomatik yerleştirilmesi tercihlerde ayarlanmadıkça, aradeğerleme özelliği 
"kapatılır". Araçlar (Tools) > Tercihler (Preferences) > Düzenle (Edit) ögelerini seçin. İşlev (Function) 
menüsünden Otomatik MV (Automatic MV) veya TV Anülus Ekleme (TV Annulus Insertion) ögesini tıklayın.

1. LV bazal aradeğerleme için çapraz başvuru modunda 2 Bölme görünümünü seçin.

2.  ögesini seçin.

3. Şekil 2‘de gösterildiği gibi MV anülusu tanımlayın. Film kontrollerini kullanarak, hattın uygun sistol sonu ve diyastol 
sonu aşamalara yerleştirilmesini gözden geçirin.

NOT: Çok düzlemli bazal aradeğerleme desteklenir. Örneğin, MV anülus 2 bölmeli ve 4 bölmeli görüntülemede tespit 
edilebilir; uyum, iki düzlem arasında yapılır. Otomatik yerleştirme için Araçlar (Tools) > Tercihler (Preferences) > 
Düzenle (Edit) ögelerini seçin. Otomatik MV Anülusu Yerleştirmeyi tıklayın ve 4 bölmeli MV Anülusunu 
dahil edin. 

NOT: Görüntüleme alanının sol alt köşesinde bulunan  veya  ögesine tıklayarak, MV veya TV Anülus 
yerleştirme serisini bulun.
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ŞEKİL 2. MV Anülus

4. Hat ile ilişkili çapraz başvuru kesitlerini inceleyerek güncellenmiş hesaplamayı gözden geçirin. 

Şekil 3‘te gösterildiği gibi, aradeğerleme hacim hesaplaması hattın kesitle kesişiminin (pembe hat) ilişkisine göre yapılır 
ve bu hacim artık hacim sonuçlarına eklenmiştir. Esas ilgi bölgesi gösterilmez. Aradeğerleme yapılan kesitler, Şekil 3‘te 
gösterildiği gibi, görüntünün sol köşesinde hacim miktarını ve aradeğerleme yüzdesini gösterirler.

ŞEKİL 3. Hacim Hesaplama

5. RV bazal aradeğerleme için çapraz başvuru modunda 4 Bölme görünümünü seçin.

6.  ögesini seçin.

7. Şekil 4‘te gösterildiği gibi TV anülusu tanımlayın. Film kontrolünü kullanarak, hattın uygun sistol sonu ve diyastol sonu 
aşamalara yerleştirilmesini gözden geçirin.
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ŞEKİL 4. TV Anülus

8. Hatla ilişkili çapraz başvuru kesitlerini inceleyerek güncellenmiş hesaplamayı gözden geçirin ve matris görünümünde 
ED ve ES atamalarını gözden geçirin.   

9. Sonucu orijinal değerine geri almak için sağ fare tuşuyla tıklayın, doğrudan hat üzerinde tutun ve sil ögesini seçin ya 
da hat üzerine sol fare tuşuyla tıklayıp klavye üzerindeki sil (delete) tuşunu kullanın. 

Doğruluğu İnceleme
1. Uzun eksen serisini film modunda oynatın ve hat yerleşimini gözden geçirin.

2. Gerekli oldukça hat yerleşimini ayarlayın.

3. Otomatik ekleme yapıldıysa, uygun serinin seçildiğini ve uygun hat yerleşiminin yapıldığını kontrol edin. Uygun şekilde 
yerleştirilmediyse, hat üzerine sağ fare tuşuyla tıklayın ve silin.

Seriler Arası Hareket Düzeltme
Seriler Arası Hareket Düzeltme, uzun eksen görüntüleri ve kısa eksen görüntülerinin alımı arasında oluşabilecek kardiyak 
çeviriyi telafi eder. Hacimsel analiz için kullanılan endokardiyal konturları içeren kısa eksen görüntüleriyle mekansal olarak 
kaydedilmeyen uzun eksen görüntülerinden anüler düzlemler elde edilirse, bölme hacimlerinde hatalar meydana gelebilir. 
Kısa ve uzun eksen görüntüleri, solunum döngüsünün farklı aşamalarında elde edilirse veya uzun ve kısa eksen 
görüntülerinin alımı arasında hasta pozisyon değiştirirse (örn. çevirirse), bu halde hata meydana gelebilir. Seriler Arası 
Hareket Düzeltme (Motion Correction Between Series) seçildiğinde, atriyoventriküler kapak düzleminin diyastol sonu 
merkezi, en bazal diyastol sonu ventriküler endokardiyal kontur ile tanımlanır. Anülus kapakçık düzleminin angülasyonu 
ve kardiyak aşamalar üzerindeki göreceli konumu, uzun eksen görüntülerinde tanımlandığı şekilde, anülus hatlarının 
angülasyonu ve anülus merkezlerinin göreceli konumu ile belirlenir. 

NOT: İşlev Analizi modunda özelliğe erişmek için. Araçlar (Tools) > Tercihler (Preferences) > Düzenle (Edit) ögelerini 
seçin. İşlev (Function) menüsünden Seriler Arasındaki Hareket Düzeltme (Motion Correction Between Series) 
ögesini seçin.

1. Tüm aşamalar tüm kesitler için LV ve RV otomatik bölümlemesi gerçekleştirin.

2. LV ve RV için Bazal Aradeğerleme gerçekleştirin. 

3.  ögesini seçin.
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4. Şekil 5'te (solda) gösterildiği şekilde, kesikli çizgi MV anülus hattı yerleşiminin üzerine bindirilmiş göründüğünde, 
anlaşma doğrulanabilir.

ŞEKİL 5. Onaylanmış Anlaşma (sol) Kardiyak Çeviri (sağ)

5. Şekil 5 (sağda), düz ve kesikli çizgi anülus hatları arasındaki boşluğu göstermektedir. 

6. Düz çizgi, uzun eksen görüntüsünün üzerine çizilen anülus düzlemini temsil eder. Kesikli çizgi, en bazal endokardiyal 
konturun konumuna bağlı olarak çevrilen anülus düzlemini temsil eder. 

NOT: Düz ve kesikli çizgi arasındaki boşluğun nedenini belirlemek ve gerekirse analizi düzeltmek, kullanıcının 
sorumluluğundadır. Bir boşluğun olası nedenleri aşağıdakileri içerir:

- Kısa eksen görüntüsündeki en bazal endokardiyal konturun doğru kesit üzerinde çizilmemiş olması. Düzeltilmemesi 
halinde, yazılım çeviriyi yanlış bir şekilde telafi edecektir. 

- Anülus hattının, anülusun konumunu temsil etmemesi. Düzeltilmemesi halinde, yazılım çeviriyi yanlış bir şekilde 
telafi edecektir. 

- Uzun eksen alımı ve kısa eksen alımı arasındaki kardiyak çeviri.

Eğer en bazal endokardiyal kontur, doğru kesit üzerine çizilirse ve uzun eksen görüntüsünde anülus hattı doğru 
şekilde çizilirse, düz ve kesikli çizgili hat arasındaki boşluk gerçek kardiyak çeviriyi temsil eder ve yazılım, bu çeviri 
için düzeltme yapacaktır.

7. RV bölümlemesi gerçekleştirilmişse ve TV anülusu yerleştirilmişse, çeviriyi gözden geçirin. 
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Matris Görünümü 
NOT: x (kesit) ve y (aşama) eksenleri değiştirilebilir. Araçlar (Tools) > Tercihler (Preferences) > Düzenle (Edit) ögelerini 
seçin. İşlev (Function) menüsünden Matris modu için X (kesit) ve Y(aşama) eksenini çevir ögesini seçin. Eğer tercih 
değiştirilirse uygulama kapatılıp yeniden başlatılmalıdır.

Matris, sistol sonu ve diyastol sonu evrelerini gözden geçirmek ve atamak ve fazlar ve kesitler arasında gezinmek için 
kullanılır. Atanan ED ve ES aşamaları, Şekil 6'da gösterildiği gibi ED için kırmızı veya ES için mavi tek renk blokları 
olarak gösterilir.

ŞEKİL 6. LV ve RV için Matris Görünümü

Ventriküler Atama

Sol ventrikül için ED (Şekil 7) veya ES (Şekil 8) ataması, tek bir matris hücresinin sağ tarafı seçilerek yapılır. 

Sağ ventrikül için ED (Şekil 9) veya ES (Şekil 10) ataması, tek bir matris hücresinin sol tarafı seçilerek yapılır.

ŞEKİL 7. ŞEKİL 8.

ŞEKİL 9. ŞEKİL 10.

Atanan ES Aşaması

Atanan ED Aşaması
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Atriyal Atama

Sol atriyum için ED (Şekil 11) veya ES (Şekil 12) ataması, tek bir matris hücresinin sağ tarafı seçilerek yapılır.

Sağ atriyum için ED (Şekil 13) veya ES (Şekil 14) ataması, tek bir matris hücresinin sol tarafı seçilerek yapılır.

Matris İşlevi

Konturların silinmesi, bir aşama veya kesit satırı veya tek bir matris hücresi seçilerek ve sağ fare tıklaması 
gerçekleştirilerek yapılabilir.

Aradeğerleme, renkli olmayan göstergelerle tanınır. Aradeğerleme aşağıdaki koşullarda uygulanabilir: 
• Aynı kardiyak aşaması sistol sonu veya diyastol sonu için kesitler boyunca izlenmiş ve bir kesit atlanmışsa.
• Aynı kardiyak aşaması sistol sonu veya diyastol sonu için kesitler boyunca izlenmiş ve/veya bir kesit atlanmışsa, 

bazal aradeğerleme uygulanabilir.

Görüntüleme Seçenekleri

ŞEKİL 11. ŞEKİL 12.

ŞEKİL 13. ŞEKİL 14.

LV/RV Matrisini 
Görüntüleme

 RA/LA Matrisini 
Görüntüleme
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Seçimler 

*Atria, sayfa 81 altında bulunana nota başvurun.

Bölme Göstergeleri 

Ventriküler Segmentasyon Göstergeleri 

Atriyal Segmentasyon Göstergeleri 

Global ED/ES Global seçildiğinde, birleşik hacim, aynı aşamadaki ED ve ES atamalarına 
dayanır.

Tek ED/ES Tek biri seçildiğinde birleşik hacim, her kesitteki aşamalarda bulunan en büyük 
ve en küçük hacimlere göre belirlenir. Etkinleştirmek için Tüm Kesitleri Yay, 
Tüm Aşamalar modu seçilmiş olmalıdır. Bazal aradeğerleme bu modda 
desteklenmemektedir. 

Aradeğerleme "Açık" veya "Kapalı"yı seçin. Doğrudan hacim eğrisi üzerinde gösterilir. 

ED Diyastol sonu aşamasını atamak için doğrudan RV için matris hücresinin sol 
tarafına veya LV için hücrenin sağ tarafına tıklayın.

Diyastol sonu aşamasını atamak için doğrudan RA için matris hücresinin sol 
tarafına veya LA için hücrenin sağ tarafına tıklayın.

ES Sistol sonu aşamasını atamak için doğrudan RV için matris hücresinin sol 
tarafına veya LV için hücrenin sağ tarafına tıklayın.

Sistol sonu aşamasını atamak için doğrudan RA için matris hücresinin sol 
tarafına veya LA için hücrenin sağ tarafına tıklayın.

Maks.

 

Maksimum atriyum hacmi için seçim*

Min.

 

Minimum atriyum hacmi için seçim*

LV Endokardiyum LV Epikardiyum RV Endokardiyum RV Epikardiyum

RA Endokardiyum LA Endokardiyum
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Ventriküler İşlev Analizi Sonuçları

ŞEKİL 15. Ventriküler Otomatik Bölümleme Sonuçları

1. Hacimsel sonuçlar, 2. Hacim eğrisi, 3. Matris

Hacim Eğrisi

LV veya RV için tüm aşamalar ve tüm kesitlerde otomatik bölümleme yapıldığında, Şekil 15‘da gösterildiği gibi bir zamana 
göre ventriküler hacim eğrisi üretilir. Hacim eğrisini rapora eklemek için sağ fare tuşunu tıklayın.

• Kırmızı daire, diyastol sonu (görüntü görüntüleme alanında ED olarak etiketlenir) ögesini gösterir.
• Mavi daire, sistol sonu (görüntü görüntüleme alanında ES olarak etiketlenir) ögesini gösterir.
• Yeşil imleç, Tepe Ejeksiyon Oranını (PER) ml/sn. olarak gösterir. (Etkileşimli Dikey İmleç).
• Sarı imleç Tepe Doldurma Oranını (PFR) ml/sn. olarak ifade eder. (Etkileşimli Dikey İmleç).
• Karşılık gelen görüntü aşaması seçimi, hacim eğrisi üzerindeki beyaz daire ile gösterilir.

Hacimsel sonuçlar ölçüm tablosunda gösterilir. 
• Ventriküler kütle sonuçlarını ya da kütle endeksini gözden geçirmek maksadıyla, LV veya RV için ters üçgene sol tıklayın.
• Aşama listesinden seçilen aşama raporda gösterilir. Varsayılan öge, ED’dir.

1

2

3
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ŞEKİL 16. Kütle Sonuçları

ŞEKİL 17. Bölme Hacmi Tablosu

LV ve RV Hacimsel değerleri Bölme Hacimleri tablosunda gösterilir. 
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Sol Ventriküler Bölgesel Analiz
LV Bölgesel Analiz, duvar hareketinin, duvar kalınlığının, duvar kalınlaşmasının ve duvar kalınlığı sonuçlarının gözden 
geçirilmesine olanak sağlar.

NOT: İşlev Kısa Eksen (Function Short Axis) içindeki LV ve RV düğmelerinin ikisi birden seçim dışı bırakıldıysa ya da 
Uzun Eksen (Long Axis) içindeki bölme seçim düğmesi seçim dışı bırakıldıysa, Otomatik Yaymaya Başla 
(Start Auto Propagation) düğmesi etkin olmaz. 

1. Tüm aşamalardaki tüm kesitler için Otomatik LV bölümleme gerçekleştirin (bkz. sayfa 66).

2. Her kesitteki RV ekleme noktasının yerleşimini gözden geçirin ve bazal kesitler için RV ekleme noktasını ayarlayın.

3. Bir kesit konumuna bir RV ekleme noktası eklemek için, RV ekleme noktasına  tıklayın, otomatik bölümlenmiş 
kesiti seçin ve RV ekleme noktasını yerleştirin. 

4. Bazal, orta ve tepe sınıflandırmasını onaylayın. 

5. Bölgesel Analize  tıklayın. Kalınlık, Kalınlaşma Yüzdesi ve Duvar Hareketi çizim, grafik ya da tablo 
biçimlerinde gösterilir.

ŞEKİL 18. Bölgesel Analiz
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Uyumsuzluk Analizi
Uyumsuzluk, Bölgesel Analiz sonuçlarının bir uzantısıdır ve Bölgesel Analizden elde edilen çevresel bilgiye göre Duvar 
Kalınlığının Geçici Değişmezliğini [Temporal Uniformity of Wall Thickness (TUWT)] hesaplanmasını sağlar.

Uyumsuzluk Analiz Prosedürü
1. Otomatik LV bölümleme gerçekleştirin (Bkz. Tüm Kesitler ve Tüm Aşamalar için Otomatik Bölümleme Yapma sayfa 

66.).

2. Bölgesel Analizi  seçin.

3. Uyumsuzluk (Dyssynchrony) sekmesini seçin.

4. Ölçüm tablosunda her kesit için sonuçlar ve ortalama global sonuç gösterilecektir.

5. Global sonuç hesaplaması ancak LV orta ventriküler kesitler dahil edilirse optimal olur. Global sonuç hesaplamasından 
bir kesit sonucunu çıkarmak için doğrudan en sağdaki sütunda bulunan ve içinde bir onay işareti olan kutuya tıklayın 
(Şekil 19).

ŞEKİL 19. Global Sonuç Hesaplama

Tavsiye Edilen Referans

Bilchick et al, “Cardiac Magnetic Resonance Assessment of Dyssynchrony and Myocardial Scar Predicts Function Class Improvement 
Following Cardiac Resynchronization Therapy”, JACC, Vol.1:No 5: 2008 p.561-8

Helm RH, Leclercq C, Faris OP, Ozturk C, McVeigh E, Lardo AC, Kass DA. Cardiac dyssynchrony analysis using circumferential versus 
longitudinal strain: implications for assessing cardiac resynchronization. Circulation. 2005 May 31;111(21):2760-7. doi: 10.1161/
CIRCULATIONAHA.104.508457. Epub 2005 May 23. PMID: 15911694; PMCID: PMC2396330.
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Otomatik Uzun Eksen Bölümleme

1.  ögesini seçin.

2. Bir uzun eksen serisi seçin.

Standart uzun eksen görünümlerine sahip bir seri oluşturmanız tavsiye edilir.

3.  ögesini seçin.

4. Tüm kesitleri ve tüm aşamaları yaymak için  ögesini seçin.

NOT: RV segmentasyonunu gerçekleştirmek için  ögesine tıklayın.

5.  ögesine tıklayın.

NOT: Uzun eksen görünümü seçim dışı bırakılmışsa, Otomatik Yaymaya Başla (Start Auto Propagation) düğmesi 
etkin olmaz.

6. Tüm izleri gözden geçirin. Merkez hattı sol ventrikülün uzun eksenine tabandan tepeye kadar karşılık gelecek 
şekilde ayarlayın.

7. Manuel olarak takip için, sol ventrikül endokardiyumunu takip için  ögesine tıklayın; hem uç diyastol hem de uç 

sistole ilişkin sağ ventrikül endokardiyumunu takip için  ögesine tıklayın.

8. Kütlenin hesaplanması için, sol ventrikül epikardiyumunu  veya sağ ventrikül epikardiyumunu takip edin .

ŞEKİL 20. Merkez Hattı Yerleştirme

Sonuçlar Ölçüm tablosunda gösterilir.
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 Atria
NOT: Atriyal hacimler için varsayılan ölçüm etiketleri, maksimum atriyal hacmi ifade eden EDV ve minimum atriyal 

hacmi ifade eden ESV'dir. Etiketleri MaxV ve MinV olarak ayarlamak için Araçlar (Tools) > Tercihler (Preferences) 
> Düzenle (Edit) ögelerini seçin. Atriyal Hacim Etiketi’ni (Atrial Volume Label) seçin: İşlev (Function) 
menüsünde MaxV, MinV.

Manuel LA ve RA Analizi
1. Görüntü Göstericiden (Image View) uygun seriyi seçin. 

NOT: Optimal sonuçlar için analizde 4 odalı yığın kullanılması tavsiye edilir. 4 odalıgörünüm atriyal anatomiyi daha 
iyiÍndicegösterir.

2.  ögesine tıklayın.

3.  düğmesine basın.

4. Diyastol sonu aşamasını belirleyin.

Endokardiyumu Tanımlama

1. LA Endokardiyum için  ögesini veya RA Endokardiyum için  ögesini seçin.

2. Endokardiyal konturu izleyin.

3. Sonraki kesite geçmek için  ögesini veya <-- ve --> ögelerini kullanın ya da küçük resme tıklayın.

4. Atriyumun tamamı bölümlere ayrılana kadar 2. ve 3. adımları tekrar edin.

5. Sistol sonu aşamasını belirleyin.

6. Atriyumun tamamı bölümlere ayrılana kadar sistol sonu aşamasında 2. ve 3. adımları tekrar edin.

NOT: Yazılım otomatik olarak diyastol sonu aşamasını en büyük hacimli aşama olarak, sistol sonu aşamasını ise 
en küçük hacimli aşama olarak tanımlar. Diyastol sonu ve sistol sonu aşama atamaları bölümleme 
sırasında güncellenir.

7. Kısa eksen görünümü kullanıldıysa, MV ve/veya TV anülusu belirleyin.
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Otomatik LA veya RA Analizi

1.  ögesine tıklayın.

2. Bir uzun eksen serisi seçin.

NOT: Standart uzun eksen görünümlerine sahip bir seri oluşturmanız tavsiye edilir. 2 Odalı ve 4 Odalı görünümleri için 
atriyal bölümleme desteklenmektedir. 

3.  ögesini seçin.

NOT: Sağ atriyal segmentasyonunu gerçekleştirmek için  ögesine tıklayın.

4. Tüm kesitleri ve tüm aşamaları yaymak için  ögesini seçin.

5.  ögesine tıklayın.

NOT: Uzun eksen görünümü seçim dışı bırakılmışsa, Otomatik Yaymaya Başla (Start Auto Propagation) düğmesi 
etkin olmaz.

6. Tüm izleri gözden geçirin. Merkez hattını atriyal odaya paralel olacak şekilde konumlandırın.

7. Manuel olarak takip amacıyla RA endokardiyumu takip için  ögesine tıklayın; hem diyastol sonu hem sistol 

sonuna ilişkin LA endokardiyumu takip için  ögesine tıklayın.

ŞEKİL 21. Merkez Hattı Yerleştirme
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Atriyal Boyutlar ve Alan

1.  ögesine tıklayın.

2. Uygun seriyi seçin.

3. Atriyal boyut ölçümü yapmak maksadıyla, LA veya RA için doğrudan sütundaki tabloya tıklayın ve ardından iki nokta 
girin. Bkz. Şekil 22.

4. Atriyal alan ölçümü yapmak maksadıyla, LA veya RA için doğrudan sütundaki tabloya tıklayın ve ardından bir ROI çizin. 
Bkz. Şekil 22.

ŞEKİL 22. Atriyal Ölçüm
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Varsayılan Ölçümler
Uygulama doğrusal ve alan ölçümlerinin rapor edilmesini sağlar. İmleç tabloda listelenen ölçümler üzerine getirildiğinde, 
açılır ipuçları gösterilir.

ŞEKİL 23. Varsayılan Ölçümler

1. Rapora Ekle, 2. Perikardiyum için Yazma Alanı, 3. Özel Ölçüm Ekleme/Kaldırma, 4. Tüm Ölçümleri Sil

Bir Ölçüm Gerçekleştirme

1.  ögesini seçin.

2. Seriyi seçin. 

3.  düğmesine tıklayın.

4. Ölçülecek anatomiyi içeren görüntüyü seçin.

5. Seçimin etkin olduğunu göstermek üzere vurgulanacak istenen ölçüme tıklayın. 

DİKKAT: Hattın doğru yerleştirilmesi ölçüm sonuçları için çok kritiktir. Ölçümler yanlış yapılırsa, hatalı teşhisler 
meydana gelebilir. Ölçümler, yalnızca uygun bir şekilde eğitilmiş ve uzman bir kullanıcı tarafından 
oluşturulmalıdır.

1

2

3 4
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6. Düzenlemek için notun üzerine tıklayın, aktif olduğunda renk mora döner. İmleci uç noktalarından birinin üzerine 
getirin ve bitiş noktasını ayarlayın. 

İmleci Görüntü Düzenleyici penceresinin dışına taşıdığınızda, ölçüm uzaklığı değeri Ölçüm tablosunda uygun bir 
şekilde güncellenir.

Ölçüm uzaklığı hattının tamamını başka bir konuma taşımak için imleci orta işaretleyicinin üzerine getirin.

NOT: Ölçümü sıfırlamak için ölçüm uzaklığı hattını seçin, sağ fare tuşuna tıklayın ve çöp kutusunu (trash can) ögesini 
seçin ya da klavyedeki Sil (Delete) tuşunu kullanın. 

NOT: Özel ölçümler, Tercihler (Preferences) altındaki Yazdırma Tercihleri (Print Preferences) Diğer (Other) sekmesinde 
yeniden düzenlenebilir, Araçlar (Tools) > Tercihler (Preferences) > Düzenle'yi (Edit) ve ardından Yazdır (Print) 
sekmesini seçin.

Ölçümleri Silme

Tüm ölçümleri silmek için  ögesine tıklayın.

Özel Ölçüm Ekleme

1.  ögesini tıklayın. 

2. Özel Ölçüm Ekle (Add Custom Measure ) açılır penceresine benzersiz bir etiket girin.

3. Ölçüm türünü Doğrusal (Linear) veya Alan (Area) olarak seçin.

4. Tamam (OK) ögesini seçin. 

Özel Ölçümü Kaldırma

1.  ögesini tıklayın. 

2. Listeden kaldırılacak özel ölçümü/ölçümleri seçin.

3. Seç (Select) ögesini seçin.

NOT: Oluşturulan özel ölçümler listeden kaldırılana kadar gelecekte yapılacak tüm analizlerde yer alırlar.
suiteHEART® Yazılımı Kullanım Talimatları NS-03-043-0003-TR Rev. 1 85



Aort Kapağı Düzlemi Analizi
Aort kapağı düzlemi analizi özelliği, tepe hızını ve aort kapağı için tepe basınç değişim miktarı ile ortalama basınç değişim 
miktarını hesaplamayı sağlar.

Basınç değişim miktarı, sol ventriküler sistolik hacimdeki çerçeve-çerçeve değişimlere bağlı olarak ve LV otomatik 
bölümlemeden alınan sonuçları kullanarak kardiyak çıkışından hesaplanır.

Aort Kapağı Düzlemi Analizi Prosedürü
1. Tüm aşamalardaki tüm kesitlerde Otomatik LV bölümleme gerçekleştirin (bkz. sayfa 66).

2. Kapakçık anatomisini gösteren bir seri seçin.

3. Ölçüm tablosundan Aort Kapağı Alanı (Aoric Valve Area) ögesini seçin (Şekil 24) ve Şekil 25‘de gösterildiği gibi aort 
kapağı alan ölçümünü gerçekleştirin.

ŞEKİL 24. Aort Kapağı Alanı 

4. ROI tamamlandıktan sonra, tablodaki sonuçlar güncellenir ve zamana göre basınç değişim miktarını gösteren bir 
grafik sunar.

Tüm ölçümleri silmek için  ögesine tıklayın.

Tavsiye Edilen Referans

Wolff, Steven D., M.D., Ph.D. Noninvasive methods for determining the pressure gradient across a heart valve without using velocity 
data at the valve orifice. U.S. Patent 9,585,568, March 7, 2017.
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ŞEKİL 25. Aort Kapağı Düzlemi Analizi

UYARI : Analiz sonuçları bir teşhise ulaşmak için kullanılacaksa, kardiyak analizi yapma konusunda uzman bir 
kişi olmanız tavsiye edilir.

NOT: Aort Değeri Düzlem Analizi ile elde edilen Tepe Hız, Tepe Basınç Eğimi ve Ortalama Basınç Eğimi, mitral regurjitan 
ya da şant sorunu olan hastalarda geçerli değildir.

Miyokardiyal Kontraksiyon Fraksiyonu

Miyokardiyal kontraksiyon fraksiyonu (MCF), kısa eksenin tam endo ve epi LV bölümlemesini gerektirir ve kısa eksen işlevi 
için sonuç tablosunda rapor edilir. MCF için kendi normal aralıklarını oluşturmak kullanıcının sorumluluğundadır. 
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Tavsiye Edilen Referanslar

Abdalla M, Akwo EA, Bluemke DA, Lima JAC, Shimbo D, Maurer MS, Bertoni AG. Association between reduced myocardial 
contraction fraction and cardiovascular disease outcomes: The Multi-Ethnic Study of Atherosclerosis. Int J Cardiol. 
2019 Oct 15;293:10-16. doi: 10.1016/j.ijcard.2019.07.040. Epub 2019 Jul 11. PMID: 31327521; PMCID: PMC7175692.
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M, Giannitsis E, Kristen AV, Katus HA, Friedrich MG, Buss SJ. Myocardial contraction fraction derived from cardiovascular 
magnetic resonance cine images-reference values and performance in patients with heart failure and left ventricular 
hypertrophy. Eur Heart J Cardiovasc Imaging. 2017 Dec 1;18(12):1414-1422. doi: 10.1093/ehjci/jew324. PMID: 28165128.

Maurer MS, Packer M. How Should Physicians Assess Myocardial Contraction?: Redefining Heart Failure With a Preserved 
Ejection Fraction. JACC Cardiovasc Imaging. 2020 Mar;13(3):873-878. doi: 10.1016/j.jcmg.2019.12.021. PMID: 32139035.
suiteHEART® Yazılımı Kullanım Talimatları NS-03-043-0003-TR Rev. 1 88



Akış Analizi
Akış Analizi modu, hem 2B hem de 4B Akış alımlarını destekler. Akış hacimlerinin, hızlarının, regurjitan hacimlerinin, basınç 
eğiminin, basınç yarılanma zamanının ve Qp/Qs’nin hem manuel olarak hem de tam otomatik bölümlenme ile 
sayısallaştırılması desteklenir. Kullanıcı yöntemi seçim(ler)ine bağlı olarak; aortik, mitral, pulmonik ve triküspit regurjitanın 
otomatik hesaplaması elde edilebilir. Doğru akış sonuçları; doğru tarama düzlemi, uygun alma parametreleri ve 
düzlemden geçen akış kodlaması kullanılarak elde edilen görüntülere bağlıdır.

NOT: Görüntü kalitesinin zayıf olduğu durumlarda otomatik bölümleme daha az doğru olabilir. Bu durumlarda 
kullanıcı, konturları düzenlemekten veya manuel bölümlemeyi gerçekleştirmekten sorumludur.

NOT: Hem 2B aşama kontrastı hem de dahili 4B Akış analizi gerçekleştirilmişse, tüm sonuçlar Akış Analizi 
Modunda bulunacaktır.

Ön işleme özelliği, Tablo 1'de belirtildiği şekilde, 2B aşama kontrastına yönelik damar türlerinin tanımlanmasını destekler. 
suiteDXT Kullanım Talimatlarına bakın.

UYARI : Ön işlemenin ardından kullanıcı, tüm analizin doğruluğunu değerlendirmekten ve gerekli düzeltmeleri 
yapmaktan sorumludur. Kapsamlı bir gözden geçirme şunları içermelidir:
- ROI yerleştirme 
- Her kategori için doğru damar tanımlaması
- Ana hat düzeltme

UYARI : Kullanıcı, otomatik bölümleme algoritmaları tarafından oluşturulan ya da değiştirilenler de dahil olmak 
üzere, tüm ilgi bölgelerinin (ROI’ler) tam yerleştirmesi ve doğru kategori atanmasından sorumludur. 
Yazılım tarafından oluşturulan kantitatif veriler, tüm ilgi bölgelerinin tam yerleştirilmesine ve doğru 
damar kategorisi atamasına bağlıdır.

UYARI : Uygulama, yalnızca görüntülerin analizine yardım eder ve otomatik olarak sonuçların klinik açıdan bir 
yorumunu üretmez. Kantitatif ölçümlerin kullanımı ve yerleştirilmesi kullanıcının inisiyatifindedir. 
Ölçümler yanlış yapılırsa, hatalı teşhisler meydana gelebilir. Ölçümler, yalnızca uygun bir şekilde 
eğitilmiş ve uzman bir kullanıcı tarafından oluşturulmalıdır.
suiteHEART® Yazılımı Kullanım Talimatları NS-03-043-0003-TR Rev. 1 89



ŞEKİL 1. Akış Analizi Arayüzüne Genel Bakış

1. Damar Kategorileri, 2. Yetişkin/Pediyatrik Seçimi, 3. Aktif ROI seçimi, 4. Grafiği Ters Çevir, 5. Seçimleri yay, 6. Silme seçenekleri, 
7. Ana hat, düzeltme aşağı açılır menüsü, 8. Ofset: Aşama, Dilatasyon, Akış, 9. Gürültü Piksellerini Çıkarma, 10. Renk Opasite Kontrolü, 
11. Örtüşme Düzeltmesi, 12 Eğri Modu Seçimleri, 13. Sonuç tablosu seçimleri, 14. Eğri Sonuçları/Görüntüleme, 15. Regurjitan Modu, 
16. Düzenleme araçları, 17. Entegre Analiz

NOT: Akış Analizi, büyüklük ve aşama görüntülerini yan yana görüntüler halinde gösterir. Aynı tarama konumunda elde 
edilen diğer görüntü tipleri görüntülenmez ve Görüntüleyicide gözden geçirilmesi gerekir.

NOT: Kalp hızı, eğri görüntüsündeki akış sonucunun üzerine gelerek elde edilebilir.

1
2

3 4 5 6
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9
10

11
12 13

14

15

16

17
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Otomatik Bölümleme Kullanan Akış Analizi
Çalışmada bulunan 2B aşama kontrast serisine göre ön işleme tamamlanmış ise, bölümleme, 2B aşama kontrast serisinde 
otomatik olarak gerçekleştirilecek ve uygun damar kategorisine atanacaktır (Tablo 1). Otomatik bölümleme, damara ilk 
ROI'nin yerleştirilmesini gerektirmez, sadece uygun damar kategorisini ve bu damarı görüntüleyen uygun seriyi seçin. Eğer 
ön işleme gerçekleşmemiş ise, alınan damar anatomisine karşılık gelen uygun kategoriyi seçmek önemlidir.

UYARI : Kullanıcı, ön işleme ile oluşturulanlar da dahil olmak üzere, tüm ilgi bölgelerinin (ROI’ler) tam olarak 
yerleştirilmesinden ve doğru kategori atamasından sorumludur. 

NOT: Aşama kontrastında sekme başına alınan damar sayısı altıdan fazlaysa, Ön İşleme özelliği sadece en son altı 
sonucu saklar.

NOT: Net akış sonucu, her damar kategorisinin altında görüntülenecektir. Bir damar kategorisinde birden fazla akış 
ölçümü varsa, ortalama sonuç gösterilecektir. Bu değeri gizlemek için Araçlar (Tools) > Tercihler (Preferences) > 
Düzenle (Edit) ögelerini seçin ve Akış (Flow) menüsünde akış birimini HİÇBİRİ (NONE) olarak ayarlayın. 

Tablo 1: Damar Kategorileri

Damar Kategorisi Araç İpucu Etiket

LVOT Sol Ventriküler Çıkış Yolu (Pediyatrik) 

pAAo Proksimal Çıkan Aort

mAAo Orta Çıkan Aort

pDAo Proksimal İnen Aort
(Pediyatrik)

SVC Süperior Vena Kava
(Pediyatrik)

MPA Ana Pulmoner Arter

RPA Sağ Pulmoner Arter
(Pediyatrik)
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Otomatik veya Manuel Bölümleme Gerçekleştirin 
(Proksimal Çıkan Aort Bölümleme Örneği)

1. Yetişkin veya Pediyatrik  ögeyi seçin.

2.  kategorisini seçin.

3. Şekil 2'de gösterildiği gibi, proksimal çıkan aortu gösteren uygun aşama kontrast serisini seçin.

ŞEKİL 2. Proksimal Çıkan Aort

4. Şekil 3’te gösterildiği gibi, Aktif ROI rengini seçin.

ŞEKİL 3. Aktif ROI Seçimi

LPA Sol Pulmoner Arter
(Pediyatrik)

IVC İnferiör Vena Kava
(Pediyatrik)

dDAo Distal İnen Aort
(Pediyatrik)

Akış 1, Akış 2 Kullanıcı tanımlı kategoriler. Sağ tıklayın ve kategori için yeni 
bir etiket girin. Etiket, araç ipucu şeklinde görünecektir. 

Tablo 1: Damar Kategorileri

Damar Kategorisi Araç İpucu Etiket
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Kullanılabilir altı ROI vardır ve 1 - 6 olarak numaralandırılmıştır. Renk kodları analiz görünümünde, görüntüleme 
alanlarında ve grafiklerde tutarlıdır.

5.  ögesini seçin.

6. Damar üzerindeki bölümlemeyi gözden geçirin. Doğru damarın bölümlere ayrıldığını doğrulayın. 
Yanlış damar bölümlemesi yapılmışsa, manuel bölümleme yapın.

7. Manuel bölümleme gerçekleştirmek için  ögesini seçin.

8. İlgilendiğiniz damarın etrafına 4 nokta bırakarak bir damar etrafında bir kontur oluşturun, ROI’yi kapatmak için imleci 
düzenleme penceresinin dışına hareket ettirin.

• Kesit içindeki tüm aşamalar üzerinde otomatik bölümleme yapmak için  ögesini seçin.

veya

• Kesit içindeki tüm aşamalar üzerinde aynı konturu yaymak için  ögesini seçin. Bu, küçük ve sabit damarları incelerken 
kullanışlıdır.

9. Düzenlemek için bir kontur üzerine tıklayın, düzenlemeyi yapın ve  ögesine tıklayın. Bkz. Kontur Düzenleme, 
sayfa 94.

10. Akış sonuçları grafikte ve sonuç tablolarında görüntülenir. Grafikten ilişkili eğriyi kaldırmak için akış sonucunun 
yanındaki onay kutusuna tıklayın. 

11. Dosya aşağı açılır menüsünden bir Ana Hat Düzeltme seçeneği seçin.
Ana Hat Düzeltme uygulanan eğrilerin Şekil 8‘de gösterildiği gibi dolu aşama veri noktaları olur. Bkz. Ana Hat Düzeltme 
Seçenekleri, sayfa 97.

ŞEKİL 4. Akış Grafiği - Düzeltme Yok (sol grafik); Düzeltme Uygulanmış (sağ grafik)

Üretilen tüm akış eğrileri pozitif yönde gösterilir. Ters eğriler,  ile gösterilir.
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Damar Kategorisi Taşıma

Gözden geçirme sonrasında, tamamlanan bir akış sonucu doğru damar kategorisinde bulunmuyorsa, uygun 
kategoriye taşınabilir.

Kontura sol tıklayın, ardından sağ tıklayıp bırakın; daha sonra imleci damar türüne sürükleyin ve Şekil 5’te gösterildiği şekilde 
uygun damar kategorisini seçin. (Pediyatrik kategoriler gösterilmiştir.) Akış sonucu şimdi bu kategoride gösterilecektir.

ŞEKİL 5. Damar Kategorisi Taşıma Seçimi

Kontur Düzenleme
1. Düzenlemek istediğiniz aşamayı seçin.

2. Düzenlemek için etkinleştirmek istediğiniz kontura sol tıklayın.
Kontur mora dönüşerek düzenlenebileceğini gösterir.

3. Görüntüleniyorsa, nokta eğrisi konturları için noktaları hareket ettirerek konturu düzenleyin.

4. Tıklayarak ve izleyerek serbest bir düzenleme gerçekleştirin. 

5. Tablo 2'de açıklandığı gibi, seçmek için kontura sol tıklayın, ardından araçları kullanmak için sağ tıklayın. 

6. Görüntü alanı düzenleme araçlarını Tablo 3'te açıklandığı şekilde kullanın.

Tablo 2: Sağ Fare Tıklama Seçenekleri

Araç Açıklama

Mevcut aşamada tek bir ROI’yi silin

Tüm aşamalardaki tüm ROI’leri silin
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Bir Aşama Aralığını Düzenleme
1. İstenen kesiti seçin.

2. Verilen kesit konumunun tüm aşamalarına ait küçük resimleri görüntülemek için  ögesini seçin.

3. Düzenlenecek aşama aralıklarının ilk aşamasını seçin.

4. Üst karakter tuşunu (shift) basılı tutun ve düzenlenecek aralıktaki son aşamayı seçin.

5. Konturu görüntü düzenleyici penceresinde düzenleyin.

6. Görüntü üzerinde seçili konturdan uzak bir yere tıklayarak veya imleci düzenleyici penceresinin dışına taşıyarak 
konturun seçimini kaldırın.

Sürükleme Aracı seçimi

Çekme aracı seçimi

Mevcut damar kategorisi gösterilecektir. Akış sonuçlarını farklı bir kategoriye taşıyın

Tablo 3: Görüntüleme Alanı Düzenleme Araçları 

Araç Açıklama

Düzenlemeyi aşamaların sonuna kopyala 

Düzenlemeyi aşamaların başına kopyala 

Önceki aşamadan ROI’yi kopyala 

ROI’yi bir sonraki aşamaya kopyala 

ROI boyutunu azalt 

Tablo 2: Sağ Fare Tıklama Seçenekleri

Araç Açıklama
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ROI boyutunu genişlet

Önceki ve Sonraki Aşamaya Git

ROI’yi sağa veya sola kaydır

ROI’yi aşağı veya yukarı kaydır 

Tablo 3: Görüntüleme Alanı Düzenleme Araçları 

Araç Açıklama
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Ana Hat Düzeltme Seçenekleri
2B aşama kontrastı için üç akış ana hat düzeltme yöntemi vardır. Üzerine bir düzeltme yöntemi uygulanan akış eğrilerinin 
dolu aşama veri noktaları olur.

NOT: Analiz için kullanılan aşama kontrast görüntülerinde görüntü aşaması kapama olmamalıdır. Görüntüde bulunan 
aşama kapama, otomatik ana hat düzeltmesini geçersiz kılacaktır.

Otomatik Ana Hat Düzeltme

Otomatik ana hat düzeltme işlevi, uzak sabit organlardaki (ör. Göğüs kafesi duvarı, karaciğer, vb.) aşama hatalarını 
araştırarak ve verileri doğrusal ya da yüksek dereceli aradeğerleme yöntemiyle doldurarak, resim alma esnasında meydana 
gelen aşama hatalarını düzeltir.

NOT: 3B/4B Akış Görüntüleyici kullanılarak bir 2B büyüklük ve aşama serisi oluşturulursa, uygulama düzeltilmemiş bir 
seri ve aşama hatası düzeltmesinin uygulandığı ikinci bir seri oluşturur. “Düzeltilmiş” (“Corrected”) etiketli 
serilere ana hat düzeltme aşağı açılır menüsündeki Otomatik (Auto) seçeneğini uygulamayın.

1. Uygun aşama kontrast serisini kullanarak bir akış eğrisi oluşturun.

2. Ana Hat Düzeltme aşağı açılır menüsünden Otomatik (Auto) ögesini seçin.

NOT: Tercihlerde Otomatik Ana Hat Düzeltme seçilirse, otomatik ana hat düzeltme otomatik olarak uygulanır.

3. Düzeltme, güncellenmiş sonuçlarla uygulanır ve akış grafiği üzerinde doğrudan gösterilir.

4. Uyum analizinde başarısız olan seriler, Şekil 6‘daki gibi bir uyarı sembolü ile gösterilir.

NOT: Görüntü içinde aşama kapama varsa, bu Şekil 7‘de gösterildiği gibi hatalı akış sonuçlarına neden olur. 
Akış analizi için kullanılan 2B Film Aşama Kontrast görüntülerinde Şekil 8‘de gösterildiği gibi görüntü aşama 
kapama olmamalıdır.

ŞEKİL 6. Ana Hat Düzeltme Hatası

Hata Tipleri:
1 – Görüntüde Kapama
2 – Görüntüde Gürültü
3 – Geçersiz görüntü
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ŞEKİL 7. Aşama Kapamayı Gösteren Örnek Görüntüler (Beyaz Oklar)

ŞEKİL 8. Aşama Kapama Olmayan Örnek Görüntüler

Fantom Düzeltme

Aşama kontrast sonuçlarının doğruluğunu iyileştirmek ve ana hat aşaması kayma hatalarını düzeltmek için hatayı 
hesaplamak maksadıyla bir fantom veri alma gerçekleştirilebilir.

NOT: Fantom düzeltme serisi, orijinal akış serisiyle aynı tarama talimatıyla ve aynı parametrelerle alınmış olmalıdır. 
Fantom seride konturun tamamını dolduran sabit bir nesneden alınan sinyal olmalıdır.

1. Uygun aşama kontrast serisini kullanarak bir akış eğrisi oluşturun.

2. Ana Hat Düzeltme aşağı açılır menüsünden karşılık gelen fantom seriyi seçin.

3. Düzeltme, güncellenmiş sonuçlarla uygulanır ve akış grafiği üzerinde doğrudan gösterilir.

Arka Plan Kontur Düzeltme

Bu düzeltme yöntemi, statik dokularla çevrili damarlar için değerlendirilmelidir.

NOT: En iyi düzeltme için, arka plan konturu akış bölgesine doğrudan komşu olan ve onu çevreleyen statik dokuya 
yerleştirilmelidir.
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1. Uygun aşama kontrast serisini kullanarak bir akış eğrisi oluşturun.

2. Ana Hat Düzeltme aşağı açılır menüsünden Arka Plan ROI (Background ROI) ögesini seçin.

3. Bir kontur çizmek için  ögesine tıklayın.

4. Düzeltme, güncellenmiş sonuçlarla uygulanır ve akış grafiği üzerinde doğrudan gösterilir.

Akış Araçları
Ofset Seçenekleri 

Dosya aşağı açılır menüsünde 3 seçenek bulunmaktadır: Aşama, Akış, Dilatasyon

Gürültü Piksellerini Çıkar

Bu seçenek, Şekil 10’da gösterildiği gibi pembe katmanla tanımlanan ROI içinde mevcutsa düşük yoğunluklu pikselleri 
(hızlara yüksek değişim) belirler ve onları akış hesaplamasından çıkarır. Gürültü piksellerinin yüzdesi kaydırma çubuğu 
kullanılarak ayarlanabilir.

ŞEKİL 9. Gürültü Pikselleri

Tablo 4:

Seçim Açıklama

Aşama Akış eğrisinin düzenini değiştirir.

Akış Akış sonucunun ana hat değerlerini değiştiren akış eğrisinin apsis değerini değiştirir.

Dilatasyon Geçerli akış piksellerini dahil etmek için, tüm aşamalara ilişkin bölümlere ayrılmış damarın 
yarıçapını belirli bir piksel miktarı kadar eşit oranda değiştirir.
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ŞEKİL 10. Pembe Katmanla Gösterilen Gürültü Pikselleri

Renk Katmanı
Büyüklük görüntüsü üzerinde hızları temsil eden kırmızı/mavi renkli bir katmanı görüntülemek için, renk opaklığı kaydırma 
çubuğunu tıklayın ve sürükleyin. Mavi veya kırmızı işaretçileri, Şekil 11'de gösterildiği gibi ayarlayarak hız aralığını 
ayarlayın. Renk opaklığını ayarlamak için Akış (Flow) menüsü altındaki Global sekmesinden Tools Araçlar (Tools) > 
Tercihler (Preferences) > Düzenle (Edit) ögelerini seçin. Renk kaplamasını kaldırmak için opaklığı %0 değerine ayarlayın.

ŞEKİL 11. Renk Katmanı Kontrolleri

Hız Örtüşme Düzeltmesi

Hız örtüşmesini düzeltmek maksadıyla aşama açmayı gerçekleştirmek için kaydırma çubuğu kontrol işaretçisini çekin. 
Değişikliğin etkisi, doğrudan aşama görüntüsü üzerinde güncellenecek ve akış grafiği güncellenecektir. 
Örtüşme düzeltmesi, görüntüde bir ROI olmadan gerçekleştirilebilir. Seride birden fazla kesit konumu mevcutsa, ayarın 
değiştirilmesi tüm kesit konumlarını etkileyecektir. Tek bir kesit konumunu değiştirmek için, kaydırma çubuğu kontrolünü 
değiştirirken, klavyedeki Ctrl veya Alt tuşunu kullanın. 
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Kullanıcı Tanımlı Tepe Nokta Hızı
1. Kardiyak döngüsünün uygun aşamasını seçin.

2. İmleci aşama görüntüsü üzerine yerleştirmek için  ögesini kullanın.
İmleç hem büyüklük hem de aşama görüntüleri üzerinde eş zamanlı olarak hareket eder. Hız, mm/s cinsinden imlecin 
yanındaki aşama görüntüsü üzerinde görünür.

ŞEKİL 12. Piksel Akış Hızı

Eğri Modu Seçimleri

Tablo 5:

Seçim Mod Açıklama

Akış Eğri, tüm kardiyak döngüsündeki her aşamanın akış hacmini 
temsil eder (varsayılan). Eğri üzerindeki her nokta o aşama için 
akışı temsil eder. Net akış sonucu görüntülenir.

Histogram Kardiyak döngüsünün her aşaması için her bir ilgi bölgesindeki 
her bir pikselin hızının bir çizimini gösterir. Tepe ve ortalama 
basınç eğimi sonuçları görüntülenir.

Basınç Yarı Zamanı (PHT) Tepe transmitral basınç değişiminin yarıya indiği süredir. PHT ve 
mitral kapakçık alanını (MVA) hesaplamak için grafiğin eğimini 
belirlemeye olanak sağlar.

Karşılaştır İki farklı kategorideki eğrilerin görüntülenmesine olanak sağlar. 

Regurjitan Net negatif akışı hesaplar (x ekseninin altında). 
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Histogram Modu

Piksel başına hızları göstermek ve tepe ve ortalama basınç değişimini hesaplamak için histogram modunu kullanın.

1. Uygun aşama kontrast serisini kullanarak bir akış eğrisi oluşturun.

2.  ögesini seçin.

3. Aşama görüntüsü üzerinde, pikselin karşılık gelen konumunu gösteren ince artı imleci etkinleştirmek için doğrudan 
grafiğe tıklayın.

4. En yüksek ve en düşük hız değerlerini bulmak için grafiğin altında yer alan çift ok kontrollerini kullanın (Şekil 13).

5. Hız değerleri içinde kesikli olarak artırma yapmak için, Şekil 13‘te gösterildiği gibi tek ok kontrollerini kullanın.

NOT: Histogram modunda doğrudan akış eğrisi üzerinde tıklandığında, seri bulma işlevi kapatılır. Bulma işlevini 
yeniden açmak için akış moduna geçin.

NOT: Karşılık gelen büyüklük ve aşama görüntülerinin gösterildiğinden emin olmak için, bir defada tek akış eğrisi ile 
çalışın, grafik gösterimindeki diğer histogram eğrileri üzerindeki seçimleri kaldırın.

NOT: suiteHEART® Yazılımının daha eski bir sürümünde histogram modu kullanılarak analiz edilmiş çalışmaların 
yeniden analiz edilmesi gerekebilir.

ŞEKİL 13. Histogram Modu

Basınç Yarı Zamanı

Basınç Yarı Zamanı (PHT), mitral kapakçıktan alınan aşama kontrast görüntülerindeki E dalgasının yavaşlama eğimi 
hesaplanarak elde edilebilir. Bu mod, PHT ve mitral kapakçık alanını (MVA) hesaplamak için grafiğin eğimini belirlemeye 
olanak verir.

1. Uygun mitral kapakçık aşama kontrast serisini kullanarak bir akış eğrisi oluşturun.

2. ROI’yi yaymak için kopyala-yapıştır seçeneğini kullanın.

3.  ögesini seçin.
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4. Eğrinin yavaşlama kısmındaki en yüksek hızı tespit etmek için doğrudan çizim üzerine tıklayın.

5. Eğrinin eğimini hesaplamak için Şekil 14’te gösterildiği gibi bir bitiş noktasına tıklayın.

6. Hesaplamayı sıfırlamak için imleci bir bitiş noktasının üzerine getirin, sağ fare tuşuyla tıklayın ve çöp kutusunu seçin.

ŞEKİL 14. Basınç Yarı Zamanı Sonuçları

NOT: Mitral Kapakçık bölgesi (MVA), Basınç Yarı Zamanı (PHT) sonuçları aort yetmezliği, kardiyak şantı ya da düşük 
ventriküler uyumdan muzdarip hastalarda geçerli değildir.

NOT: PHT modunda doğrudan akış eğrisi üzerinde tıklandığında, seri bulma işlevi kapatılır. Bulma işlevini yeniden 
açmak için akış moduna geçin.

Referans:

http://www.csecho.ca/mdmath/?tag=mvaph
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Akış Sonuçlarını Görüntüleme
Akış sonuçlarını tablo biçiminde gözden geçirmek için aşağıdaki seçeneklerden birini seçin.

Akış1 ve Akış2 için Kategori Etiketini Değiştirme
Yalnızca Akış 1 veya Akış 2 kategorilerinin etiketleri değiştirilebilir.

ŞEKİL 15. Akış 1, Akış 2

Etiketi Değiştirme
1. Akış 1 veya Akış 2'ye fareyle sağ tıklayın (Şekil 15).

2. Yeni etiket adını girin (Şekil 16).

3. Yeni etiketler araç ipuçları olarak görünecektir. 

NOT: Eğri gösterge etiketine aynı etiket atanacaktır. 

Tablo 6: Sonuç tablosu Seçenekleri

Seçim Etiket Açıklama

Entegre 
Analiz

Akış panelinden analiz sonuçlarını görüntüler. Aortik, mitral, 
pulmonik ve triküspit regurjitan ve Qp/Qs’ye yönelik sonuçları 
içerir. Bkz. Entegre Analiz, sayfa 106.

Akış Analizi Her bir akış eğrisine yönelik sonuçların özeti. 

Veri Tablosu Her bir akış eğrisine yönelik her aşama için ayrıntılı akış 
parametrelerini listeler.
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ŞEKİL 16. Düzenleme Kategorisi Etiketleri 

NOT: Akış kategorisi etiketini değiştirmek, rapordaki akış başlık etiketini değiştirir.

Eğri Göstergelerini Düzenleme 
1. Akış grafiğinin altında bulunan Akış 1:1 üzerine sağ fare tuşuna tıklayın (Şekil 17).

NOT: Eğer kategori etiketi değiştirilmişse, o etiket gösterilecektir.

ŞEKİL 17. Eğri Göstergelerini Düzenleme

2. Yeni etiket adını girin.

ŞEKİL 18. Akış Eğrisi Göstergeleri Etiketini Değiştirme

NOT: Yeni akış eğrisi göstergeleri mevcut şablona kaydedilir.
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Entegre Analiz 
Kullanıcı tarafından seçilen bir yönteme göre Entegre Analiz; Qp, Qs, Qp/Qs, aortik, mitral, pulmonik ve triküspit regurjitan 
hacimlerini ve regurjitan fraksiyonlarını (%RF) hesaplar.

UYARI : Qp, Qs ve aortik, mitral, pulmonik ve triküspit regurjitan hacimlerini ve regurjitan fraksiyonlarını 
belirleme yönteminin seçiminden kullanıcı sorumludur. 

UYARI : Hastanın patolojisine bağlı olarak, yöntemlerin bir kısmı veya tamamı uygun olmayabilir. Yorumlama 
açısından herhangi bir yöntemin geçerli olup olmadığının belirlenmesinden kullanıcı sorumludur.

UYARI : Kullanıcı, ön işleme ile oluşturulanlar da dahil olmak üzere, tüm ilgi bölgelerinin (ROI’ler) tam olarak 
yerleştirilmesinden ve doğru kategori atamasından sorumludur.

NOT: Dosya aşağı açılır menüsünden Kullanıcı, Araçlar (Tools) > Tercihler (Preferences) > Düzenle (Edit) ögelerini 
seçerek Entegre Analiz’e ilişkin varsayılan hesaplama yöntemini ayarlayabilir. Varsayılan Yöntem seçimleri 
şunlardır: Hiçbiri (None), Tümü (All) veya Sonuncu (Last).
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Entegre Analize Genel Bakış (Yetişkin gösterilmiştir)

• ml/atış veya l/dk birim seçimi
• BSA seçimi indeksi (boy ve kilo, Raport Görünümü sekmesine girilmelidir)
• Pozitif Akış sonucu seçimi

Qp ve Qs’ye yönelik seçimler
• Qp: MPA kategorisindeki akış değerlerini görüntüler 
• Qs: pAAo veya mAAo kategorilerinden akış değerlerini görüntüler
• Qp/Qs sonucu
• Kısa eksen işlev analizinde görüntülenen LV ve RV kalp atışı hacmi sonuçları

Altı çizili Qp veya Qs değerleri manuel olarak girilebilir. Sıfırlamak için, değeri silin 
ve klavyede enter tuşuna basın.

Hesaplama yöntemi aşağıdakiler için seçilebilir: 
• 1- Aort regurjitan ve %RF
• 2- Mitral regurjitan ve %RF
• 3- Pulmonik regurjitan ve %RF
• 4- Triküspit regurjitan ve %RF

Altı çizili regurjitan değerleri manuel olarak girilebilir. Sıfırlamak için, değeri silin 
ve klavyede enter tuşuna basın. 

1

2

3

4
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Qp/Qs Hesaplama
1. Entegre Analiz özelliğini kullanmak için, Şekil 19'da gösterildiği gibi sağ üst köşeden AKIŞ (FLOW) ögesini seçin.

ŞEKİL 19. Akış Sekmesi

2. Entegre Analizini kullanmadan önce, tüm damar atamalarını ve tüm kategorilerdeki doğru konturları onaylayın.
• Eğer bölümlere ayrılan damar, yanlış kategoride ise, sağ fare tuşuna tıklayın ve doğru kategoriye gidin.

Tablo 7: Qp/Qs Seçimleri

NOT: Bir damar kategorisinin birden fazla ölçümü varsa, bunların ortalaması kullanılacaktır.

NOT: Qp veya Qs için değer, tabloda açıklanan seçimlerin birisi veya birleşiminden elde edilebilir.

Sonuç Seçim Açıklama

Qp MPA kategorisinden akış sonucu. 

Qp
(Pediyatrik)

LPA + RPA'dan akış sonucu

Qs pAAo veya mAAO kategorisinden akış sonucu. Qs sonucunun ortalamasını almak için 
her iki damar türünü seçin. 

Qs
(Pediyatrik) 

LVOT kategorisinden akış sonucu.

Qs
(Pediyatrik) 

Akış sonucu SVC + pDAo

Qs
(Pediyatrik)

Akış sonucu SVC + IVC

Qs
(Pediyatrik)

Akış sonucu SVC + dDAo

Qp/Qs= Sonuç, yukarıdaki seçimlere dayanmaktadır.
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• Eğer bölümlere ayrılan damar, o kategori için yanlış damar ise, Aktif ROI'yi silin ve  ögesine tıklayın.
• Otomatik bölümlemeyi kullandıktan sonra ve damar doğru şekilde tanımlanmadı ise, manuel bölümlemeyi gerçekleştirin. 

Bkz. Otomatik veya Manuel Bölümleme Gerçekleştirin, sayfa 92.

UYARI : Kullanıcı, ön işleme ile oluşturulanlar da dahil olmak üzere, tüm ilgi bölgelerinin (ROI’ler) tam olarak 
yerleştirilmesinden ve doğru kategori atamasından sorumludur.

3. Qp için  ögesini seçin.

4. Qs için,  veya  ögesini yahut her iki damar kategorisini seçin (iki kategorideki değerlerin ortalaması alınacaktır).

5. Qp/Qs sonucu, Şekil 20’de gösterildiği gibi hesaplanacaktır.

ŞEKİL 20. Qp/Qs Sonuçları (Yetişkinler gösterilmiştir)
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Regürjitant Hacmi ve Regürjitant Fraksiyonunu (%RF) Hesaplama
1. Entegre Analiz özelliğini kullanmak için, Şekil 21'de gösterildiği gibi sağ üst köşeden AKIŞ (FLOW) ögesini seçin.

ŞEKİL 21. Akış Sekmesi

2. Entegre Analizini kullanmadan önce, tüm damar atamalarını ve tüm kategorilerdeki doğru konturları onaylayın.
• Eğer bölümlere ayrılan damar, yanlış kategoride ise, sağ fare tuşuna tıklayın ve doğru kategoriye gidin. 

• Eğer bölümlere ayrılan damar, o kategori için yanlış damar ise, Aktif ROI'yi silin ve  ögesine tıklayın.
• Otomatik bölümlemeyi kullandıktan sonra ve damar doğru şekilde tanımlanmadı ise, manuel bölümlemeyi gerçekleştirin. 

Bkz. Otomatik veya Manuel Bölümleme Gerçekleştirin, sayfa 92.

Tablo 8: Regürjitant Hacmine ilişkin Hesaplama Yöntemleri

Seçim Kapakçık Tipi Yöntem Açıklaması

Aortik Doğrudan Akış Eğrisinden (Proksimal)

Aortik Doğrudan Akış Eğrisinden (Orta)

Aortik
(Pediyatrik)

LVOT pozitif akış oranı - Qp

Mitral Dolaylı 
(Kullanılan LVSV, kısa eksen işlevi sonuçlarından elde edilir) 

Mitral Dolaylı
(Kullanılan LVSV değeri, kısa eksen işlevi sonuçlarından elde edilir)

Pulmonik Doğrudan akış eğrisinden (MPA)

Pulmonik
(Pediyatrik)

Doğrudan akış eğrisinden 
LPA + RPA negatif akış 

Triküspit Dolaylı
(Kullanılan RVSV, kısa eksen işlevi sonuçlarından elde edilir)

Triküspit Dolaylı
(Kullanılan RVSV, kısa eksen işlevi sonuçlarından elde edilir)
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UYARI : Kullanıcı, ön işleme ile oluşturulanlar da dahil olmak üzere, tüm ilgi bölgelerinin (ROI’ler) tam olarak 
yerleştirilmesinden ve doğru kategori atamasından sorumludur.

3. Hesaplama modunu seçin. Şekil 22'de gösterilen aort regurjitanı ve regurjitan fraksiyonu,  ögesi seçilerek 

hesaplanır ve pulmonik regurjitan ve regurjitan fraksiyonu, ögesi seçilerek hesaplanır.

ŞEKİL 22. Aortik ve Pulmonik Yöntem Seçimleri (Yetişkinler Gösterilmiştir)

4. Regurjitan hacim ve %RF, Şekil 22’de gösterildiği gibi hesaplanmıştır. Kullanılan payda değeri aort ve mitral için LVSV, 
triküspit ve pulmonik için ise RVSV'dir. Farklı bir değer girmek için üçgene sol tıklayın ve alana yeni bir değer yazın. 
Orijinal değere sıfırlamak için alanı temizlemeniz ve Şekil 23'te gösterildiği gibi klavyede enter tuşuna basmanız yeterlidir.

ŞEKİL 23. RF Paydası
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5. Birden fazla hesaplama yöntemi seçilirse, değerlerin regurjitan hacmi sonucuna ilişkin ortalaması alınır. 

6. Mitral regurjitan ve %RF'nin hesaplanması için Şekil 24'te gösterildiği gibi bir Qp, Qs ve aortik regurjitan yönteminin 
seçilmesi gerekir.

7. Triküspit regurjitan ve %RF'nin hesaplanması için Şekil 24'te gösterildiği gibi bir Qp, Qs ve pulmonik regurjitan 
yönteminin seçilmesi gerekir.

8. Negatif olan herhangi bir sonuç, geçersiz olarak kabul edilir ve Şekil 24’te gösterildiği gibi sarı bir üçgenle gösterilir. 

ŞEKİL 24. Yöntem Seçimleri (Yetişkinler Gösterilmektedir)
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Entegre Analiz Sonuçlarının Gözden Geçirilmesi

Tüm sonuçları incelemek için  ögesini seçin. 

NOT: Akış birimlerinin seçimi, Entegre Analiz panelinin üst kısmındadır, ml/atış veya l/dk'yı seçin.

NOT: Sonuçlar, Entegre Analiz panelinin üst kısmında BSA'ya İndeks (Index to BSA) ögesi seçilerek BSA'ya 
indekslenebilir. Geçmiş sekmesine hem boy hem de kilo girilmelidir. 

ŞEKİL 25. Entegre Sonuçlar
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Miyokardiyal Değerlendirme 
Kullanıcı, otomatik bölümleme algoritmaları tarafından oluşturulan ya da değiştirilenler de dahil olmak üzere, tüm ilgi bölgelerinin 
(ROI’ler) tam ve isabetli olarak yerleştirilmesinden sorumludur. Yazılım tarafından üretilen nicel veriler bu ilgi bölgelerinin ve 
uygulanan eşik değerlerin tam ve isabetli olarak yerleştirilmesine bağlıdır.

Çalışma Ön İşleme özelliği, LE’nin (Late Enhancement) ön işleme tabi tutulmasına olanak sağlar. suiteDXT Kullanım 
Talimatlarına bakın.

Miyokardiyal Değerlendirme (ME) analiz aracı, miyokardiyum içindeki sinyal yoğunluğu farklı alanların nicel olarak 
belirlenmesine yardımcı olur. 

Dört analiz sekmesi mevcuttur:
• Late Enhancement - Yüksek ve düşük sinyal yoğunluğuna sahip miyokardiyal kesitleri belirler.
• T2 - Kirli kan görüntüleme teknikleriyle yüksek sinyal yoğunluğuna sahip miyokardiyal kesitleri belirler.
• Sinyal Diferansiyeli - LE ve T2 analizi ve T2 sinyal yoğunluk (SI) oranını kullanarak Kazanım Kütlesi sonuçlarını gösterir.
• Early Enhancement - T1 ağırlıklı görüntülerden miyokardiyumun sinyal yoğunluğunun ve mutlak miyokardiyal güçlendirme 

yüzdesinin oranını belirler.

UYARI : Ön işlemenin ardından kullanıcı, tüm analizin doğruluğunu değerlendirmekten ve gerekli düzeltmeleri 
yapmaktan sorumludur. Kapsamlı bir gözden geçirme şunları içermelidir:
- ROI yerleştirme/tanımlama
- RV ekleme konumu
- Sinyal yoğunluk eşiği

UYARI : Uygulama, yalnızca görüntülerin analizine yardım eder ve otomatik olarak sonuçların klinik açıdan bir 
yorumunu üretmez. Kantitatif ölçümlerin kullanımı ve yerleştirilmesi kullanıcının inisiyatifindedir. 
Ölçümler yanlış yapılırsa, hatalı teşhisler meydana gelebilir. Ölçümler, yalnızca uygun bir şekilde 
eğitilmiş ve uzman bir kullanıcı tarafından oluşturulmalıdır.

Analiz Sekmeleri
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Sonuç Ölçüm Etiketlerini Tanımlama
Sonuç ölçüm etiketleri kullanıcı tanımlı olabilmelidir; varsayılan etiket Güçlendirme’dir (Enhancement) .

1. Araçlar (Tools) > Tercihler (Preferences) > Düzenle (Edit) ögelerini seçin.

2. Boş alanlara Şekil 1 bölümünde gösterildiği gibi, ek etiketleri yazın.

3. Varsayılan etiketi seçin. 
Bu etiket, tüm yeni analizler için kullanılacaktır. 

4. Save and Exit (Kaydet ve Çık) ögelerini tıklayın.

ŞEKİL 1. Etiketleri Tanımla

Ölçüm tablosundaki etiketi değiştirmek için, yeni bir etiket seçmek amacıyla ok üzerine sol tıklayın. 

ŞEKİL 2. ME Ölçüm Etiketleri

Late Enhancement Analiz Prosedürü

1.  ögesini seçin.
2. LE (Late Enhancement) sekmesini seçin.
3. Uygun kısa eksen serisini seçin.

4. Otomatik bölümleme yapmak için  ögesini seçin.
5. Tüm endokardiyal ve epikardiyal izleri, RV ekleme noktasını ve her kesitteki eşiği gözden geçirin. 

Eşiği gerekli oldukça düzenleyin.
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ŞEKİL 3. Miyokardiyal Değerlendirme Analizi

1. Sonuç tablosu, 2. Kutupsal Çizim Seçimi, 3. Kutupsal Çizim Gösterimi, 4. Sonuç Tablosu Gösterimi, 5. Sil, 6. Kutupsal Çizim

6. Manuel bölümleme yapmak için,  ögesini seçerek en bazal kesitte LV endokardiyumu izleyin.

7.  ögesini seçerek LV epikardiyumu izleyin.

8.  ögesini seçerek alt RV ekleme noktasını yerleştirin. 
9. ROI’yi tamamlamak için imleci düzenleyici penceresinin dışına taşıyın.
10. Tüm ventrikül bölümlere ayrılana kadar 6 - 9 arasındaki adımları tekrar edin.
11. Taban (base), orta (mid) ve tepe (apical) sınıflandırmasını onaylayın. 

1

2 

3

5 

6

4
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Eşik Seçimi
1. Dosya aşağı açılır menüsünden uygun eşik algoritmasını seçin (Şekil 4).

ŞEKİL 4. Eşik Algoritması Seçimi

2. Gerekli olursa, söz konusu kesitin eşik değerini en üst seviyeye çıkarmak için  ögesine tıklayın. Bu değeri tüm 

kesitlere uygulamak için  ögesine tıklayın. Gerekli ise, her kesit için eşik algoritmasını ayarlamak 
amacıyla kaydırma çubuğunu kullanın.

3. Ortalama +2 ila +7 SD (standart sapma) sonuçları için, normal miyokardiyum bölümüne normal bir ROI  
yerleştirin. Normal ROI’yi Yay (Propagate Normal ROI) onaylı ise ROI tüm kesitlere kopyalanır.

Eşik Düzenleme

1. Yüksek sinyal yoğunluklu bölgeler eklemek için  ögesini seçin. 

2. Düşük sinyal yoğunluklu bölgeler eklemek için  ögesini seçin.

3. Her iki tür sinyal yoğunluklu bölgeyi silmek için  küçük silgi aracını ya da  büyük silgi aracını seçin.

Kutupsal Çizim Gösterim Biçimleri

ME analiz aracı 2 kutupsal çizim biçimi sunar: 16 Bölüm ve Eşmerkezli

Seçenek 1: 16 Bölümlü kutupsal çizim

1. 16 Bölümlü(16 Segment) sekmesini  seçin.

2. 2 Renk (2 Color), 4 Renk (4 Color) veya Sürekli (Continuous) seçimini yapın.

Renk ölçeği çubuğuna tıklayarak renk atamalarını tanımlayabilirsiniz.

Yüzde değerlerini değiştirmek için doğrudan renk ayracına tıklayın ve çekin.
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ŞEKİL 5. Kutupsal Çizimler

3.  Kutupsal Çizim Özet Tablosunu görüntülemek için  ögesini seçin.

Seçenek 2: Kesit-Kesit biçimi
1. Eşmerkezli (Concentric) sekmesini seçin. 

ŞEKİL 6. Eşmerkezli Sekmesi

Eşmerkezli sekmesi, Kutupsal Çizimin biçimini, her halkanın bir kesiti temsil ettiği kesit-kesit biçimine dönüştüren tercihleri 
sağlar. Halka sayısı analiz edilen kesit sayısıyla belirlenir.

2. Bölge sayısını seçin.

3. Bölgedeki ROI kütle yüzde değişikliklerini göstermek için alt bölgeleri kontrol edin.

Alt bölgeler seçildiğinde düzeltme işlevi uygulanır.

4. Kutupsal Çizimi yüzde sinyal yoğunluğuna değiştirmek ve değerlere %0-100 arasında sürekli bir aralıkta renk 
kodlaması uygulamak için Sürekli (Continuous) onay kutusunu tıklayın.

Konturları silmek için  ögesine tıklayın.

NOT: LE analizi için yarı otomatik eşik değer, aşağıda gösterildiği gibi yüksek kaliteli miyokardiyal değerlendirme 
görüntüleri üzerinde optimal olarak çalışır (Görüntü A). Kan havuzundan sinyal olmadan alınan (Görüntü B) ya da 
yanlış Döndürme zamanına sahip görüntülerde eşik değerin kullanıcı tarafından öznel olarak ayarlanması gerekir. 

2 Renkli Kutupsal Çizim 4 Renkli Kutupsal Çizim Sürekli Renkli Kutupsal Çizim
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ŞEKİL 7. Miyokardiyal LE (Late Enhancement) Görüntüleri

T2 Analizi
1. T2 sekmesini seçin.

2. LE serisi daha önce analiz edilmişse, kopyala ögesini seçerek ROI’ler T2 serisine kopyalanabilir (bkz. Şekil 8).

NOT: ROI’leri kopyalamak için, isabetli sonuçlar alabilmek maksadıyla her serideki kesit sayısının eşit olması gereklidir; 
kesit sayısı eşleşmiyorsa, kopyala düğmesi kullanılamaz. Aynı sayıda kesit içeren uygun serileri oluşturmak için 
DICOM içe aktarma süreci kullanılabilir. 
En iyi sonuçlar için, Matris ve FOV (Görüş Alanı) gibi alma parametreleri her seride aynı olmalıdır. Bir kopyalama 
yaptıktan sonra, ROI’leri tüm kesit konumlarında dikkatle inceleyin ve uygun düzenlemeleri yapın. 

ŞEKİL 8. Kopyala Düğmesi
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3. Daha önce yapılmış bir LE analizi yoksa, ROI’ler manuel olarak oluşturulabilir.

4.  ögesini seçerek en bazal kesitte LV endokardiyumu izleyin.

5.  ögesini seçerek LV epikardiyumu izleyin.

6.  ögesini seçerek alt RV ekleme noktasını işaretleyin.

7. ROI’yi tamamlamak için imleci düzenleyici penceresinin dışına taşıyın.

8. Tüm ventrikül bölümlere ayrılana kadar 4-7. adımları tekrar edin.

9. 2 Standart sapmalı eşikleme yapmak için, Normal ROI Ekle (Add Normal ROI)  ögesini seçin ve bir normal 
miyokardiyum bölümü üzerine bir ROI yerleştirin. Normal ROI’yi Yay (Propagate Normal ROI) onaylı ise ROI tüm 
kesitlere kopyalanır. Her bir kesitin konumunu gözden geçirin ve gerektikçe ROI’yi ayarlayın.

NOT: İskelet kas ROI’si ve Normal ROI verildiğinde, yazılım aşağıdaki hesaplamayı yapar:
Normalize miyokardiyal T2 SI = SI miyokardiyum / SI iskelet kas; 
Eşik hesaplama: Eşik = 2 * STD NORMAL + ORT NORMAL

10. İlk bazal kesiti seçin ve Taban'ı (Base) seçmek için kesit sınıflandırma aşağıya açılan menüyü kullanın. Kalan kesitlere 
ilişkin sınıflandırmaları onaylayın. Gerekli ise, her kesit için eşik algoritmasını ayarlamak amacıyla kaydırma 
çubuğunu kullanın.

11. T2 Sinyal Yoğunluk (T2 Signal Intensity) analizi yapmak için İskelet Kas ROI’sini seçin  ve iskelet kas içine bir ROI 
yerleştirin. ROI tüm görüntülere kopyalanır. Her bir kesitin konumunu gözden geçirin ve gerektikçe ROI’yi ayarlayın. 

NOT: Kirli kan görüntülerinde yetersiz akış baskılama olabileceğinden bunlar hatalı sinyal yoğunluk analizlerine ve 
eşiklemeye neden olabilir. Yetersiz akış supresyonu, miyokardiyal ödem ile karıştırılabilecek yüksek sinyal 
yoğunluğuna neden olabilir. Düşük sinyal yoğunluğu artefaktları, yanlış düşük sonuçlara neden olabilir.

Düzenleme

Yüksek T2 sinyal yoğunluk bölgeleri eklemek için  ögesini seçin.

Yüksek T2 sinyal yoğunluk bölgeleri çıkarmak için  küçük silgi aracını ya da  büyük silgi aracını seçin.

Konturları silmek için  ögesine tıklayın.
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Birleşik Analiz

LE ve T2
Birleşik analiz modu, LE ve T2 (Ödem) görüntülerinin yan yana analiz edilmesini sağlar ve düzenleme araçları da sunar.

NOT: Birleşik analiz modunu etkinleştirmek için, önce LE sekmesi kullanılarak bir kısa eksen LE serisi için analiz 
tamamlanmalıdır. T2 (Ödem) görüntüleri de aynı çalışma içinde mevcut olmalıdır. 

1.  ögesini seçin.

2. Hem LE hem de T2 (ödem) görüntüleri içeren uygun bir çalışma seçin. LE analiz prosedürünü tamamlayın.

NOT: Birleşik analiz modunu seçmeden önce LE sekmesinde her kısa eksen kesiti için eşiklemeyi gözden geçirin. 

3. T2 sekmesini seçin ve T2 serisi için analiz prosedürünü tamamlayın.
suiteHEART® Yazılımı Kullanım Talimatları NS-03-043-0003-TR Rev. 1 121



4. Birleşik analizi başlatmak için Şekil 9 bölümünde gösterildiği gibi  ögesini seçin.

ŞEKİL 9. Birleşik Analiz Modu

5. Seçimin ardından, daha önce analiz edilen LE (Late Enhancement) serisi mod görüntüleme penceresinde görünür. 
Bu pencere daha sonra LE görüntüleri için bir düzenleme penceresi olur.

6. LE görüntülerini düzenlemek için Şekil 10‘da gösterildiği gibi görüntüleme alanının altında yer alan düzenleme 
araçlarını kullanın.

NOT: Tüm güncellemeleri ve sonuçları doğrudan LE (Late Enhancement) sekmesi üzerinde onaylayın.

NOT: LV endokardiyum veya LV epikardiyum ROI’leri silinmişse, yeniden izlemek için LE (Late Enhancement) 
sekmesine geri dönün.

T2 (Ödem) Late
Güçlendirme 

(Enhancement)
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ŞEKİL 10. LE Düzenleme Araçları

7. Soldaki T2 (Ödem) serisini düzenlemek için Şekil 11‘de gösterildiği gibi görüntüleme alanının altında yer alan 
düzenleme araçlarını kullanın.

ŞEKİL 11. T2 (Ödem) Analiz Araçları
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8. LE serisinde başka bir kesit seviyesine gitmek için Şekil 12‘de gösterildiği gibi artı ve eksi düğmelerini kullanın.
• Kesit konum bilgisi, her görüntüleme alanının sağ alt köşesinde yer alır.

NOT: LE (Late Enhancement) için gösterilen kesit konumu, T2 (Ödem) düzenleme penceresindeki kesit konumu 
tarafından belirlenir. Bu seçimi geçersiz kılmak için eksi/artı düğmelerini kullanın. 

ŞEKİL 12. Kesitler Arasında Gezinme LE’yi Kontrol Eder 

9. Hem LE hem de T2 (Ödem) serilerinde başka bir kesit seviyesine gitmek için Şekil 13 bölümünde gösterildiği gibi, 
T2 (Ödem) düzenleme görüntüleme alanının altında yer alan artı ve eksi düğmelerini kullanın. 

NOT: Birleşik analiz modunda sol taraftaki artı ve eksi düğmeleri her iki görüntüleme alanı için kesitler arası 
gezinmeyi ilişkilendirir.

ŞEKİL 13. Birleşik Kesit Gezinme Kontrolleri

Kesit Konumu Kesit Konumu
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Sinyal Diferansiyeli Sonuçları
Sinyal Diferansiyeli (Signal Differential) Sekmesini seçin.

NOT: Kazanım Kütlesi (Salvage Mass) Sonuçlarını elde etmek için LE ve T2 analizlerinin tamamlanmış olması gereklidir. 
T2 Sinyal Yoğunluğu [Signal Intensity (SI)] analizi için İskelet kas ROI’sinin yerleştirilmesiyle, T2 analizinin 
tamamlanmış olması gereklidir.

NOT: T2 (Ödem) sonucu LE sonucundan (Enfarktüs + MVO) daha azsa Kazanım Kütlesi sonucu boş olur.

ŞEKİL 14. Sinyal Diferansiyeli (Signal Differential) Sekmesi
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Early Enhancement Analizi
Analiz için gerekli görüntüler, çevrili bir spin eko T1 sekansı, Enhancement işlemi öncesi ve sonrasında kullanan kısa eksenli 
bir yığındır. Analiz, Mutlak Güçlendirme %'si (AE) ve Erken Gd Güçlendirme Oranı (EGEr) hesaplaması için bir kopyalama 
işleviyle ilk seride epikardiyum ve endokardiyumun manuel segmentasyonuna izin verir. Miyokardiyumdaki bölgeleri 
analiz etmek için yerel bir ROI kullanılabilir. 

NOT: Kirli kan görüntülerinde yetersiz akış baskılama olabileceğinden bunlar hatalı sinyal yoğunluk analizlerine ve 
eşiklemeye neden olabilir.

1. Early Enhancement Sekmesini seçin.

2. Uygun kısa eksen T1 ağırlıklı serisini seçin. 

3.  ögesini seçerek en bazal kesitte LV endokardiyumu izleyin.

4.  ögesini seçerek LV epikardiyumu izleyin.

5.  ögesini seçerek alt RV ekleme noktasını işaretleyin.

6. ROI’yi tamamlamak için imleci düzenleyici penceresinin dışına taşıyın.

7. Tüm ventrikül bölümlere ayrılana kadar 3-6. adımları tekrar edin. 

8.  ögesini seçerek iskelet kasına bir ROI ekleyin.

9. Bazal kesit konumunu seçin. Kesit Sınıflandırma açılır menüsünü tıklayın ve Taban'ı (Base) seçin. 

10. Her bir kesit için taban (base), orta (mid) ve tepe (apical) sınıflandırmasını onaylayın. 

11. Belirli bir miyokard bölgesini analiz etmek için,  ögesini seçin ve miyokardda bir ROI izleyin.
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ŞEKİL 15. Kesit Sınıflandırması ve Seri Tipi Seçimi

12. Ön (Pre) seri tipini seçin. 
Erken (Early) Post serisi bölümlere ayrılmışsa, Erken (Early) Post'u seçin.

13. Uygun kısa eksen T1 ağırlıklı Erken (Early) Post seri tipini seçin. 
Erken (Early) Post serisi önce bölümlere ayrılmışsa, Ön seriyi (Pre series) seçin.

14. Kopyala (Copy) ögesini seçin.

15. Tüm endokardiyal ve epikardiyal izler ile RV ekleme ve iskelet kas yerleştirmeleri gözden geçirin ve gerekli 
oldukça düzenleyin.

16. ROI'ler yalnızca seçilen seride tüm ROI'lerin ve RV eklemenin, kesit sınıflandırmanın, seri tipinin (3-12. adımlar) 
seçilmesi durumunda kopyalanabilir.

NOT: Endokardiyal veya Epikardiyal iz silinirse Geri Al (Undo) ögesini kullanın.

NOT: İskelet ROI'si her kesit konumunda ayarlanabilir. Silinmesi halinde, analizin yeniden yapılması gerekecektir. 

17.  ögesine tıklayın ve Tüm analizleri kaldırmak için şunu seçin TÜMÜ (ALL): Early Enhancement.

NOT: ROI’leri kopyalamak için, isabetli sonuçlar alabilmek maksadıyla her serideki kesit sayısının eşit olması gereklidir; 
kesit sayısı eşleşmiyorsa, kopyala düğmesi kullanılamaz. Aynı sayıda kesit içeren uygun serileri oluşturmak için 
DICOM içe aktarma süreci kullanılabilir.

NOT: En iyi sonuçlar için, matris ve FOV (Görüş Alanı) gibi alma parametreleri her seride aynı olmalıdır. Bir kopyalama 
yaptıktan sonra, ROI’leri tüm kesit konumlarında dikkatle inceleyin ve uygun düzenlemeleri yapın.

Yerel ROI Aracı
1. Uygun Pre-enhancement kısa eksen T1 ağırlıklı serisini seçin. 

2.  ögesini seçerek belirli miyokardiyum bölgesinde yerel bir ROI izleyin.

3.  ögesini seçerek iskelet kasına bir ROI ekleyin.

4. Şekil 16‘da gösterildiği gibi uygun kesit sınıflandırmasını ve seri tipini seçin.

ŞEKİL 16. Kesit Sınıflandırması ve Seri Tipi Seçimi
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5. Uygun kısa eksen T1 ağırlıklı Erken (Early) Post seri tipini seçin.

6. Kopyala (Copy) ögesini seçin. 

7.  ögesine tıklayın ve Tüm analizleri kaldırmak için şunu seçin TÜMÜ (ALL): Early Enhancement.
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T1 Eşleştirme Analizi
Bu özellik, eksenel spin-latis gevşeme süresi (T1) sinyalinin sayısallaştırılmasını sağlar. Uygulama, hem Doğal 
(güçlendirilmemiş/non-enhanced) hem de Güçlendirme sonrası (Post enhancement) görüntülerin T1 analizinin 
yapılmasını, hem de hücre dışı hacim kesrinin (ECV) hesaplanmasını destekler.

Gerekli Görüntüler: Farklı çevirme sürelerine (TI) sahip geri kazanım görüntülerinin çevrilmesi veya satürasyonu veya iç 
haritalar. Analiz için hareket düzeltme uygulanmış serilerin kullanılması tavsiye edilir. Sol ventriküler taban, orta ve tepeyi 
temsil eden kesit konumlarının kullanılması tavsiye edilir.

T1 Eşleştirme yapılmasında dair daha fazla rehberlik için lütfen aşağıdaki makaleye başvurun:

Messroghli, D.R., Moon, J.C., Ferreira, V.M. et al. Clinical recommendations for cardiovascular magnetic resonance 
mapping of T1, T2, T2* and extracellular volume: A consensus statement by the Society for Cardiovascular Magnetic 
Resonance (SCMR) endorsed by the European Association for Cardiovascular Imaging (EACVI). J Cardiovasc Magn Reson 
19, 75 (2017). https://doi.org/10.1186/s12968-017-0389-8

UYARI : Ön işlemenin ardından kullanıcı, tüm analizin doğruluğunu değerlendirmekten ve gerekli düzeltmeleri 
yapmaktan sorumludur. Kapsamlı bir gözden geçirme şunları içermelidir:
- ROI yerleştirme/tanımlama
- RV ekleme konumu

UYARI : Uygulama yalnızca görüntülerin analizine yardım eder ve otomatik olarak ölçülebilir sonuçlar üretmez. 
Kantitatif ölçümlerin kullanımı ve yerleştirilmesi kullanıcının inisiyatifindedir. Ölçümler yanlış yapılırsa, 
hatalı teşhisler meydana gelebilir. Ölçümler, yalnızca uygun bir şekilde eğitilmiş ve uzman bir kullanıcı 
tarafından oluşturulmalıdır.

UYARI : Kullanıcı, otomatik bölümleme tarafından oluşturulan da dahil olmak üzere, tüm ilgi bölgelerinin 
(ROI’ler) tam olarak yerleştirilmesinden sorumludur.

NOT: T1 Eşleştirme tercihlerini ayarlamak için, Araçlar (Tool) > Tercihler (Preferences) > Düzenleme (Edit) ögelerini 
seçin. T1/T2 Eşleştirme sekmesini seçin.

NOT: Tarayıcı tipinize ilişkin tercihlerde, Analiz için Otomatik Seri Oluştur (Auto Compose Series for Analysis)'u 
ayarlamanız tavsiye edilir. Analiz, tüm kesit konumlarının tek bir seride mevcut olmasını gerektirir. 
Araçlar (Tools) > Tercihler (Preferences) > Düzenle (Edit) ögelerini seçin. T1/T2 Eşleştirme sekmesini seçin.
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ŞEKİL 1. T1 Eşleştirme Arayüzü

1. Otomatik Bölümleme, 2. T1 Sonuçları, 3. Hematokrit girişi, 4. Sekans Tipi seçimi, 5. Renkli bindirme seçimleri, 6. Renkli harita seçenekleri, 
7. Sektör bindirme görüntüleme, 8. Yayılımı düzenleme, 9 Endo/Epi Ofseti, 10. Eğri veya 16 Bölümlü Kutupsal çizim, 11. T1 Eğrileri 

Analizi Gerçekleştirme

1.  ögesini seçin.
2. Uygun zaman serisini veya eşleştirme serilerini seçin.
3. Katmana ilişkin tercih seçilmişse, renk haritası otomatik olarak görüntülenecektir.
4. Farklı bir renk ölçeği seçmek için aşağı açılır menüyü kullanın.

5. Global T1 sonucunu oluşturmak için,  ögesini seçin.
6. Tüm endokardiyal ve epikardiyal izleri, RV ekleme noktasını ve kan havuzu yerleştirmesini gözden geçirin.
7. Herhangi bir yanlış konturu düzenleyin.
8. Konturları ayarlamak için Endo (kırmızı) veya Epi (yeşil) ofsetini kullanın. 

9
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 Ofseti tüm kesitlere yayın.  Ofset tek kesiti

9. Tek bir inversiyon süresini düzenlemek için,  ögesine tıklayın.

10. Her kesit konumu ve seri türüne ilişkin kesit sınıflandırmasını onaylayın.

NOT: Bir kısa eksen görüntü yığınının bölümlere ayrılması durumunda; Taban (Base), Orta (Mid) veya Tepeye (Apex) 
ilişkin T1 sonucu ve 16 bölümlü kutupsal çizim sektörlerinin ortalaması, kesit sınıflandırmasına göre alınacaktır. 
Kan havuzu T1 sonucunun ortalaması alınmayacaktır.

11. ECV'yi hesaplamak için, hem Yerel (Native) hem de Post Serisinde otomatik bölümleme gerçekleştirin.

12. Tüm endokardiyal ve epikardiyal izleri, RV ekleme noktasını ve her iki serideki kan havuzu yerleştirmesini 
gözden geçirin.

13. Miyokardiyumun bir segmentini ölçmek için,  ögesini seçin.

NOT: ECV hesaplanacaksa, doğal görüntüden işlenmiş görüntüye yerel bir ROI kopyalamak için kopyala/yapıştır 
işlevini kullanın.

NOT: Taban, Orta ve Tepeye ilişkin bir görüntü üzerinde, 5 taneye kadar yerel ROI ölçümü oluşturulabilir.

14. Gerektiği takdirde bir kan havuzu ROI’si yerleştirmek için,  ögesini seçin. 

15. Hematokrit (HCT) değerini girin.

16. ECV sonucu (%) sonuç tablosunda gösterilecektir.

17. Manuel bölümleme yapılabilir. 

•  ögesini seçerek LV endokardiyumu izleyin.

•  ögesini seçerek LV epikardiyumu izleyin.

•  ögesini seçerek RV ekleme noktasını işaretleyin.

• ECV hesaplanacaksa,  ögesini seçerek kan havuzu ROI'sini yerleştirin.

• Her kesit konumu ve seri türüne ilişkin kesit sınıflandırmasını onaylayın.

Tavsiye Edilen Referans 

Wong. et al,. “Association Between Extracellular Matrix Expansion Quantified by Cardiovascular Magnetic Resonance and 
Short-Term Mortality.” Circulation (2012):126:1206-1216.
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16 Bölümlü Kutupsal Eşlem
NOT: ECV Kutupsal Çizimi için ECV analizinin tamamlanmış olması gerekir.

1. Taban (Base), Orta (Mid) ve Tepe (Apex) sekmeleri için Global T1 analizini tamamlayın.

2. Her bir kesit konumuna ilişkin RV ekleme noktasını onaylayın. 

3. Doğru kesit sınıflandırmasını ve seri tipini onaylayın.

4. 16 Bölümlü Kutupsal Çizim  ögesini seçin.

5. Sektör katmanını doğrudan görüntü üzerinde göstermek için  ögesini seçin.

6. Zaman serisi analiz edildiyse, T1 eğrilerine dönmek için Grafikleri  seçin.

T1 Sonuç Değerleri Biçimi

Sonuç DICOM Görüntüleri Eşlem Görüntüleri

Global ortalama +/- standart ortalama +/- standart

Taban/Orta/Tepe değer +/- hata ortalama +/- standart

Yerel ROI’ler değer +/- hata ortalama +/- standart

Yerel ortalama +/- standart ortalama +/- standart

Kan Havuzu değer +/- hata ortalama +/- standart
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Konturları Silme

Seçilen serideki TÜM konturları silmek için arayüzdeki  ögesine tıklayın.

Tek bir konturu silmek için önce bir kontur üzerine sol tıklayın, sonra sağ fare tuşunu tıklayın veya tüm zaman 

noktalarındaki konturları silmek için  ögesini seçin.

T1 Eğrilerini Gözden Geçirme 
1. Eğri uyum sonuçları görüntü verilerinin sinyal davranış uyum sonuçlarını gösterir. Yanlış kayıt, solunum artefaktları 

veya düzensiz kalp atışından kaynaklanan görüntü artefaktları durumunda, eğri uyumu optimal olmayabilir.

2. Sinyal yoğunluk noktasının hesaplamaya dahil edilmemesi için üzerine doğrudan grafikte tıklayın ve görüntü 
üzerindeki kontura tıklayıp mor renge döndürün.

3. Sağ fare tuşuyla tıklayıp (tıklayıp bekleyin) sil ögesini seçin ya da klavyedeki sil tuşunu (delete) kullanın.

NOT: Eğri görüntüleme, yalnızca analize yönelik zaman serisi kullanılarak oluşturulur.

UYARI : T1 eğri uyumunun sonuçları, uygun şekilde eğitilmiş ve nitelikli bir kullanıcı tarafından gözden geçirilmelidir. 

Tavsiye Edilen Referans 

*Messroghli D. R. et al,. “Modified Look-Locker Inversion Recovery (MOLLI) for High Resolution T1 Mapping of the Heart.” 
Magnetic Resonance in Medicine (2004) 52: 141-146. 

Sonuç Denklem Referansı Uyum Tipi

T1 Look-Locker (MOLLI) y=A-B exp(-t/T1*) Levenberg-Marquardt algoritması kullanılarak doğrusal olmayan 
eğri uyumu*
suiteHEART® Yazılımı Kullanım Talimatları NS-03-043-0003-TR Rev. 1 133



İnversiyon Düzeltme Faktörü (ICF) Siemens MyoMaps
Oluşturulan tarayıcı T1 eşleşmesine benzer Zaman Serileri görüntülerini analiz ederken T1 sonuçlarını elde etmek için, 
MyoMaps MOLLI protokolleri için kullanılan verimlilik inversiyon atımını doğrulayın. Tarayıcıda, Magn Hazırlama 
(Magn Preparation) menüsünde Kontrast/Ortak kartı (Contrast/Common card) altında "Non-sel IR T1 Map" olarak 
belirtilirse, önerilen inversiyon düzeltme faktörü, ICF = 1.0365'tir. Daha fazla açıklama için Siemens Uygulama Destek 
Uzmanlarınız ile iletişime geçmeniz tavsiye edilir.

Zaman serilerine ait görüntüler analiz ediliyorsa, Şekil 2'de gösterildiği gibi tercihlerde uygun ICF'yi girin.

1. Araçlar (Tools) > Tercihler (Preferences) > Düzenle (Edit) ögelerini seçin.

2. T1/T2 Eşleştirme sekmesini seçin.

3. Tedarikçi türüne göre ICF'yi girin.

ŞEKİL 2. T1 Eşleştirme Tercihleri

Tavsiye Edilen Referans

Kellman, P., Hansen, M.S. T1-mapping in the heart: accuracy and precision. J Cardiovasc Magn Reson 16, 2 (2014).
https://doi.org/10.1186/1532-429X-16-2
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T2 Eşleştirme Analizi
Bu özellik, T2 gevşeme süresi sinyalinin sayısallaştırılmasını sağlar. T2 eşleştirme bir doku özelliği belirleme tekniğidir.

Gerekli Görüntüler: Değişken eko süreli (TE) veya dahili eşlemeler ile durağan durumlu serbest devinimli okuma 
değerlerine sahip T2 hazırlama sekansı. Analiz için hareket düzeltme uygulanmış serilerin kullanılması tavsiye edilir. 
Sol ventriküler taban, orta ve tepeyi temsil eden kesit konumlarının kullanılması tavsiye edilir.

Doğrusal olmayan 2 nokta için denklem şu şekildedir: y = a * exp(-TE/T2); burada TE, sekansa bağlı olarak eko süresini 
veya T2 hazırlık süresini ifade eder.

Doğrusal olmayan 3 nokta için denklem şu şekildedir: y = a * exp(-TE/T2) + c; burada a, T2 ve c katsayılardır (uyum ile 
hesaplanacak parametre)

Doğrusal 2 nokta için denklem şu şekildedir: Y = A - TE/T2; burada Y = log(y) ve A = log(a)’dır.

NOT: Doğrusal ve doğrusal olmayanlara ilişkin 2 noktalı uyum için arka plan çıkarma işlemi yapılmaz.

T2 Eşleştirme yapılmasında dair daha fazla rehberlik için lütfen aşağıdaki makaleye başvurun:

Messroghli, D.R., Moon, J.C., Ferreira, V.M. et al. Clinical recommendations for cardiovascular magnetic resonance 
mapping of T1, T2, T2* and extracellular volume: A consensus statement by the Society for Cardiovascular Magnetic 
Resonance (SCMR) endorsed by the European Association for Cardiovascular Imaging (EACVI). J Cardiovasc Magn Reson 
19, 75 (2017). https://doi.org/10.1186/s12968-017-0389-8

UYARI : Ön işlemenin ardından kullanıcı, tüm analizin doğruluğunu değerlendirmekten ve gerekli düzeltmeleri 
yapmaktan sorumludur. Kapsamlı bir gözden geçirme şunları içermelidir:
- ROI yerleştirme/tanımlama
- RV ekleme konumu

UYARI : Uygulama yalnızca görüntülerin analizine yardım eder ve otomatik olarak ölçülebilir sonuçlar üretmez. 
Kantitatif ölçümlerin kullanımı ve yerleştirilmesi kullanıcının inisiyatifindedir. Ölçümler yanlış yapılırsa, 
hatalı teşhisler meydana gelebilir. Ölçümler, yalnızca uygun bir şekilde eğitilmiş ve uzman bir kullanıcı 
tarafından oluşturulmalıdır.

UYARI : Kullanıcı, otomatik bölümleme tarafından oluşturulan da dahil olmak üzere, tüm ilgi bölgelerinin 
(ROI’ler) tam olarak yerleştirilmesinden sorumludur.

NOT: T2 Eşleme tercihlerini ayarlamak için, Araçlar (Tool) > Tercihler (Preferences) > Düzenleme (Edit) ögelerini seçin. 
T1/T2 Eşleştirme sekmesini seçin.

NOT: Tarayıcı tipinize ilişkin tercihlerde, Analiz için Otomatik Seri Oluştur (Auto Compose Series for Analysis)'u 
ayarlamanız tavsiye edilir. Analiz, tüm kesit konumlarının tek bir seride mevcut olmasını gerektirir. 
Araçlar (Tools) > Tercihler (Preferences) > Düzenle (Edit) ögelerini seçin. T1/T2 Eşleştirme sekmesini seçin.
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ŞEKİL 1. T2 Eşleştirme Arayüzü

1. Otomatik Bölümleme, 2. T2 Sonuçları, 3. Parametre uyum seçimleri 4. Renkli bindirme seçimleri, 5. Renkli harita seçenekleri 
6. Sektör katmanı gösterme, 7. Yayılımı düzenleme, 8 Endo/Epi Ofseti 9.Eğri veya 16 Bölümlü Kutupsal çizim, 10. Kutupsal çizim 

Analizi Gerçekleştirme

1.  ögesini seçin.
2. Uygun zaman serisini veya eşleştirme serilerini seçin. 
3. Zaman serilerini analiz ediyorsanız, uyum yöntemini seçin.

NOT: Doğrusal olmayan uyum algoritması, arka plan gürültüsünü tahmin etmez.
4. İstendiği takdirde, renk haritasını otomatik olarak görüntülemek için bindirme tercihini ayarlayın.
5. Farklı bir renk ölçeği seçmek için dosya aşağıya açılır menüsünü kullanın.

6.  ögesini seçerek, bir Global T2 sonucu oluşturun.
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7. Tüm endokardiyal ve epikardiyal izleri ve RV ekleme noktasını gözden geçirin.

8. Herhangi bir yanlış konturu düzenleyin.

9. Konturları  ayarlamak için Endo (kırmızı) veya Epi (yeşil) 
ofsetini kullanın.

 Ofseti tüm kesitlere yayın.  Ofset tek kesiti

10. Tek bir eko süresini düzenlemek için,  ögesine tıklayın.

11. Her kesit konumu ve seri türüne ilişkin kesit sınıflandırmasını onaylayın.

NOT:  Bir kısa eksen görüntü yığınının bölümlere ayrılması durumunda; Taban, Orta veya Tepeye ilişkin T2 sonucu ve 
16 bölümlü kutupsal çizim sektörlerinin ortalaması, kesit sınıflandırmasına göre alınacaktır.

12. Miyokardiyumun bir segmentini ölçmek için,  ögesini seçin.

NOT: Taban, Orta ve Tepeye ilişkin bir görüntü üzerinde, 5 taneye kadar yerel ROI ölçümü oluşturulabilir.

13. Manuel bölümleme yapılabilir. 

•  ögesini seçerek LV endokardiyumu izleyin.

•  ögesini seçerek LV epikardiyumu izleyin.

•  ögesini seçerek RV ekleme noktasını işaretleyin.

• Her kesit konumuna ilişkin kesit sınıflandırmasını onaylayın.
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16 Bölümlü Kutupsal Eşlem
1. Taban, Orta ve Tepeye ilişkin Global T2 analizini tamamlayın. 

2. Her bir kesit konumuna ilişkin RV ekleme noktasını onaylayın.

3. Doğru kesit sınıflandırmasını onaylayın.

4. 16 Bölümlü Kutupsal Çizim  ögesini seçin.

5. Sektör katmanını doğrudan görüntü üzerinde göstermek için  ögesini seçin.

6. Zaman serisi analiz edildiyse T2 eğrilerine dönmek için Grafikleri  seçin.

T2 Sonuç Değerleri Biçimi

Sonuç DICOM Görüntüleri Eşlem Görüntüleri

Global ortalama +/- standart ortalama +/- standart

Taban/Orta/Tepe değer +/- hata ortalama +/- standart

Yerel ROI’ler değer +/- hata ortalama +/- standart

Yerel ortalama +/- standart ortalama +/- standart
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Konturları Silme

Seçilen serideki TÜM konturları silmek için arayüzdeki  ögesine tıklayın.

Tek bir konturu silmek için önce bir kontur üzerine sol tıklayın, sonra sağ fare tuşunu tıklayın veya tüm zaman 

noktalarındaki konturları silmek için  ögesini seçin.

T2 Eğrilerini Gözden Geçirme 
1. Eğri uyum sonuçları görüntü verilerinin sinyal davranış uyum sonuçlarını gösterir. Kapama, yanlış kayıt, 

solunum artefaktları veya düzensiz kalp atışları nedeniyle görüntü artefaktları olması durumunda, eğri uyumu 
optimal olmayabilir.

2. Sinyal yoğunluk noktasının hesaplamaya dahil edilmemesi için üzerine doğrudan grafikte tıklayın ve görüntü 
üzerindeki kontura tıklayıp mor renge döndürün.

3. Sağ fare tuşuyla tıklayıp (tıklayıp bekleyin) sil ögesini seçin ya da klavyedeki sil tuşunu (delete) kullanın.

NOT: Eğri görüntüleme, yalnızca analize yönelik zaman serisi kullanılarak oluşturulur.

UYARI : T2 eğri uyumunun sonuçları, uygun şekilde eğitilmiş ve nitelikli bir kullanıcı tarafından 
gözden geçirilmelidir. 
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Miyokardiyal Perfüzyon 

Miyokardiyal Perfüzyon analiz modu, kullanıcının miyokardiyal perfüzyon görüntülerini incelemesini ve analiz etmesini 
sağlar. Analiz için hareket düzeltme uygulanmış serilerin kullanılması tavsiye edilir.

NOT: Yarı nicel analiz desteklenmektedir. Kullanılabilir bir çift sekans serisi varsa, gölge düzeltme uygulanabilir. 

NOT: Stres perfüzyon hareket düzeltme görüntüleri ile tek bir serinin ve dinlenme hareket düzeltme görüntüleri ile tek 
bir serinin oluşturulması tavsiye edilir.

DİKKAT: Yukarı eğim ve göreli yukarı eğim parametreleri, üzerinde gölge düzeltme uygulanmamış görüntülerde 
isabetli olmayabilir. 

UYARI : Uygulama, yalnızca görüntülerin analizine yardım eder ve otomatik olarak sonuçların klinik açıdan bir 
yorumunu üretmez. Kantitatif ölçümlerin kullanımı ve yerleştirilmesi kullanıcının inisiyatifindedir. 
Ölçümler yanlış yapılırsa, hatalı teşhisler meydana gelebilir. Ölçümler, yalnızca uygun bir şekilde 
eğitilmiş ve uzman bir kullanıcı tarafından oluşturulmalıdır.

ŞEKİL 1. Miyokardiyal Perfüzyon Analizi Arayüzü
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Tablo 1: Analiz Araçları

Tüm kesitleri, tüm aşamaları yay.

Tüm aşamaları, tekli kesiti yay.

Otomatik bölümleme gerçekleştir.

Düzenleme sonrasında analizi yeniden hesapla. (Sadece otomatik bölümleme yapılmışsa.)

Tüm aşamalarda konturları kopyala / yapıştır. 

Düzenleme sonrasında analizi yeniden hesapla. (Sadece kopyala / yapıştır yapılmışsa.)

Gölge düzeltme uygulandı, sadece bir çift sekans serisi için gerçekleştirilebilir.

Renkli Bölüm katmanını göster.

Katman gösterme.

Hesaplanan parametre için piksel hassasiyetli renkli katmanı göster.

Grafik göster.

Stres ve dinlenme grafiklerini görüntüleme.

Parametre sonuç tablosunu göster.

16, 32, 48, 96 Bölümlü ya da Eşmerkezli Kutupsal Çizim seçimi.

2 Renkli, 4 Renkli veya Sürekli Kutupsal Çizim renk seçimi.

Eşmerkezli Kutupsal Çizim Seçimleri.
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Miyokardiyal Perfüzyon Analizi Gerçekleştirme

1.  ögesini seçin.

2. Stres (Stress) ya da Dinlenme (Rest) için uygun sekmeyi seçin. 

   

3. Miyokardiyal perfüzyon serisini seçin.

4. Otomatik Bölümleme ve analiz hesaplaması gerçekleştirmek için  ögesini seçin.

5. Tüm endokardiyal ve epikardiyal izler ile RV ekleme noktasını her kesitte gözden geçirin ve gerekli oldukça düzenleyin.

6. Taban (base), orta (mid) ve tepe (apical) sınıflandırmasını onaylayın.

7. Manuel bölümleme yapmak amacıyla tek kesit ya da tüm kesitler üzerinde endokardiyal konturu çizmek için  
ögesini seçin.

8. Tek kesit ya da tüm kesitler üzerinde epikardiyal konturu çizmek için  ögesini seçin.

9. Konturları tüm aşamalara kopyalamak / yapıştırmak için  ögesini seçin.

10.  ögesini seçerek alt RV ekleme noktasını yerleştirin.

11. Tüm endokardiyal ve epikardiyal izler ile RV ekleme noktasını her kesitte gözden geçirin ve gerekli oldukça düzenleyin.

12. Taban (base), orta (mid) ve tepe (apical) sınıflandırmasını onaylayın.

13. Analiz için kullanılan başlangıç ve bitiş çerçeveleri, varış zamanı ve tepe süresine göre otomatik olarak belirlenir. 

Ayarlamak için,  ögesini seçin.

• Başlama aşamasını atamak için  ögesine tıklayın ve ardından doğrudan matris hücresine tıklayın. 

• Bitiş aşamasını atamak için  ögesine tıklayın ve ardından doğrudan matris hücresine tıklayın.
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Kontur Düzenleme
Bir düzenleme yapıldığında analizin yeniden hesaplanması gerekir. Düzenleme uyarı sembolü görünecektir. Yeniden 

hesaplama yapmak için  ögesine tıklayın.

Sonuçları İnceleme
1. Hesaplanan parametreleri gözden geçirmek için, dosya aşağı açılır menüsünden seçin. Bkz. Şekil 2.

Kutupsal çizim üzerindeki bir bölüm üzerine imleci yerleştirirseniz, bu bölüme karşılık gelen grafiğin rengi değişir.

ŞEKİL 2. Hesaplanan Parametreler Aşağı Açılır Menüsü

Grafik/Tablo Sonuçlarını Gözden Geçirme
1. Grafik sonuçlarını gözden geçirmek için grafik görünümünün sol altında yer alan dosya aşağı açılır menüsünden Şekil 

3 seçin.

2. Grafikleri görüntülemek için  ögesine tıklayın.

Görüntü üzerinde renkli bölüm katmanını görüntülerken, imleci doğrudan renkli bir bölüm üzerine 
yerleştirirseniz, bu bölüme karşılık gelen grafiğin rengi değişir.

3. Hem stres hem de dinlenme eğrilerini görüntülemek için  ögesine tıklayın.

4. Parametre sonuçlarını görüntülemek için  ögesine tıklayın.
ŞEKİL 3. Grafik Sonuçları
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Bağıl Yukarı Eğimi (RU) ve Rezerv Endeksini (RI) Hesaplama
1. Kan havuzu ROI'si, otomatik bölümleme sırasında otomatik olarak yerleştirilir.

2. Kan havuzunun kesit konumunu değiştirmek için, farklı bir kesit konumu seçmek amacıyla küçük resim görünümünü 

kullanın. Otomatik olarak yeni bir kan havuzu ROI’si oluşturmak için  ögesini veya  ögesini seçin.

3. Kan havuzu ROI'sini manuel olarak yerleştirmek amacıyla, bir ROI'yi izlemek için  ögesini seçin ve ardından  

veya  ögesini seçin.

Bazal kesit düzeyi tavsiye edilir.

4. Kan havuzu ROI’sini silmek için sağ fare tuşuyla tıklayın ve şu ögeyi seçin 

NOT: Rezerv endeksini hesaplamak için hem Stres hem de Dinlenme analizlerinin olması gerekir.

DİKKAT: Miyokardiyal Perfüzyon yukarı eğim ve göreli yukarı eğim sonuç parametreleri, üzerinde gölge 
düzeltme uygulanmamış görüntülerde isabetli olmayabilir. 
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Miyokardiyal Perfüzyon Eğriden Hesaplanan Parametre Tanımları
    

 

Varış Süresi ana hat ile yukarı eğimin kesişim süresi (saniye cinsinden)

Tepe Süresi sinyal yoğunluğunun maksimuma ulaşma süresi (saniye cinsinden) 

SI Oranı SI (tepe süre - ana hat)/ana hat

Yukarı Eğim Yukarı eğim, varış süresi ile tepe süresi arasındaki noktalara uygulanan ağırlıklı doğrusal 
uyum ile hesaplanır.

Göreli Yukarı Eğim RU = miyokardiyal yukarı eğim / kan havuzu yukarı eğimi

Rezerv Endeksi Miyokardiyal rezerv endeksi (RI) şu şekilde tanımlanır:
                    RI = RU STRES/RU DİNLENME

Sinyal Yoğunluğu

Yukarı Eğim

Güçlendirme (Enhancement)

Ana hat

Varış Süresi Tepe Süresi
Süre
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Patent Foramen Ovale (PFO) Analizi

PFO analiz aracı, PFO belirleme işleminde erken tepe noktayı göstermek için zaman eğrisine göre sinyal 
oluşturulmasını sağlar. 

UYARI : Uygulama, yalnızca görüntülerin analizine yardım eder ve otomatik olarak sonuçların klinik açıdan bir 
yorumunu üretmez. Kantitatif ölçümlerin kullanımı ve yerleştirilmesi kullanıcının inisiyatifindedir. 
Ölçümler yanlış yapılırsa, hatalı teşhisler meydana gelebilir. Ölçümler, yalnızca uygun bir şekilde 
eğitilmiş ve uzman bir kullanıcı tarafından oluşturulmalıdır.

PFO'yu başlatma
1. File (Dosya) > Select Analysis (Analiz Seçin) > PFO ögelerini seçin.

 

2. Bir gerçek zaman serisi seçin.
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ŞEKİL 1. PFO Analiz Penceresi

1. PFO düzenlenebilir sekmeler, 2. Aktif ROI’ler, 3. Sil, 4. Başlangıç ve Bitiş aşaması, 5. Sinyal Yoğunluğu-Aşama eğrisi, 6. PFO Analiz simgeleri

Atriyal Anatomiyi Seçme

Sol atrium (LA) ve sağ atrium (RA) anatomilerinin kabul edilebileceği bir görüntü seçin.

Sol Atriyal (LA) Yoğunluk Eğrisini Oluşturma

1.  ögesini seçerek eğriyi çizin. 

2. Görüntü Düzenleyici penceresinde LA üzerindeki bir konturu izleyin. 

3. İmleci Görüntü Düzenleyici penceresinin dışına taşıyın.

4. LA yoğunluk eğrisini oluşturun.

LA için sinyal yoğunluk eğrisi otomatik olarak oluşturulur.

Sağ Atriyal (RA) Yoğunluk Eğrisini Oluşturma

1. RA yoğunluk eğrisini oluşturmak için  ögesini kullanarak daha önce LA yoğunluk eğrisini oluşturmak için 
uygulanan adımları izleyin.

Eğriler katman haline getirilir ve eğri sonuçları görüntüleme penceresinde gösterilir.

NOT: Örneğin, ROI aşama 1 üzerine yerleştirildiyse ve başlangıç aşaması değişmişse, kullanıcı tarafından çizilen ROI, 
ROI’lerin yerleştirildiği orijinal görüntünün üzerinde hala görünür.

1
3

5

6

2

4
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ŞEKİL 2. PFO Eğrisi Sonuçları

Eğri Verisini Gözden Geçirme ve Aşama Aralığı Seçme
1. Rapor penceresinde eğrileri gözden geçirin ve Başlangıç Aşaması (Start Phase) ile Bitiş Aşamasını (End Phase) ayarlayın.

2. Start Eğri gösterimi yapılacak aşama aralığını belirlemek maksadıyla Başlangıç Aşaması (Start Phase) ile Bitiş 
Aşamasını (End Phase) seçmek için yukarı ve aşağı okları kullanın.

Başlangıç ve bitiş aşamalarını ayarlamak PFO eğrilerinin görüntüsünü etkiler.

Grafikte bir noktaya tıklamak, Görüntü Düzenleyici penceresinde görüntülenen aşamayı günceller.

ŞEKİL 3. Başlangıç ve Bitiş Aşaması Seçim Ekranı

NOT: Aynı seride iki alım işlemi varsa, ilk alım için Başlangıç ve Bitiş Aşamalarını seçebilir, LA ve RA ROI’lerini 
(eğrilerin otomatik olarak oluşturulmasından kaynaklanan) çizebilir ve ikinci görüntü kümesi için işlemi başka bir 
PFO sekmesinde tekrarlayabilirsiniz. Tüm PFO sekme etiketleri düzenlenebilir.

Konturları Düzenleme

Birden fazla aşamayı tek bir kesit konumunda düzenleme:

1. Kesit konumunu seçin

2. Ögeyi seç 

3. Düzenlenecek aşama aralıklarının ilk aşamasını seçin.
4. Üst karakter tuşunu (shift) basılı tutun ve düzenlenecek aralıktaki son aşamayı seçin.

Seçilen küçük resimler kırmızı bir kenarlıkla vurgulanmış halde görüntülenir.
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5. Konturu görüntü düzenleyici penceresinde düzenleyin.
6. Seçilen konturun ilerisinde görüntü üzerine tıklayarak veya imleci düzenleyici penceresinin dışına taşıyarak konturun 

seçimini kaldırın.

ROI düzenleme gösterme aralığı ayarlanarak kontrol edilebilir.

Görüntü Görünümünden (Image View) uygun gösterme aralığını seçin.

 Aralık-Hepsi (Scope All) – ROI düzenlemelerini tüm aşamalara uygular.

 Aralık-Mevcuttan Bitişe Kadar (Scope Current to End) – ROI düzenlemelerini mevcut aşamadan bitişe 
kadar uygular.

 Aralık-Sadece Mevcut (Scope Current Only) – ROI düzenlemelerini sadece mevcut aşamaya uygular.

Konturları Silme

TÜM (ALL) kontur silmek için  ögesine tıklayın.

Tüm zaman noktalarındaki konturları silmek için, bir görüntüye önce sol fare ile tıklayın, sonra sağ fare ile tıklayın ve 

akabinde  ögesini seçin.

Nihai Eğri Sonuçlarını Gözden Geçirme

Konturlardan zamana karşılık piksel yoğunluğunu gösteren bir grafik oluşturulur. Rapora göndermek için sağ fare tuşuyla 

 üzerine tıklayın.
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T2*

T2* analiz aracı, çoklu-eko hızlı değişim eko sekansından faydalanarak dokunun T2* değerlerini hesaplar.

T2* eğrisi, üssel azalma eğrisi formülü kullanan bir eko süresi-sinyal yoğunluğu grafiğidir. T2* uyum algoritması, 
Levenberg-Marquardt doğrusal olmayan en küçük kareler algoritmasını temel alır.

T2* azalma eğrisi şöyle hesaplanır:   y = a *exp(-TE/T2*) + c

 Burada simgeler şu anlama gelir:

UYARI : Uygulama, yalnızca görüntülerin analizine yardım eder ve otomatik olarak sonuçların klinik açıdan bir 
yorumunu üretmez. Kantitatif ölçümlerin kullanımı ve yerleştirilmesi kullanıcının inisiyatifindedir. 
Ölçümler yanlış yapılırsa, hatalı teşhisler meydana gelebilir. Ölçümler, yalnızca uygun bir şekilde 
eğitilmiş ve uzman bir kullanıcı tarafından oluşturulmalıdır.

Tablo 1:

y TE zamanındaki sinyal yoğunluğudur

a 0 (sıfır) zamanındaki ters manyetizasyondur

TE eko süresidir

T2* azalma sabitidir ve

c arka plan gürültüsüdür
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Kalp Analiz Prosedürü
ŞEKİL 1. T2* Analiz Arayüzü

1.  ögesini seçin. 

2. Uygun seriyi seçin.

3. Küçük resim panelinden kısa eksen kesitini seçin.

4.  ögesini kullanarak interventriküler bölmeyi çevreleyen bir kontur çizin.

T2* ve R2* değerleri hesaplanır ve sonuç tablosunda gösterilir.

R2 değeri hesaplanır ve grafik üzerinde gösterilir.
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Miyokardiyal Renk Haritası Oluşturma

1.  ögesini kullanarak endokardiyal sınır konturunu çizin.

2.  ögesini kullanarak epikardiyal sınır konturunu çizin. 

T2*/R2* renk haritası görüntünün üzerine katman olarak yerleştirilir. 

3. R2* renk haritası değeri değiştirilebilir.

NOT: 1,5 T görüntüler için varsayılan aralık T2 için 5 ms - 500 ms arasıdır*. 3,0T görüntüler için varsayılan aralık 2,5 ms 
- T2 için 1000 ms’dir. 

4. Renk haritası dinamik renk aralığını ayarlamak için yukarı ve aşağı ok tuşlarına tıklayıp çekin. 

Görüntü Düzenleyici içindeki renk katmanı dinamik olarak değişir.

Hz ve ms değerleri de dinamik olarak değişir.

5. T2* ve R2* değerleri  ögesi seçilerek ve görüntüdeki renk haritası katmanının üzerine yerleştirilerek belirlenebilir.

Uyum Parametreleri
T2* azalma eğrisi için 2 Parametre (2 Parameter) veya 3 Parametre Uyumunu (3 Parameter Fit) seçin. 

ŞEKİL 2. Parametre Uyumu

2 parametre uyumu, emsal değerlendirme literatüründe genel bir kabul görmüştür [1]. Bu modelde, arka plan gürültüsü 
olarak adlandırılan c, histogram tabanlı bir algoritma ile hesaplanıp, sinyal yoğunluğundan çıkarılır, ardından doğrusal 
olmayan bir uyum gerçekleştirilir.

3 parametre uyumunu da emsal değerlendirme literatüründe referans edilmiştir [2]. Bu model doğrudan giriş sinyali 
üzerinde çalışan doğrusal olmayan bir yaklaşımdır.

Her iki model içinde ilk T2* değeri deneme için yapılan bir doğrusal uyum kullanılarak tahmin edilir.

1. D.J Pennell, et al. “Cardiovascular T2-star (T2Star) magnetic resonance for the early diagnosis of myocardial iron 
overload,” Eur Heart J 2001; 22: 2171-2179.

2. Ghugre NR, et al. “Improved R2* Measurements in Myocardial Iron Overload,” Journal of Magnetic Resonance 
Imaging 2006; 23: 9-16.
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T2* Sonuçlarını Gözden Geçirme
1. Görüntülerin tümünde kontur konumunu gözden geçirin. 

2. Tablo T2*/R2* ölçümlerini ayrı ayrı listeler ve ortalama değer hesaplar.

NOT: T2* eğrisi, üssel azalma eğrisi formülü kullanan bir eko süresi-sinyal yoğunluğu grafiğidir. Zaman zaman, daha iyi 
bir eğri uyumu için, daha sonraki eko noktalarını azalma eğrisinden çıkarmak gerekebilir. Bu, aşırı demir yükü 
durumlarında sinyal yoğunluğu çok düşük olduğunda meydana gelebilir.

Görüntüden tek bir kontur silmek için

1. Konturu seçmek için farenin sol tuşunu tıklanır ve konturun rengi mora dönüşür.

2. Çöp kutusunu seçmek için fareyi sağ tıklayın veya bir konturu kaldırmak için klavyedeki Sil (Delete) tuşunu kullanın.
• Kontur silinir ve eğri uyumu yeniden hesaplanır.

ŞEKİL 3. T2* Eğrisi

UYARI : T2* eğri uyumunun sonuçları, uygun şekilde eğitilmiş ve nitelikli bir kullanıcı tarafından gözden 
geçirilmelidir.

T2 ve T2*, milisaniye (ms) olarak, R2 ve R2* ise Hertz (veya s-1) olarak bildirildiği için 1000 çarpanı kullanılır.

Tablo 2: R2*/T2* Dönüşümleri

Sonuç Birim Dönüşüm

R2* Hz R2*=1000/T2*

T2* ms T2*=1000/R2*
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3B/4B Akış Görüntüleyici
3B ve 4B akış görüntülerinin etkileşimli eğik şekilde yeniden biçimlendirilmesini sağlar. 2B aşama kontrastı ve 4B'den analiz 
edilebilen 2B işlev görüntüleri oluşturmaya yönelik araçlar mevcuttur. Dahili akış analizi gerçekleştirilebilir. 

NOT: İzometrik voksellerden ve örtüşen kesitlerden oluşan 3B seri, yeniden biçimlendirilmiş görüntülerin 
kalitesini iyileştirir.

NOT: 3B/4B Akış Görüntüleyici, ancak 4B lisansı varsa bir 4B seriyi gösterebilir.

NOT: Hem 2B aşama kontrastı hem de dahili 4B Akış analizi gerçekleştirilmişse, tüm sonuçlar Akış Analizi 
Modunda bulunacaktır. 

DİKKAT: 3B ya da yeniden biçimlendirilmiş görüntüler bir tanının oluşturulması için sadece ek destekleyici bilgi 
sağlar ve her zaman konvansiyonel görüntüleme teknikleriyle birlikte kullanılmalıdır.

UYARI: 3B yeniden biçimlendirilmiş görüntüleri her zaman orijinal alınmış verilerle ilişkilendirin.

UYARI: Pencere genişliği ve seviyesi (WW/WL) ayarları faklı patolojilerin görünümünü ve diğer anatomik 
yapıları fark etme becerisini etkileyebilir. Yanlış WW/WL ayarları görüntü verilerinin gösterilememesine 
neden olabilir. Tüm görüntü verilerini gözden geçirmek için farklı WW/WL ayarları gerekebilir.
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3B/4B Akış Görüntüleyici Arayüzü Bileşenleri

ŞEKİL 1. Görüntüleme Kontrol Araçları ve Görüntüleme Alanları

Görüntüleme Kontrol Araçları

3B Görüntüleme Alanı Aksiyal Görüntüleme Alanı

Eğik Görüntüleme Alanı 1 Eğik Görüntüleme Alanı 2
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Tablo 1: Görüntüleme Kontrol Araçları

Araç Açıklama
İnce Artı İmleci (Crosshair Cursor) - tüm görüntüleme alanları 
arasında gezinmeyi senkronize eder. 

Yönlendirme Düğmeleri (Orientation Buttons) - 3B ve eğik 
görüntüleme alanlarında görüntü düzlemini değiştirir.

S = Üst (Superior)
I = Alt (Inferior)
A = Ön (Anterior) 
P = Arka (Posterior) 
L = Sol (Left)
R = Sağ (Right) 
Eğik Mod (Oblique Mode) - istenen anatomiyi göstermek için eğik 
yeniden biçimlendirilmiş görüntüyü ve düşey kesişimi gösterir. 

Çifte Eğik Mod (Double Oblique Mode) - üç ayarlanabilir renkle 
(mavi, sarı ve yeşil) tanımlanan üç eğik düzlem gösterir. Diğer iki eğik 
düzlemi güncellemek için herhangi bir ekseni ayarlayın. 

3B Görüntüleme Modu (3D View Mode) - 3B görüntüleme alanında 
görüntü resimleme modları sunar

Yüzey 
MIP = Maksimum yoğunluk projeksiyonu (Varsayılan)
MINIP = Minimum yoğunluk projeksiyonu 

Akış Çizgileri (Streamlines)- 3B hız alanlarını belirli bir zaman 
aşamasında görsel olarak sunar.

1 Renk Hızı Katmanı*
2 Renk Hızı Katmanı Kaldırma*
3 Aşamalı Görüntüleme*
*Sadece 4B Akış için geçerlidir.
Hız Aralığı (Speed Range) - akış yönünün renk hızı atamasını ayarlar. 
Sadece 4B Akış görüntüleri içindir.
Hız Aralığı renk çubuğu lejantı, her görüntüleme alanının sağ 
tarafında gösterilir. Değer tahminidir.

1 2 3
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Opaklık (Opacity) - anatomiyi vurgulayan görüntülemeyi 
iyileştirmek için görüntünün renk hızı opaklığını kontrol eder. 
Sadece 4B akış görüntüleri içindir. 

Film (Cine) - saniye başına kare sayısını kontrol eder ve filmin 
başlangıç ve bitiş karelerini belirler. Sadece 3B zaman çözünürlüklü 
büyüklük ve 4B akış görüntüleri içindir. Filmi oynatmak ya da 
duraklatmak için klavyedeki boşluk tuşunu kullanın.

Seriyi Kaydet (Save Series) - analiz için 2B konvansiyonel işlevsel ya 
da akış görüntü serisi ya da sonradan işlenmiş MIP görüntüleri 
oluşturur. Kesit sayısını, kesit kalınlığını, boşluğu ve görüş alanını 
girmek için kullanın. Bu parametreler her bir görüntüleme alanının 
sol üstünde bulunur. Açmak/kapatmak için Ctrl + T tuş 
kombinasyonunu kullanın.

Sadece Büyüklük (Magnitude Only) - işlev analizinde kullanmak 
üzere orijinal görüntülerden tek kesitli veya çok kesitli çok aşamalı 
bir büyüklük serisi oluşturur.

Büyüklük ve Aşama (Magnitude and Phase) - akış analizinde 
kullanmak üzere orijinal görüntülerden tek kesitli veya çok kesitli 
çok aşamalı bir aşamalı büyüklük serisi oluşturur. Bu seçenek sadece 
4B Akış serisi seçildiğinde kullanılabilir. (Otomatik aşama düzeltmeli 
bir kopya seri de oluşturulur.)

Sonradan İşlenmiş (Post-Processed) - 3B görüntülerden maksimum 
yoğunluk projeksiyon görüntüleri oluşturur. 4B akış verisi 
olduğunda, görüntüler üzerinde gözden geçirme maksadıyla renk 
katmanlı tek kesitli veya çok kesitli çok aşamalı bir seri oluşturulur. 

Tümü Sonradan İşlenmiş - Her görüntüleme alanından tüm 
biçimlendirilmiş görüntüleri kaydeder.
Kaydet (Save)- seri tanımı tarafından oluşturulan tüm görüntü serisi 
tiplerini yerel veritabanına kaydeder. 

Rx Planlama (Rx Planning) - seri tanımı tarafından oluşturulan 
istenen tarama eksenini tanımlar. 

Tablo 1: Görüntüleme Kontrol Araçları

Araç Açıklama
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Sayfalama ve Kalınlaştırma (Paging and Thickening) - 
MIP görüntüsün kalınlığını değiştirir ve görüntü seti boyunca 
sayfalama yapar. 

1= MIP görüntüsünün kalınlığını değiştirmek için tıklayın ve iki 
taraftaki düğmelere doğru çekin
2= görüntü seti boyunca sayfalama yapmak için kaydırıcıya tıklayın 
ve çekin. 

Kontroller seçili görüntüleme alanının sağ tarafında yer alır.

Doğrusal (Linear) - Düz hat mesafelerini ölçmek için sunulmuştur. 
Silme (Delete), Bulma (Locate) veya Etiketleme (Label) yapmak için 
doğrudan ölçüme tıklayın ve sağ fare tuşuna basın.

3B Döndürme (3D Rotate) - 3B görüntüleme alanında ve/veya eğik 
görüntüleme alanı 1 ve 2’de görüntüleri eğer veya döndürür. Eğmek 
ya da döndürmek için görüntüleme alanında doğrudan sol fare 
tuşuna tıklayıp çekin. 

Akış Yönü (Flow Direction) - eğik görüntüleme alanı 1 ve 2’de düşey 
düzlemi gösterir. Bu özelliği kullanmak için ilgilenilen anatomi 
üzerinde doğrudan sol fare tuşuna tıklayın. Sadece 4B akış 
görüntüleri içindir.
Pencere/Seviye (Window/Level) - tüm görüntüleme 
alanlarında mevcuttur.

Kaydırma (Pan) - tüm görüntüleme alanlarında mevcuttur.

Yaklaşma (Zoom) - tüm görüntüleme alanlarında mevcuttur.

Döndürme (Rotate) - 3B görüntüleme alanı, görüntüleme alanı 1 ve 
görüntüleme alanı 2’de kullanılabilir.

Tablo 1: Görüntüleme Kontrol Araçları

Araç Açıklama
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3B/4B Akış Görüntüleyici Yerleşimi ve Seri Oluşturma Çıktıları
Yeniden biçimlendirme için seçilen görüntü serisinin tipine bağlı olarak, görüntü oluşturma tipi aşağıdaki tabloda özetlenmiştir. 

Sıfırlama (Reset) - tüm görüntüleme alanlarında mevcuttur.

Tarama Parametreleri (Scan Parameters) - herhangi bir 
görüntüleme alanında sağ fare tuşuyla tıklanır.

Tablo 2: Hızlı Tuş

İşlev Eylem
Hedef İmleç İmleci istenen anatomi üzerine konumlandırın ve Shift 

tuşuna basın.
1 x 1 Düzeni 
(Yerleşim)

Herhangi bir 2 x 2 görüntüleme alanına çift tıklamak, 
düzeni 1 x 1'e ve 2 x 2'ye geri değiştirir. 

Tablo 3:3B/4B Akış Görüntüleyici Yerleşimi ve Çıktıları

3B/4B Akış Görüntüleyici 
Yerleşimi

3B Görüntü Serisi Çıktıları 4B Akış Görüntüsü Serisi Çıktıları

3B görüntüleme (sol üst 
görüntüleme alanı)

Sonradan İşlenmiş Sonradan İşlenmiş

Aksiyal (sağ üst görüntüleme alanı) Sadece Büyüklük

Sonradan İşlenmiş (MIP)

Sadece Büyüklük*, Büyüklük ve 
Aşama* ve Sonradan İşlenmiş 
(renk katmanı)*

Eğik 1 (sol alt görüntüleme alanı) Sadece Büyüklük

Sonradan İşlenmiş (MIP)

Sadece Büyüklük*, Büyüklük ve 
Aşama* ve Sonradan İşlenmiş 
(renk katmanı)*

Eğik 2 (sağ alt görüntüleme alanı) Sadece Büyüklük

Sonradan İşlenmiş (MIP)

Sadece Büyüklük*, Büyüklük ve 
Aşama* ve Sonradan İşlenmiş 
(renk katmanı)*

*Bu seri tipi suiteHEART® Yazılımında konvansiyonel analiz için kullanılabilir.
Büyüklük ve aşama serilerinin her biri için otomatik aşama düzeltmeli bir kopya oluşturulacaktır.

Tablo 1: Görüntüleme Kontrol Araçları

Araç Açıklama
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Örnek İş Akışı: 3B Görüntü Serisinden MIP Görüntüler Oluşturma
1. Uygun çalışmayı seçin ve suiteHEART® Yazılımını çalıştırın.

2.  ögesini seçin.

3. Aşağı açılır seri listesinden uygun 3B seriyi seçin. Şekil 2‘de görüldüğü gibi, seçili görüntü tipi düğme 
üzerinde gösterilecektir.

ŞEKİL 2. Seride Dolaşma

4.  ögesini seçin ve istenen görüntüleme alanına tıklayın. Şekil 3 bölümünde gösterildiği gibi yeniden biçimlendirme 
çizgileri görünecektir. 

ŞEKİL 3. Çifte Eğik Mod
 

5. Düz çizgiye tıklayın, sol fare tuşuna tıklayıp çekerek çizgiyi istenen anatomiyi gösterecek şekilde eğin. 
a.) Kaydetmek için istenen görüntüleme alanına tıklayın. 
b.) Görüntüleme alanının sağ tarafında yer alan kontrolleri kullanarak MIP kalınlığını ayarlayın. 
c.) Şekil 4’te gösterildiği gibi seri tanım girişlerini tamamlayın. 
d.) MIP görüntüsünü yerel veritabanına kaydetmek için kaydet düğmesine basın.
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ŞEKİL 4. Seri Tanımı

6.  ögesini seçerek bir MIP görüntü yığını oluşturun.

NOT: Oluşturulabilecek maksimum sonradan işlenmiş MIP görüntüsü sayısı 512’dir.

7. Şekil 5‘te gösterildiği gibi, referans görüntü olarak kullanılacak görüntüleme alanına tıklayın ve bir toplu görüntü 
kümesi tanımlayın.

a.) Kesit kapsama aralığını genişletin.
b.) Kesit yönünü göstermek için açıyı ve okları ayarlayın.
c.) Rx’i hareket ettirin.

ŞEKİL 5. Rx Planlama

8. Seri tanımını girin ve görüntüleri yerel veritabanına kaydetmek için  ögesine tıklayın. 

9. Oluşturulan seriyi görüntülemek için analiz moduna geçin, gözden geçirme modunu seçin ve yenileye tıklayın. 

1. Sonradan İşlenmişi Seçin
2. Kaydet Düğmesine Tıklayın

b

a a

c
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Örnek İş Akışı: Analiz için 2B Seri Oluşturma

Konvansiyonel 2B aşama kontrast veya 2B işlevsel görüntüler oluşturmak için hem zamanla çözünen büyüklük hem de R/L, 
A/P ve S/I akış düzenine sahip bir 4B Akış serisi gereklidir. 

4B akış görüntülerinden oluşturulmuş sadece büyüklük ya da büyüklük ve aşama serileri, işlev ya da akış analizinde 
kullanılabilecek geçerli 2B konvansiyonel serilerdir.

4B Akış serisinden sonradan işleme ile oluşturulan serilerin bir renk akış katmanı olur.

1. Uygun çalışmayı seçin ve suiteHEART® Yazılımını çalıştırın.

2.  ögesini seçin.

3. Şekil 6‘da gösterildiği gibi, aşağı açılır seri listesinden uygun 4B seriyi seçin. Şekil 6‘da görüldüğü gibi, seçili görüntü tipi 
düğme üzerinde gösterilecektir.

ŞEKİL 6. Seride Dolaşma

4.  ögesini seçin ve istenen görüntüleme alanına tıklayın. Şekil 7 bölümünde gösterildiği gibi yeniden biçimlendirme 
çizgileri görünecektir.

ŞEKİL 7. Çifte Eğik Mod

5. Düz bir çizgiye tıklayın, sol fare tuşuna tıklayıp çekerek çizgiyi istenen anatomiyi gösterecek şekilde eğin. 
a.) Kaydetmek için istenen görüntüleme alanının üzerine tıklayın ve 2B aşama kontrast serisi oluşturmak için Büyüklük ve 

Aşamayı, işlevsel bir seri oluşturmak için Büyüklüğü seçin. 
b.) Görüntüleme alanının sağ tarafında yer alan kontrolleri kullanarak kesit kalınlığını ayarlayın. 
c.) Şekil 8’de gösterildiği gibi seri tanım girişlerini tamamlayın ve seriyi yerel veritabanına kaydetmek için kaydet düğmesine basın.
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ŞEKİL 8. Seri Tanımlama ve Kaydetme

6. Çok kesitli çok aşamalı görüntülerden bir yığın oluşturmak için  ögesini seçin.

NOT: Oluşturulabilecek çok aşamalı görüntülerin maksimum sayısı 32’dir. 

NOT: Büyüklük ve aşama serilerini kaydederken, ikinci seriye otomatik ana hat düzeltmesi uygulanacaktır. Şekil 9’da 
gösterildiği gibi, “düzeltilmiş” (corrected) olarak etiketlenecektir. 

ŞEKİL 9. Otomatik Aşama Ofset Değeri Hatası Düzeltilmiş Seri Örneği

1. Büyüklük ve Aşamayı Seçin

2. Kaydet Düğmesine Tıklayın
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7. Şekil 10 bölümünde gösterildiği gibi, referans görüntü olarak kullanılacak görüntüleme alanına tıklayın ve bir toplu 
görüntü kümesi tanımlayın.

ŞEKİL 10. Rx Planlama

8. Seri Tanımı seçeneklerini seçin ve görüntüleri yerel veritabanına kaydetmek için  ögesine tıklayın. 

9. Oluşturulan seriyi analiz etmek için uygun analiz moduna geçin ve yenileye tıklayın. 

Örnek İş Akışı: Bir Akış Ölçümü Oluşturma 

Akış analizi arayüzü araçları hakkında ayrıntılı bilgi için bkz. Akış Analizi, sayfa 89.

1. Analiz (Analysis) Sekmesini seçin.

2. Üzerinde çalışılacak damarı saptayın. Otomatik bölümleme için, gösterildiği gibi, sadece aort ya da pulmoner anatomi 

desteklenir. Bir akış eğrisi oluşturmak için  ögesine tıklayın.
suiteHEART® Yazılımı Kullanım Talimatları NS-03-043-0003-TR Rev. 1 164



ŞEKİL 11. Aort ve Pulmoner Damar Örneği

UYARI: Kullanıcı, ön işleme ile oluşturulanlar da dahil olmak üzere, tüm ilgi bölgelerinin (ROI’ler) tam olarak 
yerleştirilmesinden ve doğru kategori atamalarından sorumludur.

3. Manuel bölümleme için üzerinde çalışılacak damarı saptayın ve Şekil 12 bölümünde gösterildiği gibi  
ögesine tıklayın.

Kullanılabilir altı ROI vardır ve 1 - 6 olarak numaralandırılmıştır. Renk kodlaması analiz görünümünde, görüntüleme 
alanlarında ve grafiklerde aynıdır.

4. İlgilendiğiniz damarın etrafına 4 nokta bırakarak bir damarın etrafında bir kontur oluşturun.

5. Tüm aşamalarda bölümleme maksadıyla  ögesine tıklayın.

ŞEKİL 12. Manuel ROI Yerleştirme
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Hız Örtüşme Düzeltmesi Uygulama

Hız örtüşmesini düzeltmek maksadıyla aşama açmayı kaldırmak için kaydırma çubuğu kontrol düğmesini çekin. 
Değişikliğin etkisi doğrudan aşama görüntüsü üzerinde güncellenir ve sonuçlar doğrudan akış grafiği üzerinde gösterilir. 
Hız kodlu üç görüntünün her birini üç dik yön (x, y, z) boyunca kontrol etmek için aşağı açılır menüden Şekil 13‘te 
gösterildiği gibi seçim yapın.

ŞEKİL 13.
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Menü Odaklı Raporlama

UYARI : Rapor, içeriğin analizle eşleştiğinden emin olmak için onay ve dağıtımdan önce denetlenmelidir. Rapor 
içeriğinin hatalı olması, gecikmiş veya yanlış teşhise neden olabilir. Analiz ve yorum uygun bir şekilde 
eğitilmiş ve uzman kullanıcılar tarafından yapılmalıdır.

Rapor Görünümüne, arayüzün  sağ alt köşesine tıklayarak veya Alt+R tuşlarına basılarak erişilebilir. Kardiyak 
görüntülerin raporlanmasını kolaylaştırmak için iki monitörün olması önerilir. 

Birden fazla monitör varsa, arayüzün  sağ üst orta kısmından monitörü seçin. 

Rapor Görünümü arayüzü (Şekil 1), menü odaklı bir seçim sağlar. Seçimler, metinle doldurulan uygun rapor bölümü ile 
doğrudan arayüz üzerinde yapılabilir. Parametre sonuçları için raporlama metni ve kategorik aralıklar, tercihler altından 
kullanıcı tarafından tanımlanabilir. Araçlar > Tercihler > Düzenle ögelerini ve Menü Odaklı Raporlama sekmesini seçin. 

ŞEKİL 1. Rapor Görünümü Arabirimi

1. Kardiyak Anatomi Seçimi, 2. Sonuçlar, 3 Menü Seçimleri, 4. Kutupsal Çizimler (Polar Plots) için şemalar, 5. Monitör Seçimi, 
6. Raporu HTML olarak kopyalama, 7. Rapor İçeriği, 8 Hasta Demografikleri, 9. Makro Sekmeleri, 10 Rapora Görüntü, Grafikler, Tablolar Ekleme    

1

2 3

4

5 6

7

8

9

10
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Hasta Demografikleri
Demografikler bölümü DICOM başlığındaki hasta bilgisini içerir. Alanlar Şekil 10‘da gösterildiği gibi düzenlenebilir (vurgulanabilir). 

NOT: Düzenleme, DICOM başlığını değiştirmez. 

ŞEKİL 2. Demografikler   

1. DICOM Başlık Bilgisi, 2. Beden Yüzey Alanı (BSA) Seçimi 

Beden Yüzey Alanı (BSA) hesaplama tipi, ters üçgen üzerinde sol fare tuşuyla tıklanarak seçilebilir.

Referans: http://halls.md/formula-body-surface-area-bsa/

Raporlanacak uygun kardiyak anatomi, Şekil 3'te gösterildiği gibi arayüzün sol üst kısmından seçilebilir. 
• LV: Sol Ventriküler 
• RV: Sağ Ventriküler 
• Atria 
• Kapaklar

ŞEKİL 3. Kardiyak Anatomi Seçimi

Beden Yüzey Alanı 
Hesaplama Yöntemi

Formül

DuBois ve DuBois BSA (m2) = 0,20247 x Boy(m)0,725 x Kilo(kg)0,425

Mosteller BSA (m2) = KAREKÖK ([Boy(cm) x Kilo(kg) ]/3600)
BSA (m2) = KAREKÖK ([Boy(inç) x Kilo(libre) ]/3131)

Gehan ve George BSA (m2) = 0,0235 x Boy(m)0,42246 x Kilo(kg)0,51456

Haycock BSA (m2) = 0,024265 x Boy(m)0,3964 x Kilo(kg)0,5378

Boyd BSA (m2) = 0,0003207 x Boy(cm)0,3 x Kilo(gram)(0,7285 - (0,0188 x LOG(gram))

1

2
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Raporlama Prosedürü
NOT: Kategorik aralıkların tamamlanması, rapor için otomatik önceden doldurma işlevinin etkinleştirilmesini 

sağlayacaktır. Metin, kullanıcı tanımlı değerlere göre önceden doldurulacaktır. Raporlama işlemi sırasında menü 
arayüzünden bir seçim yapılırsa, önceden doldurma işlevi artık etkinleştirilmez.

1. Menülerden, çalışma için ilgili bulguları seçin. LV seçilmişse, Sol Ventrikül rapor bölümü Şekil 4'te gösterildiği gibi 
metinle doldurulacaktır.

ŞEKİL 4. Sol Ventrikül için Örnek Seçimi 

2. İmleci parantezin dışına yerleştirin ve parantez içindeki satırın tamamını kaldırmak için klavyedeki geri okuna basın 
veya manuel olarak metin eklemek veya düzenlemek için imleci parantezin içine yerleştirin.

NOT: Sonuç parametreleri oluşturulmadan önce uygun tüm analizlerin tamamlanması gerekir.

3. Tüm raporlama bölümleri manuel olarak düzenlenebilir. Geçmiş, İzlenim, Teknik ve Bulguların rapor bölümleri için 
makrolar oluşturulabilir. Makroları yapılandırmak için, Araçlar (Tools) > Tercihler (Preferences) > Düzenle (Edit) 
ögelerini ve Makro (Macro) sekmesini seçin. 

ŞEKİL 5. Kullanıcı Tanımlı Makrolarla gösterilen Geçmiş Sekmesi (History Tab) 

4. Rapor bölümünde, içeriği rapora dahil etmek veya rapordan çıkarmak için onay kutularını tıklayın. Bkz. Şekil 6.

ŞEKİL 6. Rapor İçeriği  

5. Raporu HTML formatında dışa aktarmak için  ögesine tıklayın.
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Rapora Görüntü, Grafikler, Tablolar Ekleme

1. Herhangi bir görüntü görüntüleme alanına, grafiğe veya tabloya sağ tıklayın ve  ögesini seçin.

2.  ögesini seçerek grafikleri veya tabloları görüntüleyin.

NOT: Çok kesitli görüntüler rapora gönderilebilir. Araçlar (Tools) > Tercihler (Preferences) > Düzenle (Edit) ögelerini 
seçin. Genel sekmesi altından Rapor Edilecek Çok Kesitli Görüntü ögesini işaretleyin. 

Gözden geçirme modunda, sağ fare tuşu ile  ögesini tıklayın; Filmin durdurulması gerektiğini unutmayın.

ŞEKİL 7. Görüntü, Grafikler, Tablolar   

1. Grafikleri ve Tabloları Görüntüleme, 2. Başlık Yazma, 3. Kontroller 

Kontroller 

Her bir resim, grafik veya tablo arasında ilerleyin

Etkin olduğunda rapora dahil edin

Küçük veya büyük görüntü biçimleri

Görüntü, grafik veya tablo kaldırma

Görüntü yerleştirme

1 2

3
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Kutupsal Çizimler
Kutupsal Çizimler, uygun şema tamamlanarak rapora eklenebilir. Kutupsal Çizimler, İşlev, Enhancement ve Perfüzyon için 
mevcuttur. Kutupsal Çizimleri rapora dahil etmek için Şekil 8'de gösterilen kutuya tıklayın.

ŞEKİL 8. Şemalar 

Segment Seçimi
1. Renk kodlu bir tanımlayıcıya ve segmente sol tıklayın veya - 

Listeden seçim yapmak için doğrudan bir segmente sağ tıklayın veya - 
tüm segmentler için ayarlamak üzere segmentten uzakta seçim yapın.

2. İşlev ve geliştirme için segment seçimleri, Şekil 9da gösterildiği gibi seçimin metin tanımlayıcılarıyla Sol veya Sağ 
Ventrikül için uygun rapor bölümünü dolduracaktır.

3. Araçlar (Tools) > Tercihler (Preferences) > Düzenle (Edit) ögelerini seçerek varsayılan etiketi Geliştirmeyi yapılandırın 
ve Miyokardiyal Değerlendirme altına istediğiniz etiketi girin. Miyokardiyal Değerlendirme Analizi sekmesinden uygun 
etiketi seçin.

NOT: Uzun eksenli tepe segmenti tamamlandıysa, 17 segmentli Kutupsal Çizim raporda biçimlendirilecektir.
NOT: Geliştirme şeması, Perfüzyon şemaları görüntülenirken değiştirilebilir.

4. Kutupsal Çizimleri 4 renge ayarlamak için Araçlar (Tools) > Tercihler (Preferences) > Menü Odaklı Raporlama 
(Menu Driven Reporting) > Kutupsal Çizim Rengi (Polar Plot Color) ögelerini ve 4 rengi seçin.

ŞEKİL 9. Segment Seçimleri 
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Rapor Önizleme  

1. Dosya (File) > Rapor Önizleme (Preview Report) ögelerini veya sağ alttan  ögesini seçin.

2. İstenen tüm analiz sonuçlarının ve yapılandırılmış bilgilerin dahil edildiğinden emin olmak için raporu gözden geçirin.

3. Raporu kaydetmek için  ögesini seçin. 

4. Konum ve dosya türünü seçin.

NOT: Raporun dosya adı Tercihler içinde yapılandırılabilir. Bkz. Rapor Tercihlerine İlişkin Seçimler, sayfa 29.

ÖNEMLİ: Kırmızı renkle gösterilen değerler aralık dışındaki değerlerdir ve rapor siyah beyaz bir yazıcıda yazdırılacaksa 
belirgin görünmezler. 

ŞEKİL 10. Kaydet Penceresi

5. Raporu yazdırmak için Yazdır (Print) ögesini seçin.

UYARI : Rapor, içeriğin analizle eşleştiğinden emin olmak için onay ve dağıtımdan önce denetlenmelidir. 
Rapor içeriğinin hatalı olması, gecikmiş veya yanlış teşhise neden olabilir. Analiz ve yorum uygun bir 
şekilde eğitilmiş ve uzman kullanıcılar tarafından yapılmalıdır.

İncelemeyi Onaylama 
Uygulama raporları onaylama ve kilitleme özelliğine sahiptir. Onaylanan rapor kaydedilir ve görüntülenebilir 
ancak değiştirilemez.

NOT: Ön Gereksinimler: Kullanıcı raporu imzalamak için yetkili olmalıdır. Bkz. Rapor Onay Yetkili Kişiler (Authorized 
Report Approvers), sayfa 30.

NOT: Bir görüntü üzerinde bir eylem gerçekleştirilinceye kadar “Onaylı İnceleme” (“Approved Exam”) düğmesi ve 
menüsü etkin olmaz. 
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1. İncelemeyi Onayla (Approve Exam) ögesini veya Dosya (File) > İncelemeyi Onayla (Approve Exam) ögesini seçin.

ŞEKİL 11. İncelemeyi Onayla Penceresi

2. İstenirse, imza açıklaması girin.

3. İsim aşağı açılır menüsünden kullanıcı adınızı seçin.

4. Parolanızı girin.

5. Onaylamak ve pencereyi kapatmak için Onayla (Approve) ögesine tıklayın. Onaylama prosedürünü tamamlamadan 
pencereyi kapatmak için İptal (Cancel) ögesine tıklayın.

Verilen açıklama kullanılarak bir seri oluşturulur.

NOT: Onaylı bir inceleme yapıldığında, raporun bir tarihi ve zaman damgası olur.

Dışa Aktarma Seçenekleri
1. Araçlar (Tools) > Dışa Aktar (Export) > Raporu DICOM olarak gönder (Report to DICOM) ögelerini seçin.

İkincil yakalama (SCPT) oluşturulur ve seri listesine eklenir.

2. Araçlar (Tools) > Dışa Aktar (Export) > Raporu Excel olarak gönder (Report to Excel) ögelerini seçin.
Raporu bir Excel dosyası olarak dışarı aktarır.

3. Araçlar (Tools) > Dışa Aktar (Export) > Raporu XML olarak gönder (Report to XML) ögelerini seçin.
Raporu bir XML dosyası olarak dışarı aktarır.

4. Araçlar (Tools) > Dışa Aktar (Export) > Görüntüleri DICOM olarak gönder (Images to DICOM) ögelerini seçin.
İkincil yakalama (SCPT) oluşturulur ve seride kaydedilir.

5. Araçlar (Tools) > Dışa Aktar (Export) > .... konumuna raporla (Report to... ) ögelerini seçin.
Sonuçları, üçüncü taraf raporlama sistemine aktarır.

6. Araçlar (Tools) > Dışa Aktar (Export) > Görüntüleri JPEG, AVI, vb. olarak gönder ögelerini seçin.
Filmi Kaydet açılır penceresi görüntülenir.

7. Araçlar (Tools) > Dışa Aktar (Export) > Verileri Matlab olarak gönder (Data to Matlab) (sadece lisansla) 
ögelerini seçin.

İkili biçimde bir Mat-file dosyasını dışa aktarır.
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ŞEKİL 12. Filmi Kaydet Penceresi

1. Dışa aktarılacak dosya türlerini seçin.

2. Dosyanın/dosyaların kaydedileceği konuma gidin.

3. Dışa aktarma işlemine başlamak ve pencereyi kapatmak için Kaydet (Save) ögesine tıklayın. Görüntülenmekte olan seri 
dışa aktarılan tek dosyadır.

NOT: Veriyi AVI veya MOV dosyası olarak dışa aktarırken, suiteHEART® Yazılımı maksimum saniyedeki kare sayısını, 
uygulama içinde görüntüleme için ayardan bağımsız olarak, 20 olarak ayarlar.

NOT: İçinde hem çok aşamalı hem de tek aşamalı görüntüler olan özel bir seri .avi veya .mov dosyası olarak dışa 
aktarılıyorsa, dışa aktarma işleminden önce çok aşamalı görüntü içeren bir görüntüleme alanının seçildiğinden 
emin olun.

Onaylı Raporu Gözden Geçirme 
1. Dosya (File) > Onaylı Rapor Yükle (Load Approved Exam) ögelerini seçin. 

Bu, Onaylı İncelemeyi Seç (Select Approved Exam) penceresini görüntüler. İncelemeyle ilgili tüm onaylı 
incelemeler listede görüntülenir.

ŞEKİL 13. Onaylı İnceleme Seçimi Penceresi
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2. Listeden seriyi seçin.

3. Onaylı raporu ve ilgili analizi yüklemek ve görüntülemek için Yükle (Load) ögesine tıklayın. 
• Yalnızca onaylı bir rapor görüntülenebilir.
• Onaylı rapor düzenlenerek ve bu değişiklikler yeni bir incelemeye kaydedilerek onaylanan bir incelemeden yeni bir 

inceleme oluşturulabilir. Yeni inceleme ikincil yakalama serisi olarak kaydedilir.

NOT: Onaylı bir inceleme ve analizin yüklenmesi, geçerli analiz oturumundaki bilgilerin üzerine yazacaktır.

NOT: suiteHEART® Yazılımının önceki sürümleriyle analiz edilen incelemeler yüklenmek isteniyorsa ve bir 
“Onaylı İnceleme Yükle” (“Load Approved Exam”) işlemi yapıldıysa, rapor üzerinde onaylayan kişi adı ile tarih 
veya zaman damgası bilgisi bulunmaz. Raporu yeniden yayımlamadan önce tüm analizlerin gözden geçirilmesi 
ve tüm sonuçların onaylanması tavsiye edilir.
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Rapor Veritabanı

Rapor Veritabanı (Report Database) daha önce onaylanan raporların içeriğinde arama yapmanızı sağlar. Bir rapor, yalnızca 
onaylandıktan sonra rapor veritabanına girilir.

Rapor Veritabanı Aracı Prosedürü
1. Araçlar (Tools) > Rapor Veritabanı (Report Database) ögelerini seçin.

Arama Kriterlerini Seçme
2. Şablon arama aşağı açılır menüsünden arama yapmak için doğru şablonu seçin.

3. Geçmiş aşağı açılır menüsünden arama sorgusunu seçin. Geçerli sorgu çubuğu seçilen değerlerinizi görüntüler.

ŞEKİL 1. Arama Seçenekleri

NOT: İstenen sorgu yoksa, yeni bir sorgu oluşturun.
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Sorgu Gerçekleştirme
1. Şekil 1’de gösterildiği gibi, Geçmiş (History) çubuğunun sağındaki Yeni (New) ögesini seçin. 

Rapor Veritabanı penceresinde sorgu oluşturma panelleri görüntülenir.

ŞEKİL 2. Veritabanı Sorgu Paneli

1. Sorgu Analiz Sekmeleri, 2. Sorgu Grubu, 3. Sorgu Alanları, 4. Sorgu İşleyicileri, 5. Sorgu Parametreleri, 6. Sorgu Oluşturma, 7. Yeni Sorgu, 
8. Sorgu Kuralları, 9. Sorgu Gerçekleştirme, 10. Sorgu Seçenekleri

2. Çalışma, İşlev, ME, T2*, T1 Eşleştirme ve T2 Eşleştirme arasından sorgu kategorisi sekmesini seçin. Sorgu grupları ve 
alanları uygun bir şekilde güncellenir.

3. Sorgu grubunu seçin.

4. Sorgu alanını seçin.

NOT: Rapor Veritabanı özel ölçümlerde arama yapamaz.

5. Sorgu arama parametrelerini belirlemek için işleyici seçin.

6. Arama kriterleri için değerler sağlamak üzere parametreleri girin.

7. Sorguyu Kurallar (Rules) panelinde görüntülemek için Sorgu Oluştur (Create Query) ögesini seçin. Tek bir arama işlemi 
sırasında birden fazla sorgu yürütülebilir. Her ek kural için 1 ile 7 arasındaki adımları tekrarlayın.

Değil (Not) düğmesi sorgu değerini olumsuz yapar.

1

2

3

4 5

6 7

8

9

10
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Veya (Or) düğmesi aramayı sorgulardan yalnızca biriyle karşılarken birden fazla sorguyu birbirine bağlar. 
Veya (Or) işlevi seçimin üzerindeki sorgu kuralına uygulanır.

Sil (Delete) düğmesi sorgu kuralının seçilmesini ve silinmesini sağlar.

8. Veritabanında arama yapmak için Çalıştır (Run) ögesini seçin.

Arama sonuçları Sorgu sonucu penceresinde görüntülenir. Aramayı karşılayan sorgu değerleri sonuç penceresinin 
en sağdaki sütununda görüntülenir.

ŞEKİL 3. Sorgu Sonucu Penceresi

1. Geçmiş çubuğu, 2. Sorgu Sonuçları, 3. Yazdırma Listesi, 4. Raporları Yazdır, 5. Listeyi Dışa Aktar,6. Sil, 7. Sonuçları Getirme

NOT: Yeni sorgu sonuçları yalnızca inceleme kimliği, inceleme tarihi, imza yetkisi ve rapor şablonunun benzersiz bir 
birleşimine göre oluşturulur. Bu alanların bir kopyası algılanırsa, eski rapor yeni raporla değiştirilir.

Sonuçları Getirme 
1. Sorgu Sonuçları (Query Result) penceresinden, DICOM kaynağı’nı (DICOM source) seçin.

2. Sonuç listesinden çalışmalar’ı (studies) seçin.

3. Getir (Retrieve) ögesine tıklayın.

ŞEKİL 4. Sorgu Sonucu Penceresi

1

2 3
4
5
6

7
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Sonuçları Görüntüleme
1. Raporu görüntülemek için Sorgu sonucu penceresindeki bir girişe çift tıklayın. 

Seçilen raporu görüntüleyen yeni bir pencere açılır. Birden fazla rapor varsa, raporlar arasında gezinmek için 
Sonraki Rapor (Next Report) ve Önceki Rapor (Previous Report) ögelerini kullanın. Rapor Gözden Geçirme 

penceresini kapatmak için pencereyi kapatma işaretine  tıklayın.

ŞEKİL 5. Rapor Görüntüleyici

2. Ana rapordan, veritabanı arayüzü:

Düzenle (Edit) > Tümünü Seç (Select All) tüm arama sonuçlarını seçer.

Düzenle (Edit) > Seçimi Temizle (Clear Selection) tüm arama sonuçlarının seçimini iptal eder.

Düzenle (Edit) > Seçimi Ters Çevir (Invert Selection her sonucun seçim durumunu değiştirir.

Düzenle (Edit) > Geçmişi Temizle (Clear History) önceki sorguların kaydını siler.

3. Sorgu listesini yazıcıya göndermek için Listeyi Yazdır (Print List) ögesini seçin.

4. Seçilen raporları yazıcıya göndermek için Raporları Yazdır (Print Reports) ögesini seçin.

5. Listeyi bir html dosyası ve raporu bir pdf olarak kaydetmek için Listeyi Dışa Aktar (Export List) ögesini seçin.

6. Seçilen raporları rapor veritabanından kaldırmak için Sil (Delete) ögesini seçin.
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Sorguyu Kaydetme
1. Favoriler (Favorites) > Favorilere Ekle (Add to Favorites) ögelerini seçin. 

2. Favorilere Ekle metin kutusunda, sorgu için bir etiket girin ve Tamam (OK) ögesine tıklayın.

ŞEKİL 6. Favoriler Menüsü

ŞEKİL 7. Favoriler Açılır Menüsü
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Favoriyi Silme
1. Rapor Veritabanı penceresinden Favoriler (Favorites) > Favorilere Yönet (Manage Favorites) ögelerini seçin.

ŞEKİL 8. Favorileri Yönet Penceresi

2. Favori ögesini seçin.

Sonuç penceresinde tüm sorgu formülü görüntülenir.

3. Sil (Delete) ögesine tıklayın.

Onay açılır penceresi silme seçiminizi doğrulayacaktır. Evet (Yes) ögesini seçin.

4. Kapat (Close) ögesini seçin.
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Arama Sonuçlarını bir HTML Dosyasına Aktarma
1. Rapor Veritabanı penceresinin sağ tarafındaki Listeyi Dışa Aktar (Export List) ögesini seçin. 

ŞEKİL 9. Dışa Aktarma Penceresi

2. Listenin dışa aktarılacağı dizini seçin.

3. Tamam (OK) ögesini seçin.
• Açılır bir pencere raporların dahil edilip edilmeyeceğini sorar.
• Liste ve raporlar HTML dosyası olarak dışa aktarılır. 
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Veritabanını Dışa Aktarma
Veritabanı büyüdükçe verinin arşivlenmesi tavsiye edilir.

1. Rapor Veritabanı menü çubuğundan Dosya (File) > Dışa Aktar (Export) ögesini seçin.

2. Listenin dışa aktarılacağı dizini seçin.

3. Tamam (OK) ögesini seçin. Veritabanı harici depolama cihazına dışa aktarılır.

Veritabanını İçe Aktarma
Veritabanı, dışa aktarıldığı başka bir bilgisayardan tekrar içe aktarılabilir. 

1. Dosya (File) > İçe Aktar (Import) ögesini seçin. 

ŞEKİL 10. İçe Aktarma Penceresi

2. Listenin içe aktarılacağı dizini seçin.

3. İçe aktarılan veritabanı mevcut veritabanıyla birleştirilir. 
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Ek

Referans Makaleler
Bu el kitabında Şablon Sekmesi, sayfa 37 bölümünde açıklanan normal değerler, aşağıdaki emsal değerlendirme literatür başvuru 
kaynaklarından oluşturulmuş olabilir:

1. Kawel-Boehm et al, “Normal Values for Cardiovascular Magnetic Resonance in Adults and Children.” Journal of 
Cardiovascular Magnetic Resonance (2015) 17:29

2. Maceira A.M. et al, “Normalized Left Ventricular Systolic and Diastolic Function by Steady State Free Precession 
Cardiovascular Magnetic Resonance.” Journal of Cardiovascular Magnetic Resonance (2006) 8, 417-426.

3. Lorenz C. et al. “Normal Human Right and Left Ventricular Mass, Systolic Function, and Gender differences by Cine 
Magnetic Resonance Imaging.” Journal of Cardiovascular Magnetic Resonance 1(1), 7-21, 1999.

4. Sechtem, U. et al. “Regional left ventricular wall thickening by magnetic resonance imaging: evaluation in normal 
persons and patients with global and regional dysfunction.” Am. J. Cardiol. 1987 Jan 1;59(1):145-51.

5. Storey P, et al. “R2* Imaging of Transfusional Iron Burden at 3T and Comparison with 1.5T,” Journal of Magnetic 
Resonance Imaging 25:540–547 (2007)

6. D.J Pennell, et al. “Cardiovascular T2-star (T2Star) magnetic resonance for the early diagnosis of myocardial iron 
overload”, Eur Heart J 2001; 22: 2171-2179. 
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Ek B - İşlevsel Analiz Tarama Düzlemi Örneği
İsabetli işlev sonuçları için,analiz, aşağıdaki ilk resimde gösterildiği gibi kısa eksen görüntüsü üzerinde yapılmalıdır.
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Kısa eksen görüntüsünün alınması için doğru tarama yüzeyi belirleme. Kesitler, sol ventrikülün uzun eksenine dik olacak şekilde, 
tabandan en az 2 kesit üstte ve seride bulunan tepeden (apex) sonra da en az 1 kesit olacak şekilde belirlenmelidir.
suiteHEART® Yazılımı Kullanım Talimatları NS-03-043-0003-TR Rev. 1 186



İndeks

Sayısal Değerler
3B/4B Akış Görüntüleyici 154
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H
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